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Welcome to the 003 Family

Welcome to the 003® family of cross-platform
Pro Tools® workstations for music, sound de-
sign, and multimedia production from Avid.
The 003 family includes 003, 003 Rack, and
003 Rack+ devices.

003 Family Features

Each 003 family interface has unique features.
However, all 003 family units share the follow-
ing input and output capacity:

e Up to 18 channels of 1/0O.

e Eight analog audio inputs, with D/A convert-
ers supporting up to 24-bit, 96 kHz audio.

e Eight analog audio outputs, with D/A convert-

ers supporting up to 24-bit, 96 kHz audio.

e Main and Alternate Monitor Output pairs
(+4 dBU) with a single level control. These
outputs mirror Outputs 1-2 and provide di-
rect connection to a monitoring system (such
as a stereo power amp, powered speakers, or
another stereo destination).

¢ Aux Input pair (+4 dBu) for direct monitoring
of tape or CD input sources.

e Two 1/4-inch stereo headphone outputs
(Headphone 1 and 2) with level controls.
Headphone 2 can monitor Main Outputs 1-2
like Headphone 1, or be switched to monitor
Outputs 3—4 for a discrete cue mix.

Optical connectors for eight channels of Opti-
cal (ADAT) I/O (supporting up to 48 kHz) or
two channels of Optical S/PDIF I/O.

RCA connectors for two channels of S/PDIF
digital I/O supporting up to 24-bit, 96 kHz au-
dio.

Word Clock In and Out ports, to receive or

send 1x Word clock.

Footswitch jack for starting and stopping
playback or punching in/out while recording.

Monitor section with Mute switch and
switches for routing input and output signals.

Audio and MIDI Features

003 and 003 Rack

Eight analog audio inputs.

Inputs 1-4 feature:

e Support for microphone (XLR) and DI
(1/4”) inputs.

e 75 Hz high-pass filters (HPFs), switchable
per channel.

e 48V phantom power on mic inputs, swit-
chable in channel pairs.

Line inputs 5-8 (1/4” TRS) switchable be-

tween +4 dBu (for pro-level gear) and -10 dBV

(for consumer-level gear).

One MIDI In port and two MIDI Out ports,

providing up to 16 channels of MIDI input

and up to 32 channels of MIDI output.
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003 Rack+

Eight analog audio inputs.

Each input channel features:

e Support for microphone (XLR) and Line/DI
(1/4” TRS) inputs.

e 75 Hz high-pass filter (HPF), switchable per
channel.

¢ 48V phantom power on mic inputs, swit-
chable per channel.

e 20 dB pad, switchable per channel.
Front panel DI input.

One MIDI In port and one MIDI Out port,
providing up to 16 channels of MIDI input
and up to 16 channels of MIDI output.

Control Surface Features
(003 Only)

003 provides an integrated control surface that
includes the following:

Eight motorized touch-sensitive faders for
controlling track volume and other parame-
ters. Includes ability to disable faders during
playback of automated mixes.

Dedicated Solo, Mute and Channel Select/Re-
cord Arm switches.

Eight multifunction rotary encoders for oper-
ating pan, send, and plug-in controls.

Fast and convenient access to sends, inserts,
plug-in pages, pan settings, and other track
functions.

Automation Mode switches for selecting and
displaying Automation modes.

Large, bright LCD for data display.

Transport controls, plus Transport mode
switches for loop playback, loop record, and
QuickPunch.

Dual-concentric Jog/Shuttle wheel.

003 Family User Guide

Save, Undo, and Enter switches. Memory Lo-
cation switch for recalling Memory Locations
or opening the Memory Location window.

Windows switches for Pro Tools display of
plug-in, Mix, and Edit windows.

Navigation and Zoom controls.
MIDI mode switches for MIDI mapping.
Utility mode switch for testing 003.

Pro Tools LE Capabilities

Pro Tools LE™ with an 003 family device on Mac
or Windows provides the following capabilities:

e Playback of up to 48 mono or stereo digital
audio tracks, or a combination of playing
back and recording up to 48 mono or stereo
digital audio tracks, depending on your
computer’s capabilities.

e Upto 128 audio tracks (with up to 48 active
tracks), 128 Auxiliary Input tracks, 64 Mas-
ter Fader tracks, 256 MIDI tracks, and 32 In-
strument tracks per session.

® 16-bit or 24-bit audio resolution, at sample
rates up to 48 kHz.

¢ Non-destructive, random-access editing
and mix automation.

¢ Audio processing with up to 10 inserts per
track (RTAS plug-ins or hardware inserts).

e Up to 10 sends per track.

e Up to 32 internal mix busses.

A Pro Tools LE uses your computer’s CPU to
mix and process audio tracks. Computers
with faster clock speeds yield higher track
counts and more plug-in processing.



System Requirements and
Compatibility

Avid can only assure compatibility and provide
support for hardware and software it has tested
and approved.

For complete system requirements and a list of
qualified computers, operating systems, hard
drives, and third-party devices, visit:

www.avid.com/compatibility

MIDI Requirements

003 and 003 Rack include one MIDI In port and
two MIDI Out ports, providing 16 channels of
MIDI input and 32 channels of MIDI output.
The 003 Rack+ includes one MIDI In port and
one MIDI Out port, providing 16 channels of
MIDI I/O.

003 family interfaces support any device that
supports MIDI continuous controller (CC) data.
Drivers are provided to use 003 as a MIDI con-
trol surface on any supported Mac or Windows
computer with virtually any compatible soft-
ware.

In MIDI mode, 003 family units send the same
MIDI control data over FireWire and the MIDI
Out 1 port. It responds to MIDI data received
over FireWire and from the MIDI In port. If you
require additional MIDI ports, add a MIDI inter-
face to your system. USB MIDI interfaces work
effectively with Pro Tools systems on Windows
or Mac.

A\ Only USB MIDI interfaces are compatible
with Pro Tools systems for Mac OS X.
Modem-to-serial port adapters and serial
MIDI devices are not supported.

For a list of supported MIDI interfaces and
controllers, visit www.avid.com.

Hard Drive Requirements

For optimal audio recording and playback, all
Pro Tools systems require one or more qualified
hard drives.

If you are using an ATA/IDE or FireWire hard
drive, initialize your drive with the Disk Utility
application included with Apple System soft-
ware (Mac) or Windows Disk Management
(Windows).

For more information, see Appendix D, “Hard
Drive Configuration and Maintenance.”

Avoid Recording to the System Drive

Recording to your system drive is not recom-
mended. Recording and playback on a system
drive may result in lower track counts and fewer
plug-ins.

Registration

Review the enclosed Registration Information
Card and follow the instructions on it to quickly
register your purchase online. By registering,
you become eligible to receive the following:

e Technical support information
¢ Software update and upgrade notices

e Hardware warranty information
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Conventions Used in This
Guide

All of our guides use the following conventions
to indicate menu choices and key commands:

Convention Action

File > Save Choose Save from the
File menu

Control+N Hold down the Control key

and press the N key

Control-click Hold down the Control key
and click the mouse button

Right-click Click with the right
mouse button

The names of Commands, Options, and Settings
that appear on-screen are in a different font.

The following symbols are used to highlight
important information:

Q User Tips are helpful hints for getting the

most from your system.

A\ Important Notices include information that
could affect your data or the performance of
your system.

Shortcuts show you useful keyboard or
mouse shortcuts.

Cross References point to related sections in
this guide and other Pro Tools guides.
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Installing Pro Tools on Mac

This chapter contains information for Mac sys-
tems only. If you are installing Pro Tools on a
Windows computer, see Chapter 3, “Installing
Pro Tools on Windows.”

A\ Before installing this version of Pro Tools,
see the Read Me information included on
the Pro Tools Installer disc.

Installation Overview

Installing your 003 family system on a Mac
includes the following steps:

1 “Installing Pro Tools LE and Connecting Your
Interface” on page 5.

2 “Launching Pro Tools LE” on page 8.
3 “Launching Pro Tools LE” on page 8.

4 Configuring your system for improved perfor-
mance (see Chapter 4, “Configuring Your
Pro Tools System”).

5 Making audio and MIDI connections to your
003 family interface (see Chapter 10, “Making
Studio Connections”).

Q The Pro Tools Installer disc includes addi-
tional software for your system. For more in-
formation, see “Additional Software on the
Pro Tools Installer Disc” on page 9.

Installing Pro Tools LE and
Connecting Your Interface

Before connecting your 003 family interface to
your computer, you need to install Pro Tools LE
software.

A\ Do not connect your 003 family interface to
your computer until you have installed
Pro Tools LE software.

To install Pro Tools LE:

1 Make sure you are logged in as an Administra-
tor for the account where you want to install
Pro Tools.

For details on Administrator privileges
in Mac OS X, see your Apple OS X
documentation.

2 Insert the Pro Tools LE Installer disc in your
DVD drive.

3 On the Installer disc, locate and double-click
Install Pro Tools LE.mpkg.

-‘u\%

Install Pro Tools LE.mpkg icon
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4 Follow the on-screen instructions to proceed
with installation.

5 Click Continue each time you are prompted.

6 At the Installation Type page, do one of the
following:

e To install all Pro Tools application files and
free plug-in suites (and associated content),
leave the default Installation options se-
lected and click Continue.

¢ Select (or deselect) a custom configuration

of Installation options (see “Installation
Options” on page 7) and click Continue.

7 Click Install.

8 If prompted, enter your Administrator pass-
word and click OK to authenticate the installa-
tion.

9 Follow the remaining on-screen instructions.
10 When installation is complete, click Restart.

11 Before launching Pro Tools LE software, shut
down your computer and connect the 003 fam-
ily interface to your computer.

12 Plug the 003 family interface into a standard
AC outlet, using the AC power cable included
with the unit. AC power is required to operate
your 003 family interface.

13 Locate the FireWire cable that came with
your unit.

A\ Be sure to note the orientation of the
FireWire cable connector when you insert it
in your 003 family interface. It is possible
to damage the FireWire port if you force the
connector in upside down.

6 003 Family User Guide

14 Plug one end of the FireWire cable into one
of the ports marked “1394"” on the back panel of
your 003 family interface. Either port will work.

o

e . @& ©
[

I— FireWire ports

003 family FireWire ports (back panel)

15 Do one of the following, depending on your
system configuration:
¢ Plug the other end of the FireWire cable
into an available FireWire port on your
computer.
—or—
e If your computer has only one FireWire
port, plug the other end of the FireWire ca-
ble into an available FireWire port on a
FireWire hard drive connected to your
computer.

A Connecting your 003 family interface to your
computer through a FireWire hard drive does
may not provide the maximum track count.
To achieve the maximum track count, install
a qualified PCI/PCMCIA/ExpressCard to in-
crease the number of FireWire ports on your
computer.

For information on supported PCI/PCM-
CIA/ExpressCard FireWire options, visit the
Avid website (www.avid.com).



Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and
plug-ins (and associated content), click the re-
veal triangle for the Pro Tools LE option in the
installer, and deselect any of the following op-
tions that you do not want installed.

Application Files (Required for Pro Tools) Installs
the Pro Tools application and supporting library
files needed to run Pro Tools. This option also
installs the Avid CoreAudio Driver. This option
must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including
DigiRack plug-ins, free Bomb Factory plug-ins,
Eleven Free, TL Utilities, and D-Fi and Maxim
plug-ins. For more information, see the Audio
Plug-Ins Guide.

Pro Tools Creative Collection

Select any of the Pro Tools Creative Collection
options you want installed. For more informa-
tion, see the Audio Plug-Ins Guide.

Effects Plug-Ins Installs 20 free effects plug-ins
from Avid’s AIR group.

Virtual Instruments Installs six free virtual in-
strument plug-ins from Avid’s AIR Group.

Virtual Instrument Content Installs sample con-
tent for AIR virtual instruments.

Q Virtual Instrument content is very large and
© may take up to 20 minutes to install. During
this time, the progress bar may not appear to
move but your software is still installing. Do

not terminate the installation.

Additional Options

The Pro Tools installer provides the following
additional options to install along with
Pro Tools software and plug-ins.

Avid CoreAudio Driver This option installs the
Avid CoreAudio Driver, which lets you use qual-
ified audio interfaces with third-party applica-
tions that support the CoreAudio Driver stan-
dard.

Avid Video Engine This option lets you integrate
Avid® video peripherals such as the Avid Mojo®
with your Pro Tools system. Do not install un-
less you will be using one of these products.

Command|8 Controller and Driver This option in-
stalls the personality file and device driver for
the Avid Command|8® control surface. Do not
install unless you will be using Command|8.

Chapter 2: Installing Pro Tools on Mac
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Launching Pro Tools LE

When launching Pro Tools LE the first time, you
are prompted to enter an authorization code to
validate your software. (The code begins with
the letters DIGI.)

To authorize Pro Tools LE software:

1 Make sure your 003 family interface is con-
nected to your computer and powered on.

2 Do one of the following:
e Click the Pro Tools LE icon in the Dock.

¢ Locate and double-click the Pro Tools LE
application on your hard drive.

A If you get a warning dialog about updating
the firmware for your hardware, follow the
on-screen instructions to perform the
firmware update. See “Updating 003 Fam-
ily Firmware” on page 8.

3 Enter the authorization code in the dialog
(making sure to type it exactly as printed,
observing any spaces and capitalization), then
click Validate. (Your authorization code is lo-
cated on the back of your Pro Tools DVD wallet.)

8 003 Family User Guide

4 Use the Quick Start dialog to do one of
the following:

e Create a new session from a template.
¢ Create a new blank session.

¢ Open any other session on your system.

@ PRO TOOLS
LE

) Crosse Sevnion from Templas | Cusar L

Cancel ) [E500)

Quick Start dialog

For more information on the Quick
Start dialog and session templates, see
the Pro Tools Reference Guide
(Help > Pro Tools Reference Guide).

Updating 003 Family Firmware

When you launch Pro Tools software, it auto-
matically checks the version of the unit’s firm-
ware and prompts you to update it if a newer
version is available.

If you update your unit’s firmware, let the up-
date complete before disconnecting or turning
off your system.

When a firmware update completes, Pro Tools
quits, and you must relaunch Pro Tools.

If during the update process you get a message
that Pro Tools cannot communicate with your
003 family interface, wait up to 30 seconds for

the message to close. If the message does not go
away, power off 003 family interface and then

power it on again.



Additional Software on the
Pro Tools Installer Disc

The Pro Tools Installer disc provides additional
software for your system, including drivers to let
third party applications play and record through
Pro Tools hardware, and a Pro Tools demo
session.

Y Check your Pro Tools Installer disc for
additional software and installers.

Third-Party Applications and
Plug-lns

Your Pro Tools package also includes several free
applications and plug-ins from Avid and se-
lected Avid Third Party developers. Once you've
completed your Pro Tools installation, you can
install these separately.

003 Factory Bundie Plug-ins

If you purchased a Factory version of your 003
family system, go to the Additional Files/Factory
Bundle Installers folder on the Pro Tools LE In-
staller disc and run the Install 003 Factory Bun-
dle installer.

Avid CoreAudio Driver

The Avid CoreAudio Driver is a multi-client,
multichannel sound driver that allows CoreAu-
dio-compatible applications to record and play
back through Pro Tools hardware.

The Avid CoreAudio Driver is installed by de-
fault when you install Pro Tools.

For information on configuring the
Avid CoreAudioDriver, see the CoreAudio
Drivers Guide.

Standalone CoreAudio Driver

The CoreAudio Driver can be installed as a
standalone driver on Mac systems that do not
have Pro Tools software installed.

For information on installing and configuring
the standalone version of the Avid CoreAudio
Driver, see the CoreAudio Drivers Guide

A\ If you uninstall Pro Tools, the Avid Core-
Audio Driver is automatically uninstalled.

Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo
session that you can use to verify that your sys-
tem is working. The demo session for

Pro Tool LE is named “Filtered Dream.”

A\ Before installing the demo session to your
audio drive, make sure the drive is config-
ured as described in “Formatting an Audio
Drive” on page 160.

To install the demo session:

1 Insert the Pro Tools LE Installer disc into your
DVD drive.

2 On the Pro Tools LE Installer disc, locate and
open the Additional Files/Pro Tools Demo Ses-
sions Installer folder.

3 Double-click Install demo session.pkg.
4 Follow the on-screen instructions.

5 When prompted, select your audio drive as
the install location and click Next to begin the
installation.

6 When installation is complete, click Close.

194 The demo session can be opened by dou-
ble-clicking the Filtered Dream.ptf file (in the
Filtered Dream Demo Session folder).
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Connecting FireWire Drives

Connect FireWire hard drives directly to an
available FireWire port on your computer.

A Do not connect a FireWire hard drive to the
second FireWire port on the back panel of
your 003 family interface.

The FireWire ports on 003 family interfaces do
not pass data when they are powered off. If you
daisy-chain FireWire devices from your com-
puter, it is best to connect FireWire hard drives
directly to your computer and not to the 003
family interface. This will prevent hard drive er-
rors and data loss in case the 003 family inter-
face is powered off.

To yield higher performance from audio
drives, enable journaling. See “Enabling
Journaling for Audio Drives” on page 32.

To connect a FireWire hard drive, do one of the
following:

» If your computer has more than one FireWire
port, connect the FireWire hard drive to one
FireWire port on the computer, and connect
your 003 family interface to another FireWire
port on the computer.

— Or —

= If your computer has only one FireWire port,
connect the FireWire hard drive directly to your
computer and then connect your 003 family in-
terface to an available FireWire port on the
drive.
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A\ Connecting your 003 family interface to your
computer through a FireWire hard drive does
not support maximum track count. To
achieve the maximum track count, purchase
a PCI/PCMCIA/ExpressCard to increase the
number of FireWire ports on your computer.

For information on supported PCI/PCM-
CIA/ExpressCard FireWire options, visit the
Avid website (www.avid.com).

Connecting Other FireWire
Devices to 003 Family Interfaces

The second FireWire port on your 003 family in-
terface is available for daisy-chaining FireWire
devices such as digital cameras or digital video
recorders. Even when it is powered off,

003 family interfaces supply power from the
computer through its FireWire ports, letting you
recharge batteries in connected FireWire de-
vices.



Uninstalling Pro Tools

If you need to remove Pro Tools software from
your computer, use the Uninstaller application.

To uninstall Pro Tools from your computer:

1 Make sure you are logged in as an Administra-
tor for the account where Pro Tools is installed.

For details on Administrator privileges
in Mac OS X, see your Apple OS X
documentation.

2 Go to Applications/Digidesign/Pro Tools/
Pro Tools Utilities and double-click
Uninstall Pro Tools.

3 Click Continue to proceed with the uninstall.

4 Choose the type of uninstall you want to
perform:

Safe Uninstall Leaves certain plug-ins and sys-
tem files needed for compatibility with some
Avid products. Use Safe Uninstall if you are using
an Avid application or preparing to update to a
.cs release.

Clean Uninstall Removes all Pro Tools files, in-
cluding system files, plug-ins, and MIDI patch
names. Use Clean Uninstall whenever you are
preparing to upgrade, or to troubleshoot from a
clean system.

5 Click Uninstall.

6 Enter your Administrator password and click
OK.

7 Click Finish to close the Installer window.

Chapter 2: Installing Pro Tools on Mac 11
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Installing Pro Tools on Windows

This chapter contains information for Windows
systems only. If you are installing Pro Tools on a
Mac computer, see Chapter 2, “Installing

Pro Tools on Mac.”

A\ Before installing this version of Pro Tools,
see the Read Me information included on
the Pro Tools Installer disc.

Installation Overview

Installing your 003 family system on a Windows
computer includes the following steps:

1 “Installing Pro Tools LE and Connecting Your
Interface” on page 13.

2 “Launching Pro Tools LE” on page 16.

3 Configuring your system for improved perfor-
mance. (See Chapter 4, “Configuring Your
Pro Tools System.”)

4 Making audio and MIDI connections to your
003 family interface. (See Chapter 10, “Making
Studio Connections.”)

Q The Pro Tools Installer disc includes addi-
tional software for your system. For more in-
formation, see “Launching Pro Tools LE”
on page 16.

Installing Pro Tools LE and
Connecting Your Interface

Before connecting your 003 family interface to
your computer, you need to install Pro Tools LE
software.

A\ Do not start this procedure with your 003
family interface connected to your computer.

To install Pro Tools LE:

1 Start Windows, logging in with Administrator
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

Q When the installation is complete, you will
" need to restart your computer.

2 Insert the Pro Tools LE Installer disc in your
DVD drive and do one of the following:

e If Windows AutoRun is enabled, a mini-
browser appears. Select Install Pro Tools LE
to begin installation.

e If Windows AutoRun is not enabled, locate

and double-click Setup.exe on the Installer
disc.

*lg'.. aetup.exe |

Setup.exe icon
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A\ In Windows 7 and Windows Vista, if the
User Account Control dialog appears, click
Allow.

3 Follow the on-screen instructions to proceed

with installation and click Next when prompted.

4 To install the complete compliment of
Pro Tools software and plug-ins, leave Pro Tools
selected.

5 At the Select Features page, do one of the fol-
lowing:

e To install all Pro Tools application files and
free plug-in suites (and associated content),
leave the default Installation options se-
lected and click Continue.

e Select (or deselect) a custom configuration

of Installation options (see “Installation
Options” on page 15) and click Continue.

6 Click Next.
7 Click Install.

8 When prompted, connect the FireWire cable
to your 003 family interface.

A Be sure to note the orientation of the
FireWire cable connector when you insert it
in your 003 family interface. It is possible
to damage the FireWire port if you force the
connector in upside down.
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9 Do one of the following, depending on your
system configuration:

¢ If your computer has multiple FireWire
ports, plug the other end of the FireWire ca-
ble into an available FireWire port on your
computer.

—or-

e If your computer has only one FireWire
port and you are using it for an external
hard drive, plug the other end of the
FireWire cable into an available FireWire
port on the FireWire hard drive that is con-
nected to your computer.

A\ Connecting your 003 family interface to your
computer through a FireWire hard drive does
may not provide the maximum track count.
To achieve the maximum track count, install
a qualified PCI/PCMCIA/ExpressCard to in-
crease the number of FireWire ports on your
computer.

For information on supported PCI/PCM-
CIA/ExpressCard FireWire options, visit the
Avid website (www.avid.com).

If you are using a Windows laptop that has
a 4-pin FireWire port (commonly labeled
“1394”), see “Additional Software on the
Pro Tools Installer Disc” on page 17 for
FireWire cable information.

10 Plug your 003 family interface into a stan-
dard AC outlet using the AC power cable in-
cluded with the unit.

11 Power up your 003 family interface. AC
power is required to operate your device.



12 Click OK.

A In Windows 7 and Windows Vista, a series
of Windows Security dialogs may appear.
Click “Install” on each one until they go
away.

A\ In Windows XP, a series of Software Instal-
lation dialogs about the driver not passing
Windows Logo testing may appear. Click
Continue Anyway on each until they go
away. If any other dialogs appear (such as
the “Found New Hardware” dialog), leave
them open and do not click on them. These
dialogs will close on their own.

13 Wait for the installer to finish installing all
software components, drivers, and PACE System
files before proceeding to the next step.

14 When installation is complete, click Finish
and restart your computer.

Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and
plug-ins (and associated content), click the plus
(+) next to Pro Tools LE 8.0 option in the Select
Features page of the installer, and deselect any of
the following options that you do not want in-
stalled.

Application Files (Required for Pro Tools) Installs
the Pro Tools application and supporting library
files needed to run Pro Tools. This option must
be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including
DigiRack plug-ins, free Bomb Factory plug-ins,
Eleven Free, TL Utilities, and D-Fi and Maxim
plug-ins. For more information, see the Audio
Plug-Ins Guide.

Pro Tools Creative Collection

Select any of the Pro Tools Creative Collection
options you want installed. For more informa-
tion, see the Audio Plug-Ins Guide.

Effects Plug-Ins Installs 20 free effects plug-ins
from Avid’s AIR group.

Virtual Instruments Installs six free virtual in-
strument plug-ins from Avid’s AIR Group.

Virtual Instrument Content Installs sample con-
tent for AIR virtual instruments.

A\ Virtual Instrument content is very large and
may take up to 20 minutes to install. During
this time, the progress bar may not appear to
move but your software is still installing. Do
not terminate your installation.

Additional Options

The Pro Tools installer provides the following
additional options to install along with
Pro Tools software and plug-ins.

Mac HFS+ Disk Support Option This option lets
your Pro Tools system read, write, record, and
play back using Mac-formatted HFS+ disks. HFS+
disks are commonly referred to as Mac OS Ex-
tended (Journaled) disks.

For information on using the Mac HFS+
Disk Support option, see the HFS+ Disk Sup-
port Option Guide.

Avid Video Engine This option lets you integrate
Avid® video peripherals such as the Avid Mojo®
with your Pro TOols system. Do not install un-
less you will be using one of these products.

Command|8 Controller and Driver This option in-
stalls the personality file and device driver for
the Avid Command|8® control surface. Do not
install unless you will be using Command|8.

Chapter 3: Installing Pro Tools on Windows
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Installing QuickTime

QuickTime is required for Pro Tools if you plan
to include movie files, or import MP3 or MP4
(AACQ) files in your sessions. QuickTime for Win-
dows is available as a free download from the
Apple website (www.apple.com).

A\ For information on which version of
QuickTime is compatible with your ver-
sion of Pro Tools, visit the compatibility
pages of the Avid website
(www.avid.com).

To install QuickTime:
1 Visit www.apple.com and go to the Quick-

Time page.

2 Download the QuickTime installer applica-
tion to your computer.

3 Double-click the QuickTime installer applica-
tion and follow the on-screen installation in-
structions.

4 Restart your computer.
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Launching Pro Tools LE

When launching Pro Tools the first time, you
are prompted to enter an authorization code to
validate your software. (The code begins with
the letters DIGI.)

To authorize Pro Tools software:

1 Make sure your 003 family interface is con-
nected to your computer and powered on.

2 Double-click the Pro Tools LE shortcut on
your desktop (or the application icon in the
Pro Tools folder inside the Digidesign folder).

A If you get a warning dialog about updating
the firmware for your hardware, follow the
on-screen instructions to perform the
firmware update. See “Updating 003 Fam-
ily Firmware” on page 17.

3 Enter the authorization code in the dialog
(making sure to type it exactly as printed,
observing any spaces and capitalization), then
click Validate. (Your authorization code is lo-
cated on the back of your Pro Tools DVD wallet.)



4 Use the Quick Start dialog to do one of
the following:

e Create a new session from a template.
¢ Create a new blank session.

e Open any other session on your system.

Dk Saset (]

@ PRO TOOLS
LE

Quick Start dialog

For more information on the Quick
Start dialog and session templates, see
the Pro Tools Reference Guide
(Help > Pro Tools Reference Guide).

Updating 003 Family Firmware

When you launch Pro Tools software, it auto-
matically checks the version of the unit’s firm-
ware and prompts you to update it if a newer
version is available.

If you update your unit’s firmware, let the up-
date complete before disconnecting or turning
off your system.

When a firmware update completes, Pro Tools
quits, and you must relaunch Pro Tools.

If during the update process you get a message

that Pro Tools cannot communicate with your

003 family interface, wait up to 30 seconds for

the message to close. If the message does not go
away, power off 003 family interface and then

power it on again.

Additional Software on the
Pro Tools Installer Disc

The Pro Tools Installer disc provides additional
software for your system, including a Pro Tools
demo session.

@ Refer to your Pro Tools Installer disc for
additional software and installers.

Third-Party Applications and
Plug-Ins

Your Pro Tools package also includes several free
applications and plug-ins from selected Third
Party developers. Once you've completed your
Pro Tools installation, you can install these sep-
arately. Go to the Additional Files\3rd Party
Content folder on the Pro Tools LE Installer
disc.

003 Factory Bundie Plug-Ins

If you purchased a Factory version of your 003
family system, the installers for your Factory
Bundle are located on your Pro Tools Installer
disc in the \Additional Files\Factory Bundle In-
stallers folder.

Avid Audio Drivers

The Avid Audio Drivers are multi-client, multi-
channel sound drivers that allow Pro Tools and
third-party audio programs that support the
ASIO Driver or WaveDriver MME/DirectX (Mul-
timedia Extension) standards to record and play
back through qualified Pro Tools audio inter-
faces.

For additional information on the Avid
Audio Drivers, see the Windows Audio
Drivers Guide.

Chapter 3: Installing Pro Tools on Windows
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Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo
session that you can use to verify that your sys-
tem is working. The demo session for

Pro Tool LE is named “Filtered Dream.”

A Before installing the demo session to your
audio drive, make sure the drive is config-
ured as described in “Formatting an Audio
Drive” on page 160.

To install the demo session:

1 Insert the Pro Tools LE Installer disc into your
DVD drive.

2 On the Pro Tools LE Installer disc, locate and
open the Additional Files\Pro Tools Demo Ses-
sions Installer folder.

3 Double-click LE Demo Session Setup.exe.
4 Follow the on-screen instructions.

5 When prompted, select your audio drive as
the install location and click Next to begin the
installation.

6 When installation is complete, click Finish.

()" The demo session can be opened by double-
clicking the Filtered Dream.ptf file (located
in the Filtered Dream Demo Session folder).
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Connecting FireWire Drives

Connect FireWire hard drives directly to an
available FireWire port on your computer.

A Do not connect a FireWire hard drive to the
second FireWire port on the back panel of
your 003 family interface.

The FireWire ports on 003 family interfaces do
not pass data when they are powered off. If you
daisy-chain FireWire devices from your com-
puter, it is best to connect FireWire hard drives
directly to your computer and not to the 003
family interface. This will prevent hard drive er-
rors and data loss in case your 003 family inter-
face is powered off.

To connect a FireWire hard drive, do one of the
following:

= If your computer has more than one FireWire
port, connect the FireWire hard drive to one
FireWire port on your computer, and connect
your 003 family interface to another FireWire
port on the computer.

— Or —

= If your computer has only one FireWire port,
connect the FireWire hard drive directly to your
computer and then connect your 003 family in-
terface to an available FireWire port on the
drive.

A Connecting your 003 family interface to
your computer through a FireWire hard drive
does not support maximum track count. To
achieve the maximum track count, purchase
a PCI/PCMCIA/ExpressCard to increase the
number of FireWire ports on your computer.

For information on supported PCI/PCM-
CIA/ExpressCard FireWire options, visit the
Avid website (www.avid.com).



Connecting Other FireWire
Devices to 003 Family Interfaces

The second FireWire port on your 003 family in-
terfaceisavailable for daisy-chaining FireWire de-
vices such as digital cameras or digital video re-
corders. Even when it is powered off, 003 and
003 Rack supply power from the computer
through its FireWire ports, letting you recharge
batteries in connected FireWire devices.

Connecting to Laptops with
4-Pin FireWire Cable

003 family interfaces include a 6-pin to 6-pin
FireWire cable. Some Windows laptops include
only a 4-pin FireWire port (commonly labeled
“‘1394"). To use your 003 family with these
computers, a 4-pin to 6-pin cable is required.
Purchase this cable (part number #9940-30779-
00) through your authorized Avid dealer or on-
line at www.avid.com.

A\ This cable can also be purchased at com-
puter supply stores. Maximum supported
cable length for FireWire (IEEE-1394) is
14 feet (4.3 meters).

Uninstalling Pro Tools

If you need to remove Pro Tools software from
your computer, use the Uninstaller application.

To uninstall Pro Tools from your computer:

1 Start Windows, logging in with Administrator
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

2 Go to Program Files\Digidesign\
Pro Tools\Pro Tools Utilities and double-click
Uninstall Pro Tools.exe.

3 Click Next.

4 Click Uninstall to proceed with the uninstall.

Chapter 3: Installing Pro Tools on Windows
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chapter 4

Configuring Your Pro Tools System

After you have connected your system and in- Shut down your Pro Tools system in this order:
stalled Pro Tools software, you are ready to start

1 Quit Pro Tools and any other running applica-
up and configure your Pro Tools system.

tions.
To quit Pro Tools, choose Pro Tools >
starting Up or Shutting Down Quit (Mac) or File > Exit (Windows).

Your sys'tem 2 Turn off or lower the volume of all output
devices in your system.

To ensure that the components of your

Pro Tools system communicate properly with 3 Turn off your computer.
each other, you need to start them in a particu- L
lar order 4 Turn off the 003 family interface.

5 Turn off any MIDI interfaces, MIDI devices, or

Start up your Pro Tools system in this order: synchronization peripherals.
1 Lower the volume of all output devices in your 6 Turn off any control surfaces.
system.

7 Turn off any external hard drives.
2 Turn on any external hard drives. Wait ap-

proximately ten seconds for them to spin up to
speed.

3 Turn on any control surfaces (such as Com-
mand|8).

4 Turn on any MIDI interfaces, MIDI devices, or
synchronization peripherals.

5 Turn on the 003 family interface.
6 Turn on your computer.

7 Launch Pro Tools or any third-party audio or
MIDI applications.
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Configuring Pro Tools LE
Software

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools lets you
adjust the performance of your system by
changing system settings that affect its capacity
for processing, playback, and recording.

In most cases, the default settings for your sys-
tem provide optimum performance, but you
may want to adjust them to accommodate large
or processing-intensive Pro Tools sessions.

E Playback Engine

003 Settings

HIW Buffer Size: | 512 Samples

RTAS Processars: | 2 Processor

| |3 [

CPU Usage Limit: | 85 %

RTAS Engine [ 'gnere Erars During Playback/Record (may
9N cause clicks and pops

DAE Playback Buffer (disk buffer)

Size: | 3000 ms; Level 4 [ Cache Size: Normal =

Lower values for the disk buffer reduce disk latency (system more responsive). Higher values
improve disk performance (system less responsive)

Plug-in Streaming Buffer

size: [ 250 ms; Level 2 (De... | &

[ Optimize for streaming content on audio drives (requires more system memory)

==
Playback Engine dialog (with Structure installed)
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Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) con-
trols the size of the buffer used to handle host
processing tasks such as RTAS plug-ins.

e Lower Hardware Buffer Size settings are useful
for improving latency issues in certain record-
ing situations or for improving certain system
performance problems. On Pro Tools LE sys-
tems, lower settings reduce all input-to-out-
put monitoring latency on any record-armed
tracks or Auxiliary Input tracks with live in-
puts.

e Higher Hardware Buffer Size settings are use-
ful for sessions that are using more RTAS plug-
ins for playback. These settings allow for more
audio processing. They can also be useful to
reduce errors on machines that require a
higher buffer size.

A\ Inaddition to causing slower screen response
and monitoring latency, higher Hardware
Buffer Size settings can increase the latency
caused by RTAS plug-ins, and affect the
accuracy of plug-in automation, mute data,
and MIDI track timing.

To change the Hardware Buffer Size:

1 Choose Setup > Playback Engine.

2 From the H/W Buffer Size pop-up menu, select
the audio buffer size, in samples.

3 Click OK.



Host Processors

The Host Processors setting lets you manage
multi-processor support for RTAS (Real-Time
AudioSuite) plug-in processing.

Used in combination with the CPU Usage Limit
setting, the Host Processors setting lets you con-
trol the way RTAS and other host-based process-
ing tasks are carried out by the system.

For example:

¢ For sessions with large numbers of RTAS
plug-ins, you can allocate 2 or more proces-
sors to Host Processing and set a high CPU
Usage Limit.

¢ For sessions with few RTAS plug-ins, you can
allocate fewer processors to host processing
and set a low CPU Usage Limit to leave more
CPU resources available for automation accu-
racy, screen response, and video.

e Depending on the importance of video and
overall screen response, and on the density of
automation being employed, try different
combinations of Host Processors and CPU Us-
age Limit settings to achieve the best results.
For example, to improve screen response in a
medium-sized session using a moderate num-
ber of RTAS plug-ins, try reducing the number
of RTAS plug-ins, but keep the CPU Usage Limit
set to the maximum (up to 99% on a single
processor system).

To set the number of Host Processors:

1 Choose Setup > Playback Engine.

2 From the Host Processors pop-up menu, select
the number of available processors you want to
allocate. The number of processors varies de-
pending on your computer:

e Select 1 Processor to limit processing to
one CPU in the system.

e Choose 2 Processors to enable load balanc-
ing across two available processors.

¢ On systems running four or more proces-
sors, choose the number of processors for
processing.

3 Click OK.

System Usage Window and Processing

The System Usage window (Window > System Us-
age) displays the combined amount of process-
ing occurring on all enabled processors with a
single indicator, regardless of how many proces-
sors are available in the system. If the System Us-
age Window shows that you are at the limit of
available resources, increase the number of pro-
cessors and adjust the CPU Usage Limit setting.
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CPU Usage Limit

The CPU Usage Limit setting controls the per-
centage of CPU resources allocated to Pro Tools
host processing tasks. Used in combination with
the Host Processors setting, the CPU Usage Limit
setting lets you control the way Pro Tools tasks
are carried out by the system.

e Lower CPU Usage Limit settings limit the effect
of Pro Tools processing on other CPU-inten-
sive tasks, such as screen redraws, and are use-
ful when you are experiencing slow system
response, or when running other applications
at the same time as Pro Tools.

e Higher CPU Usage Limit settings allocate more
processing power to Pro Tools, and are useful
for playing back large sessions or using more
RTAS plug-ins.

The maximum available CPU Usage Limit de-
pends on the number of processors in your com-
puter and on the number of processors you spec-
ify for host processing. This value can range
from 85% for single-processor computers, and
99% for multiprocessor computers (which dedi-
cate one entire processor to Pro Tools).

On multiprocessor computers, the maximum
CPU Usage Limitis reduced when you use all your
processors (as selected in the Host Processors
pop-up menu). For example, on dual-processors,
the limit is 90%. On four-processor computers,
the limit is 95%.

A Increasing the CPU Usage Limit may slow
down screen responses on slower computers.
To change the CPU Usage Limit:
1 Choose Setup > Playback Engine.

2 From the CPU Usage Limit pop-up menu, select
the percentage of CPU processing you want to
allocate to Pro Tools.

3 Click OK.
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Host Engine (Error Suppression)

The Host Engine option determines error report-
ing during playback and recording. This is espe-
cially useful when working with instrument
plug-ins.

You should only enable error suppression if you
are experiencing frequent RTAS errors that are
interrupting your creative workflow. When er-
ror suppression is enabled, you can experience a
degradation of audio quality. However, this may
be acceptable in order to avoid interrupting
playback and recording when working with in-
strument plug-ins. Be sure to disable error sup-
pression when you need to ensure the highest
possible audio quality, such as for a final mix.

To enable error suppression:

1 Choose Setup > Playback Engine.

2 Select Host Engine: Ignore Errors During Play-
back/Record.

3 You can also select Minimize Additional I/0
Latency.

4 Click OK.

Error Suppression Options

Ignore Errors During Playback/Record

When enabled, Pro Tools continues to play and
record even if the RTAS processing requirements
exceed the selected CPU Usage Limit. This can re-
sult in pops and clicks in the audio, but does not
stop the transport.



Minimize Additional 1/0 Latency

When enabled, any additional latency due to
suppressing errors during playback and record is
minimized to 128 samples. Suppressing errors
requires at least 128 samples of additional buff-
ering on some systems. If this option is disabled,
the buffer is half the H/W Buffer Size, or at least
128 samples (whichever is greater). If you are us-
ing an older, slower computer, you may want to
disable this option to avoid adverse perfor-
mance.

This option is only available if the Ignore Errors
During Playback/Record option is enabled.

DAE Playback Buffer Size

The DAE Playback Buffer Size setting determines
the amount of memory DAE allocates for disk
buffers. In addition to levels, the DAE Playback
Buffer Size shows values in milliseconds, which
indicate the amount of audio buffered when the
system reads from disk.

The optimum DAE Playback Buffer Size for most
disk operations is 1500 msec; Level 2 (Default).

e DAE Playback Buffer Size settings lower than
1500 msec; Level 2 (Default) may improve
playback and recording initiation speed, as
well as preview in context in DigiBase brows-
ers. However, a lower setting may make it dif-
ficult to play or record tracks reliably with
sessions containing a large number of tracks
or a high density of edits, or with systems that
have slower or heavily-fragmented hard
drives.

e DAE Playback Buffer Size settings higher than
1500 msec; Level 2 (Default) allow higher track
count, higher density of edits in a session, or
the use of slower hard drives. However, a
higher setting may increase the time lag when
starting playback or recording, starting pre-
view in context from DigiBase browsers, or
cause a longer audible time lag while editing
during playback.

Q Using a larger DAE Playback Buffer Size

leaves less system memory for other tasks.
The default setting of 1500 msec (Level 2) is
recommended unless you are encountering
-9073 (“Disk too slow or fragmented”)
errors.

To change the DAE Playback Buffer Size:

1 Choose Setup > Playback Engine.

2 From the DAE Playback Buffer pop-up menu, se-
lect a buffer size. Memory requirements for each
setting are shown at the bottom of the Playback
Engine dialog.

3 Click OK.

If Pro Tools needs more system memory for the
DAE Playback Buffer, it will prompt you to re-
start your computer.
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Cache Size

The Cache Size setting determines the amount
of memory DAE allocates to pre-buffer audio for
playback and looping when using Elastic Audio.

Minimum Reduces the amount of system mem-
ory used for disk operations and frees up mem-
ory for other system tasks. However, perfor-
mance when using Elastic Audio features may
decrease.

Normal Is the optimum Cache Size for most ses-
sions.

Large Improves performance when using Elastic
Audio features, but it also decreases the amount
of memory available for other system tasks, such
as RTAS processing.

Q Using a larger Cache Size leaves less system
" memory for other tasks. The default setting
of Normal is recommended unless you are
encountering -9500 (“Cache too small”)
errors.

To change the Cache Size:

1 Choose Setup > Playback Engine.

2 From the Cache Size pop-up menu, select a
disk cache size.

3 Click OK.
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Plug-In Streaming Buffer Size
(Structure Plug-In Only)

This setting appears in the Playback Engine dia-
log only if Structure, Structure LE, or

Structure Free is installed on your system. The
Plug-In Streaming Buffer Size determines the
amount of memory DAE allocates for streaming
playback from disk with the Structure plug-in.
This setting only affects playback if disk stream-
ing is activated in Structure’s plug-in controls
(see the Air Virtual Instruments Guide for more in-
formation).

The optimum Plug-In Streaming Buffer Size for
most sessions is 250 ms (Level 2).

¢ Plug-In Streaming Buffer Size settings lower
than 250 msec (Level 2) reduce the amount of
system memory used for sample playback and
frees up memory for other system tasks. How-
ever, audio quality of sample playback may
decrease.

¢ Plug-In Streaming Buffer Size settings higher
than 250 msec (Level 2) improve the audio
quality of sample playback, but they also de-
crease the amount of memory available for
other system tasks, such as RTAS processing.

Q Using a larger Plug-In Streaming Buffer Size
leaves less system memory for other tasks.
The default setting of 250 ms (Level 2) is
recommended unless you are experiencing
problems with the audio quality of sample
playback.

To change the Plug-In Streaming Buffer Size:
1 Choose Setup > Playback Engine.

2 From the Plug-In Streaming Buffer Size pop-up
menu, select a buffer size.

3 Click OK.



Optimizing the Plug-In Streaming
Buffer Size

(Structure Plug-In Only)

This option appears in the Playback Engine dia-
log only if one of the Structure sampler instru-
ment plug-in is installed on your system. This
option is useful when you are playing samples
from the same drive that contains audio for the
current session. When this option is selected,
Pro Tools automatically optimizes the size of the
Plug-In Streaming Buffer to facilitate disk access
from both Pro Tools and Structure. The Plug-In
Streaming Buffer Size pop-up menu is unavail-
able when this option is selected.

To set Pro Tools to optimize the Plug-In Streaming
Buffer Size:

1 Choose Setup > Playback Engine.

2 Select the Optimize for Streaming Content op-
tion.

3 Click OK.

Configuring the Pro Tools
Hardware Settings

In the Hardware Setup dialog, Pro Tools lets you
set the default sample rate and clock source for
your system, and configure the digital inputs on
the 003 family interface.

Default Sample Rate

The Sample Rate setting appears as the default
sample rate when you create a new session. (This
setting is available in the Hardware Setup dialog
only when no session is open.)

@ You can change the sample rate when
creating a new Pro Tools session by selecting
a different sample rate in the New Session
dialog. See the Pro Tools Reference Guide for
details.

To change the default Sample Rate:

1 Choose Setup > Hardware.

Hardware Setup dialog

2 Select the sample rate from the Sample Rate
pop-up menu.

3 Click OK.
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Clock Source

The Pro Tools Hardware Setup dialog lets you
select the Clock Source for the system.

Internal If you are recording an analog signal di-
rectly into Pro Tools, you will usually use the In-
ternal setting.

External If you are transferring material into
Pro Tools from an external digital device, or if
you utilize a common house clock signal, you
will synchronize Pro Tools to the digital device
or common signal. The external clock source
corresponds to the connector on the back of the
003 family interface that is receiving your clock
signal: S/PDIF (RCA), Optical, or Word Clock. If
you are using an optical device, you also need to
set the Optical Format (ADAT or S/PDIF).

A You can use only one pair of S/PDIF inputs
(either RCA or Optical) at a time. At
96 kHz, it is recommended that you use the
S/PDIF (RCA) port.

Note that S/PDIF (RCA) output is still
available when S/PDIF Optical is selected.

To select the Clock Source:

1 Choose Setup > Hardware.
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2 Choose the clock source from the Clock
Source pop-up menu.

Hardware Setup 3]
Porighor ok
Cptical Format.
(5 ADaT
Crapoer
oy
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w Intaead 5
WPOF (RCA)
ek
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3 |

Hardware Setup dialog

A\ Your digital input device must be connected
and turned on for Pro Tools to synchronize
to it. If your input device is not turned on,
leave the Clock Source set to Internal.

A Only one S/PDIF input pair can be used at a
time. When you select S/PDIF (RCA) as the
Clock Source, the Optical Format setting
will switch to ADAT (for sample rates
44.1 kHz and 48 kHz), or to None (for sam-
ple rates 88.2 kHz and 96 kHz).

Conversely, when you select S/PDIF as the
Optical Format, the Clock Source setting
will switch to Internal if it was previously
set to S/PDIF (RCA).

3 Click OK.



Optical Format

The Optical port can be set for eight channels of
ADAT Optical I/O (supporting up to 48 kHz) or
two channels of S/PDIF Optical I/O. The Optical
Format ADAT option is replaced by None for ses-
sion rates 88.2 kHz and 96 kHz.

If you are using an optical device for recording,
you need to set the Optical Format.

To select the digital format of the Optical 1/0 port:
1 Choose Setup > Hardware.

2 In the Optical Format section, do one of the
following:
e Select ADAT if your optical device is using
the ADAT format.

— Or —

¢ Select S/PDIFif your optical source device is
using the S/PDIF format.

A\ Only one S/PDIF input pair can be used at a
time. When you select S/PDIF as the
Optical Format, the Clock Source setting
will switch to internal if it was previously
set to S/PDIF (RCA).

Conversely, when you select S/PDIF (RCA)

as the Clock Source, the Optical Format set-
ting will switch to ADAT (for sample rates

44.1 kHz and 48 kHz), or to None (for sam-
ple rates 88.2 kHz and 96 kHz).

3 Click OK.

Configuring 1/0 Setup

Using the I/O Setup dialog, you can label

Pro Tools LE input, output, insert, and bus signal
paths. The 1/O Setup dialog provides a graphical
representation of the inputs, outputs, and signal
routing of the 003 family interface.

Pro Tools LE has default I/O Setup settings that
will get you started. Use the I/O Setup dialog
only if you want to rename the default I/O
paths.

To rename 1/0 paths in 1/0 Setup:
1 Choose Setup > 1/0.

New Fath | Dafautt |

| tmportSettings | [ Export Settngs | [_Concel | |Il

/0 Setup dialog, Input tab

2 Click the Input, Output, Insert, or Bus tab to dis-
play the corresponding paths.
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3 To change the name of a path or subpath, dou-
ble-click directly on the Path Name, type a new
name for the path, and press Return (Mac) or
Enter (Windows).

4 Click OK.

See the Pro Tools Reference Guide (or choose
Help > Pro Tools Reference Guide) for more
information on renaming 1/0 paths.

Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools,
do one of the following:

= On Mac, configure your MIDI setup with Au-
dio MIDI Setup. See Appendix B, “Configuring
AMS (Mac OS X Only)” for details.

— Or —

= On Windows, configure your MIDI setup with
MIDI Studio Setup. See Appendix C, “Configur-
ing MIDI Studio Setup (Windows Only)” for de-
tails.

Backing Up Your System
Configuration

After configuring your system and Pro Tools,
you should save an image of your system drive
using a backup utility such as Norton Ghost
(Windows) or Bombich Carbon Copy Cloner
(Mac). By doing this, you can quickly restore
your system configuration and settings if you
encounter any problems.
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Optimizing a Mac System for
Pro Tools

To ensure optimum performance with
Pro Tools LE, configure your computer before
using Pro Tools hardware and software.

Before configuring your computer, make sure
you are logged in as an Administrator for the ac-
count where you want to install Pro Tools. For
details on Administrator privileges in Mac OS X,
refer to your Apple OS X documentation.

A Do not use the Mac OS X automatic Soft-
ware Update feature, as it may upgrade
your system to a version of Mac OS that has
not yet been qualified for Pro Tools. For
details on qualified versions of Mac OS,
visit www.avid.com/compatibility.

Turning Off Software Update

To turn off the Software Update feature:

1 Choose System Preferences from the Apple
menu and click Software Update.

2 Click the Software Update tab.

3 Deselect Check for Updates.

Turning Off Energy Saver

To turn off the Energy Saver feature:

1 Choose System Preferences from the Apple
menu and click Energy Saver.

2 Click the Sleep tab and do the following:
e Set the computer sleep setting to Never.
e Set the display sleep setting to Never.

e Deselect the Put the hard disk(s) to sleep
when possible option.



Disable or Reassign Mac Keyboard
Shortcuts Used by Pro Tools

To have the full complement of Pro Tools key-
board shortcuts, you need to disable or reassign
any conflicting Mac OS X Keyboard Shortcuts in
the Apple System Preferences, including the
following:

e “Show Help menu”

e Under “Keyboard Navigation”
e “Move focus to the window drawer”

e Under “Dock, Exposé, and Dashboard”
e “Automatically hide and show the Dock”
e “All windows”

e “Application windows”

e “Desktop”
¢ “Dashboard”
e “Spaces”

e Under “Spotlight”
e “Show Spotlight search field”
e “Show Spotlight window”

For a complete list of Pro Tools keyboard
shortcuts, see the Keyboard Shortcuts Guide
(Help > Keyboard Shortcuts).

To disable or reassign Mac 0S X keyboard
shortcuts:

1 Choose System Preferences from the Apple
menu and click Keyboard & Mouse.

2 Click the Keyboard Shortcuts tab.

3 Do one of the following:
¢ Deselect the Mac OS X options that conflict
with Pro Tools keyboard shortcuts.
—or-
¢ Assign different, non-conflicting keyboard

shortcuts to the corresponding Mac OS X
options.

Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign
the Spaces keyboard shortcuts to avoid conflicts
with important Pro Tools keyboard shortcuts.
You can reassign Spaces keyboard shortcuts to
use a combination of modifier keys (Com-
mand+Option+Control+Shift) in addition to
the default Spaces keyboard shortcut assign-
ments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use
modifier key combinations that do not conflict
with Pro Tools keyboard shortcuts:

1 Choose System Preferences from the Apple
menu and click Exposé & Spaces.

2 Click the Spaces tab.
3 Ensure that Enable Spaces is selected.

4 Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+F8” from the “To activate Spaces” pop-up
menu.

5 Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+Arrow Keys” from the “To switch between
spaces” pop-up menu.

6 Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+Number Keys” from the “To switch directly
to a space” pop-up menu.
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Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically
indexes files and folders on local hard drives in
the background. In most cases, this is not a con-
cern for normal Pro Tools operation. However,
if Spotlight starts indexing drives while record-
ing in a Pro Tools session with high track counts
for an extended period of time, it can adversely
affect Pro Tools system performance. You may
want to disable Spotlight indexing for all local
drives before using Pro Tools for big recording
projects.

A\ Disabling Spotlight indexing also disables
the Find function in Mac OS X.

To disable Spotlight indexing:

1 Choose System Preferences from the Apple
menu and click Spotlight.

2 In the Spotlight window, click the Privacy tab.

3 To prevent indexing of a drive, drag its icon
from the desktop into the list.

Enabling Journaling for Audio Drives
To yield higher performance from audio drives,

enable journaling.

To enable journaling:

1 Launch the Disk Utility application, located in
Macintosh HD/Applications/Utilities.

2 Select the volume in the left column of the
Disk Utility window.

3 Click Enable Journaling in the toolbar.
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Optimizing a Windows System
for Pro Tools

To ensure optimum performance with
Pro Tools LE, configure your computer before
using Pro Tools hardware and software.

For Mac System Optimization, see
“Optimizing a Mac System for Pro
Tools” on page 30.

Before configuring your computer, make sure
you are logged in as an Administrator for the ac-
count where you want to install Pro Tools. For
details on Administrator privileges, see your
Windows documentation.

Required Optimizations

To ensure optimum performance with
Pro Tools, configure the following settings be-
fore using Pro Tools hardware and software.

A\ When you are finished changing Windows
system settings, restart your computer.

Enabling DMA

Enabling your computer's DMA (Direct Memory
Access) frees up CPU bandwidth so your com-
puter can do other Pro Tools tasks.

In most cases the DMA option will already be set
correctly, as Windows detects and activates
DMA mode by default.



To enable DMA for any IDE hard drives:
1 Choose Start.

2 Right-click Computer (Windows 7, Windows
Vista) or My Computer (Windows XP) and choose
Manage.

3 In the left pane of Computer Management un-
der System Tools, click on Device Manager.

4 In the right pane, click the triangle
(Windows 7) or the plus (+) sign (WindowsXP
and Windows Vista) next to IDE ATA/ATAPI
Controllers.

5 Double-click on an IDE Channel.
6 Click the Advanced Settings tab.

7 Under Device Properties, check the box Enable
DMA (Windows 7, Windows Vista) or under each
listed Device, set the Transfer Mode to DMA if
available (Windows XP).

8 Click OK.

9 Repeat for each IDE Channel.

Configuring Windows Power
Management Settings

Pro Tools requires maximum CPU performance
for optimal RTAS processing and disk streaming.
For best performance, use the following recom-
mended Windows Power Management settings.

To configure Windows Power Management
Settings (Windows 7, Windows Vista):

1 Choose Start > Control Panel.
2 Click Hardware and Sound > Power Options.

3 In the Power Options control panel, click High
Performance.

4 Click Change plan settings.

5 Click Change advanced power settings to
change additional settings.

6 Click Hard disk > Turn off hard disk after =
Never. You can make optional changes such as
disabling sleep and disabling shutting down the
monitor.

7 Click OK or click Save changes to save the
changes.

8 Close the window.

To configure Windows Power Management
Settings (Windows XP):

1 Choose Start > Control Panel.

2 Double-click Power Options.

3 Click the Power Schemes tab.

4 From the Power Schemes pop-up menu, select
Always On.

5 Verify that the following settings are set to
Never:

e Turn off hard disks

e System standby

e System hibernates

6 Click OK.
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Disabling User Account Control
(Windows 7, Windows Vista)

Some third-party applications that interface
with Pro Tools may require UAC to be disabled
for proper operation.

To disable User Account Control (UAC):

1 Choose Start > Control Panel.
2 Click User Accounts and Family Safety.

3 In the User Accounts and Family Safety control
panel, click User Accounts.

4 Click Change User Account Control settings
(Windows 7) or Turn User Account Control on or off
(Windows Vista).

5 Move the User Account Control slider to Never
Notify (Windows 7), or deselect the Use User Ac-
count Control (UAC) to help protect your computer
option (Windows Vista).

6 Click OK.

7 Restart your computer.

Recommended Optimizations

Pro Tools can also be affected by other software
and hardware drivers installed on your com-
puter. For best possible performance, it is recom-
mended (but not required) that you do the fol-
lowing:
¢ Avoid running any unneeded programs at
the same time as Pro Tools.

e Turn off any software utilities that run in
the background, such as Windows Messen-
ger, calendars, and disk maintenance pro-
grams.

e Turn off any non-essential USB devices
while running Pro Tools.
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e If your video display card supports it, en-
able Bus Mastering in the manufacturer’s
Control Panel. See the manufacturer’s in-
structions for details.

Optional Optimizations

The following system optimizations may help
Pro Tools perform better on some systems. It is
recommended that you only try these optimiza-
tions if necessary, as they may disable or ad-
versely affect the functionality of other pro-
grams on your system.

Disabling Network Cards

If applicable, disable any networking cards
(other than a FireWire card that you might use
to connect an external drive to your system).

To disable a network card (Windows 7,
Windows Vista):

1 Choose Start > Computer.
2 Click System Properties.

3 In the left-hand pane under Control Panel
Home, click on Device Manager.

4 In the Device Manager window, double-click
Network adapters.

5 Right-click on the network adapter and select
Disable.

6 Repeat as necessary for additional network
adapters

7 Close the Device Manager window.



To disable a network card (Windows XP):
1 Right-click My Computer (Windows XP) and
choose Manage.

2 Under System Tools, select Device Manager.

3 In the right-hand pane, click “+” to reveal Net-
work adapters.

4 In the Device Manager window, double-click
Network adapters, then double-click the Network
Adapter card you want to disable.

5 Under the General tab, choose Do not use this
device (disable) from the Device Usage pop-up
menu, then click OK.

6 Close the Computer Management window.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1 Right-click Computer (Windows 7, Windows
Vista) or My Computer (Windows XP) and choose
Properties.

2 Click the Advanced system settings link in the
left pane (Windows 7, Windows Vista) or the
Advanced tab (Windows XP).

3 Under the Performance section, click the Set-
tings button.

4 In the Performance Options window, click the
Advanced tab.

5 Under the Processor Scheduling section, select
the Background Services option.

6 Click OK to close the Performance Options
window.

7 Click OK to close the System Properties win-
dow.

8 Restart the computer for the changes to take
effect.

Disabling System Startup Items

The fewer items in use by your computer, the
more resources are available for Pro Tools. Some
startup applications may be consuming unnec-
essary CPU resources, and can be turned off.

If you disable any of the following startup items,
do so carefully:

e Portable media serial number (required for
some applications that utilize a copy pro-
tection key)

e The Plug and Play service
e Event log

e Cryptographic services

To Disable System Startup Items:

1 From the Start menu, type “msconfig” in Start
Search (Windows 7 and Windows Vista) or in
Run (Windows XP) and click OK to open the Sys-
tem Configuration Utility.

2 Under the General tab, choose Selective
Startup.

3 Deselect Load Startup Items and click OK.
4 Click Restart to restart the computer.

5 After restarting, the computer displays a Sys-
tem Configuration message. Check to see if
Pro Tools performance has increased before you
deselect the Don't show this message again op-
tion. If performance has not changed, run
“msconfig” and return your computer Startup
Selection back to Normal Startup - load all device
drives and services. Alternatively, try disabling
Startup items and non-essential processes indi-
vidually.
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003 Top Panel

003 Operating Modes

003 can be in any of five states when it is on:
e Standby mode
e Pro Tools mode
e MIDI mode
e Third-Party Software mode
e Utility mode

Standby Mode

003 is in this mode when you first power on the
unit, waiting for you to launch Pro Tools (or an-
other supported application).

In Standby mode, the unit displays “003 Of-
fline” in the top row of the 003 display and the
Monitor Mute switch is enabled (lit).

In Standby mode, the Monitor section I/O ports
are available, without having to power on the
computer.

While in Standby mode, you can also switch to
MIDI mode to control external MIDI devices
(without having to power on the computer).
However, you cannot use 003 as a standalone
MIDI router; you must route MIDI through
software.

Pro Tools Mode

003 is in this mode when the 003 unit is con-
nected to a computer and Pro Tools LE software
is running.

If Pro Tools is running and no session is open,
the unit normally displays “Open or create a
new session.” When a session is being launched,
the display changes to “Loading a session.”

Q If no session is open and a Workspace
" browser is open and being used to audition
an audio file, the unit displays “Working.”

When a Pro Tools session is open, the unit mir-
rors the on-screen controls. 003 faders, transport
switches, rotary knobs, and switches control the
corresponding elements in Pro Tools. You can
also use 003 MIDI ports as you would those on a
standard MIDI interface.

In Pro Tools mode, the Monitor section and
MIDI I/O ports are available with a session open
or closed.

To put 003 in Pro Tools mode:

1 Make sure the 003 unit is properly connected
to the computer and powered on.

2 If Mute is disabled (unlit), enable Mute by
pressing the Monitor Mute switch so that it is lit.

3 Launch Pro Tools LE and open or create a
Pro Tools session.

Chapter 5: 003 Top Panel
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MIDI Mode

003 is in this mode when either the MIDI Map A
or B switch is enabled (lit). In this mode, 003
functions as a MIDI control surface for external
devices and applications other than Pro Tools.
MIDI mode can be enabled in Pro Tools mode,
Third-Party Software mode, or Standby Mode.
For more information, see Chapter 12, “Using
MIDI Mode with 003.”

Third-Party Software Mode

003 is in this mode when the 003 unit is con-
nected to a computer and you launch a
third-party audio application (such as iTunes or
Ableton Live), and then use 003 as your play-
back or recording device. You can also use 003
MIDI ports as you would those on a standard
MIDI interface.

In this mode, the unit displays “Working” in the
top row of the LCD.

On Windows, ASIO- and WaveDriver-compati-

ble applications are supported. WaveDriver sup-
ports playback only. On Mac, CoreAudio Driver
applications are supported.

! For more information on third-party audio
drivers, see the Windows Audio Drivers Guide
(for ASIO or WaveDriver on Windows) or the
CoreAudio Drivers Guide (Mac).
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To use a third-party software application with 003:

1 Make sure 003 is properly connected to the
computer and in Standby mode.

2 Configure your system and software for ASIO,
WaveDriver, or CoreAudio Driver.

See the Windows Audio Drivers Guide (for
ASIO and WaveDriver on Windows) or the
CoreAudio Drivers Guide (Mac).

3 If Mute is disabled (unlit), press the Monitor
Mute switch.

4 Launch your third-party audio application.
5 Disable the Monitor Mute switch (unlit).

6 Use monitor section controls and switches to
adjust audio input routing, monitor levels, and
headphone levels.

Playing Audio Audio from your third-party soft-
ware application can be routed to 003’s outputs,
via the FireWire connection.

Recording Audio (ASIO Driver and CoreAudio
Driver Only) Audio from 003 inputs can be
routed to software inputs in your third-party
software applications, through the FireWire
connection.

Refer to the documentation for your third-party
software for information on configuring inputs
and outputs.

Utility Mode

003 is in this mode when the Utility switch is
enabled (flashing). In Utility mode, you can run
pre-programmed diagnostic tests of the 003 unit
(such as fader movement and LEDs). The Utility
switch is unavailable in Pro Tools mode.

See Appendix A, “Utility Mode (003 Only)”
for more information.



003 Top Panel Overview
Figure 1 identifies each of the main 003 control sections.

The 003 top panel is arranged in sections of controls with related functions. The Fader section in-
cludes standard channel strip controls, similar to any small-format mixer. The Console/Channel
View section provides powerful multi-state controls for viewing and controlling inserts, plug-ins and
sends in Pro Tools. The Transport and Navigation controls provide access to many of the on-screen
navigation features of Pro Tools.

Display Mode switch

Display section
and Status LEDs

Mic/DI
Input controls

Console/Channel

View section . .
Monitor section

Miscellaneous
controls

Automation |
section

Transport and
Navigation controls
Modifiers section —

R | IS B S E—

Fader section

Figure 1. Major sections of the 003 top panel
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Display Section

The top portion of the 003 includes an LCD display, Display mode switch, and status indicators.

LCD display

003 LCD, Display Mode switch, and status indicators

LCD Display

For all 003 operating modes, the LCD display
provides status information.

For information on the status information
displayed for each 003 operating mode, see
“003 Operating Modes” on page 37.

In Pro Tools mode, when a session is open, 003’s
LCD s alarge, two-row display. The LCD display
dedicates two rows, each with up to six charac-
ters, to each channel strip.

In most views, the top row of the LCD shows the
the current view or mode status on the left side
and the session’s Main Counter on the right
side.

The bottom row of the LCD shows track, send,
and insert names, and pan position, send levels,
and plug-in control information, depending on
the current view, as selected by the Chan-
nel/Console switches.
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MIDI Data indicators

Host ,”1394" status indicator

HOST SYNC MiDI

1394 Wl S/PDIF ADAT In Out1 Outz

I
Display Mode switch

Sync indicators

The default display is the name of the displayed
element. Names of items with more than six
characters are abbreviated to six characters. Full
names of items with more than 6 characters can
be temporarily displayed in the LCD. See “Dis-
playing Full Names of Tracks, Insert Parameters,
and Other Elements” on page 100.

When you move a fader or rotary encoder, the
LCD will temporarily display the value for that
control in the lower row of the LCD, then return
to the default display. Values can also be tempo-
rarily displayed without moving a control or set
to display always. See “Displaying Settings In-
stead of Track or Control Names” on page 100.

Additional LCD Naming Conventions in
Pro Tools Mode

When a send or insert is muted, its names is cap-
italized in the LCD display.

When a track, send, or insert is inactive, “@” ap-
pears before its name in the LCD display.



Display Mode Switch

This switch is used to change default LCD dis-

plays:

e Full names of items with more than 6 charac-
ters can be temporarily displayed in the LCD.
See “Displaying Full Names of Tracks, Insert
Parameters, and Other Elements” on
page 100.

¢ The lower row of the LCD shows track or con-
trol names by default. The display can be
changed to temporarily show settings by
pressing and holding the Display Mode
switch, or be reset to always show settings. See
“Displaying Settings Instead of Track or Con-
trol Names” on page 100.

The Display Mode switch flashes during a tem-
porary display or when the LCD default has
been reset to always show settings.

Host (“1394”) Status Indicator

The Host status LED, marked “1394” below its
LED, indicates that communication has been es-
tablished between the unit and Pro Tools LE
software (or another software application)
through FireWire.

Sync Indicators

The Sync LEDs indicate the current clock source.
When the current clock source is not estab-
lished, the respective LED flashes.

If none of the Sync LEDs are lit, 003’s clock
source is set to internal.

There are three Sync LEDs:

W Clk (Word Clock) LED Lights when clocking to
Word Clock.

S/PDIF LED Lights when clocking to the S/PDIF
on the RCA or Optical port.

ADAT LED Lights when clocking to ADAT on the
Optical port.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of
MIDI data on the MIDI In, MIDI Out 1, or MIDI
Out 2 ports. Individual LEDs are provided for
each port. Active sensing is not indicated.
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Fader Section

The Fader section consists of eight channel
strips, each with identical controls.

—— Channel Meter LEDs

—— Rotary Encoder and
Encoder/Meter LED ring

Channel Select switch

Solo switch

Mute switch

—— Channel Fader

Channel strip in the Fader section

003 Family Setup Guide

Each fader has a motorized touch-sensitive
fader, solo and mute switches, a multi-state
Channel Select switch, a rotary encoder and its
LED ring, and meter LEDs. The LCD display ded-
icates two rows, each with up to six characters,
to each channel strip.

Channel Strip Controls

Channel Faders

Each channel has its own 100 mm, servo-driven,
touch-sensitive, motorized fader for controlling
levels of audio, Auxiliary Input, Master Fader,
MIDI, and Instrument tracks.

Flip Mode

In Flip mode (Flip switch lit), rotary encoder
controls are taken over by the faders, which
makes the rotary encoders available to control
another parameter. For example, in normal
Send View (Send switch lit), rotary encoders
control send level, while faders control output
gain. In Flip mode, faders (instead of rotary en-
coders) control the send level parameters and
rotary encoders control pan.

For more information, see “Using Flip
Mode” on page 110.



Muting Fader Movement

Because 003 faders are motorized, they move to
follow automation when playing back and re-
cording (when the track is set to an automation
read or write mode, and not Off). During critical
listening passes, the sound of the fader motors
and their automated movements may be dis-
tracting. You can temporarily shut off (or mute)
motorized fader movement using the Fader
Mute switch.

When the Fader Mute switch is enabled (flash-

ing), faders park and do not respond to touching
or movement. Previously recorded automation

continues to affect playback, while the faders are
disengaged from reading.

For more information, see “Muting Fader
Movement” on page 112.

Channel Solo/Mute Switches

Each channel has Solo and Mute switches, lo-
cated above its fader. These switches let you solo
or mute the channel. The switches also show the
Pro Tools solo and mute status for each track.
When a track is soloed (Solo switch lit), the
Mute switches on other tracks in the session
flash. When a track is muted, its Mute switch is
lit continuously.

The Solo switch function follows the Pro Tools
Operation preference for latched operation. (See
the Pro Tools Reference Guide for details.)

Channel Select Switches

Each channel has a Channel Select switch that
performs several functions, depending on the
view or mode, as follows.

Console View Depending on the Console View
(Pan, Send, or Insert), 003 can be used to do the
following:

e Select tracks or inserts on a particular chan-
nel for editing.

e Assign inputs, outputs, sends, or inserts
(plug-ins or hardware).

¢ Open track or send Output windows.

e Make track or send Outputs active or inac-
tive.

e Select pre- or post-fader operation for
sends.

e Bypass plug-ins.
¢ Reset faders and other parameters to their
default settings.

For information on using Console View for
specific Pro Tools workflows, see
Chapter 11, “Pro Tools Mode with 003.”

Channel View Depending on the Channel View
(EQ, Dynamics, Insert, or Pan/Send), 003 can be
used to do the following:

e Display inserts or plug-ins on a channel.

e Select and edit individual send or insert set-
tings as displayed across the LCD.

e Toggle switched plug-in controls (such as
bypass and Phase Invert).

e Cycle through plug-in windows.

For information on using Channel View for
specific Pro Tools workflows, see
Chapter 11, “Pro Tools Mode with 003.”
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Record Arming Mode When the Rec Arm switch
is enabled (flashing), the Channel Select switch
for a track enables or disables its Record Enable
button, plus acts as a record-enabled indicator.
When a track is record-enabled, its Channel Se-
lect switch flashes when the Transport is
stopped. When Pro Tools is recording, the
switch is lit continuously.

Tracks that are armed for recording will remain
armed after Rec Arming mode is disabled.

See “Rec Arm (Record Arm) Switch” on
page 45 for details on record-enabling
tracks.

Automation Mode The Automation Mode
switches (Write, Touch, Latch, Read, and Off) let
you use the Channel Select switches to set the
track’s Automation mode.

See “Automation Section” on page 54 for
more information.

Memory Location Mode In this mode (Memory
Location switch lit), Channel Select switches re-
call the Memory Location that corresponds to
their channel number. Additionally, the Mem-
ory Location window can be opened.

See “Working With Memory Locations” on
page 110 for more information.
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Rotary Encoders

Each Channel has a rotary encoder. These knobs
control a variety of parameters, depending on
the view:

Console View The rotary encoders control pan,
send level, or insert settings, depending on
which Console View is enabled (Pan, Send, or
Insert).

Channel View The rotary encoders control
plug-in, pan/send, or insert settings, depending
on which Channel View is enabled (EQ, Dynam-
ics, Insert, or Pan/Send).

Rotary Encoder LEDs

Each rotary encoder has a ring of 11 LEDs for in-
dicating data values controlled by the encoder.
The style of display depends on the type of data.
For example, discrete or stepped information
such as pan position or frequency value is
shown by a single LED, while an expanding se-
ries of LEDs shows values such as send levels,
gain, or filter bandwidth. When you rotate the
encoder, its LEDs update.

In Pan View, the Meter switch sets what the
LEDs display (left pan, right pan, or no function
in Automation mode).

Channel Meter LEDs

Each channel includes a five-segment LED me-
ter, scaled at 0, -3, -6, -12, and -42 dBFS for
track level. The meters are also labeled to indi-
cate the track’s current Automation mode: Wrt
(Write), Tch (Touch), Lch (Latch), or Rd (Read).

When the Meter switch is set to Left or Right,
these meters display track level. When the Meter
switch is set to Auto (Automation), the meter in-
dicator corresponding to the track’s current Au-
tomation mode is lit.



Meter Switch and LEDs

The Meter switch (located to the right of the en-
coder row) configures the display mode for
Channel Meter LEDs and the rotary encoder
LEDs.

Meter switch and LEDs

Meter switch and LEDs

The Meter switch also sets whether Left or Right
pan is controlled by a channel’s rotary encoder.

When you toggle through the three Meter
switch modes, the corresponding Meter switch
LED lights when its mode is enabled, as follows:

Left When enabled (LED lit), the Channel Meter
LEDs function as level meters, displaying mono
signals or the left channel of a stereo signal. Ro-
tary encoder LEDs indicate the left pan position
(available on stereo channels or sends). Addi-
tionally, the rotary encoder can be used to ad-
just the left pan position on stereo channels or
sends.

Right When enabled (LED lit), the Channel Me-
ter LEDs function as level meters, displaying the
right channel of a stereo signal. Rotary encoder
LEDs indicate the right pan position (available
on stereo channels or sends). Additionally, the
rotary encoder can be used to adjust the right
pan position on stereo channels or sends.

Auto (Automation) When enabled (LED lit), the
Channel Meter LEDs display the Automation
mode for their channel. When the Auto switch
is enabled, the rotary encoders do not function.

Global Fader Controls

Default and Input switches
Rec Arm switch
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switch

Mstr Faders switch

Global Fader control switches

The following controls affect the assignment
and operation of all the faders:

Rec Arm (Record Arm) Switch

When the Rec Arm switch is enabled (flashing),
003 is in Record Arming mode. In this mode,
channels can be armed (record-enabled) or dis-
armed for recording by pressing their Channel
Select switch.

For information on how to record arm
tracks with 003, see “Recording” on
page 108.

In this mode, the top row of the LCD shows “Re-
cord Arm” and the lower row of the LCD shows
track names. Additionally, volume fader updates
will not be reflected in the LCD, panning cannot
be adjusted with rotary encoders, and the Dis-
play mode cannot be changed.

In Record Arming mode, the Channel Select
switches act as record-enable switches and indi-
cators. When a channel is record-enabled and
the transport is stopped (or playing back with-
out recording), its Channel Select switch flashes.
When Pro Tools is recording, it is lit continu-
ously.

Tracks that are armed for recording will remain
armed after Rec Arming mode is disabled.
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Mstr Faders (Master Faders) Switch

When enabled (flashing), the Master Faders
switch arranges all Master Fader tracks in the
current session on the right-hand side of the
control surface. Pressing this switch a second
time returns the control surface to the previous
view.

In Pan View, the Master Fader levels are dis-
played in the LCD.

Fader Flip Switch

When enabled (flashing), the Flip switch in-
vokes Flip mode. Flip mode transfers control as-
signments from the rotary encoders to the corre-
sponding channel faders, allowing you to use
the touch-sensitive faders to edit and automate
send and plug-in values. Additonally, in certain
views, the rotary encoders are available to con-
trol another parameter.

Flip mode is not available in Pan View.

See “Using Flip Mode” on page 110 for
more information.
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Default Switch

The Default switch is used in conjunction with a
Channel Select switch to reset a fader (or
fader-mapped plug-in parameter) to its default
setting. For example, you can reset a channel
volume fader to its default level of 0.0 dB.

See “Setting Track Controls to Defaults” on
page 109 for more information.

Input Switch

The Input switch toggles Auto Input and Input
Only Monitor mode for record-enabled tracks.

See the Pro Tools Reference Guide for more
information about Pro Tools input monitor-
ing modes.



Console/Channel View Section

The Console and Channel View sections give you control over many on-screen elements in Pro Tools.

Master Bypass switch

CO”SS%%XAZ‘QV Channel View switches Plugin Page switches

ESC (Escape/Cancel) switch

Insert/Send
Position
switches

003 Console and Channel View switches

Both Console and Channel Views let you view and access pan, sends, or plug-ins for editing, and au-
tomation.

Console View Switches

Console View switches let you toggle 003 to show pan position, send assignments, or insert assign-
ments for all channels on the control surface.

003 is in Console View when any of the Console View switches (Pan, Send, or Insert) is lit in the Con-
sole View section.

S When you first open a Pro Tools session, the top row of the 003 is in Console View with the Pan
switch enabled (lit). This default view is sometimes called the Home View.

Think of Console View as a global view of a given control type across the entire mixer console (such
as send A for Channels 1-8).

Chapter 5: 003 Top Panel
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Insert/Send Position Switches

These switches determine which of the five
available insert positions (marked A-E in

Pro Tools) or ten available send positions
(marked A-J in Pro Tools) are displayed in Con-
sole View.

For information on using Console View for
specific Pro Tools workflows, see
Chapter 11, “Pro Tools Mode with 003.”

There are three Console Views, based on their
corresponding switch name:

Pan Switch When enabled (lit), 003 is in Pan
View. This is the default View when you first
open a Pro Tools session.

In this view, rotary encoders adjust channel pan
positions, and faders adjust track volume. The
bottom row of the LCD shows the track names,
and temporarily shows the channel pan posi-
tions when the encoder is moved, or volume in-
formation when the fader is moved. The top row
of the LCD shows the pan mode (left or right)
and Main Counter.

Send Switch When enabled (lit), 003 is in Send
View. In this view, rotary encoders adjust Send
level and the faders adjust track volume. The
bottom row of the LCD shows the names of cur-
rently assigned sends across all channel strips
for a given send position (Sends A-J in

Pro Tools). The top row of the LCD shows the
send position and Main Counter.

Insert Switch When enabled (lit), 003 is in Insert
View. In this view, the bottom row of the LCD
shows the names of currently assigned inserts
(hardware inserts or plug-ins) across all channel
strips for a given insert position (Inserts A-E in
Pro Tools). The top row of the LCD shows the
insert position and Main Counter.
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Channel View Section Switches

The first four Channel View switches determine
the type of information displayed for a selected
track. The first two switches focus on particular
types of plug-ins (EQ and Dynamics), while the
second two address all types of inserts and
sends.

For information on using Console View for
specific Pro Tools workflows, see
Chapter 11, “Pro Tools Mode with 003.”

The Channel View section also includes Page
Left, Page Right, Master Bypass, and ESC
switches.

E Insert <Page > Master ESC

Dynamics | pan/Send/PRE ‘ Bypass

sssss
sssss
sssss
sssss
sssss
sssss
sssss
sssss

{0:0: 0303 0xHOHOHO:
Channel View switches

003 is in Channel View when any of the first
four Channel View Select switches (EQ, Dynam-
ics, Insert, or Pan/Send) is lit in the Channel
View section.



Think of Channel View as a way to temporarily
focus on all the plug-ins, inserts or sends on a
single channel.

EQ Switch When enabled (flashing), 003 is in
Channel View. In this view, 003 identifies chan-
nels with equalizer plug-ins assigned to them by
illuminating their Channel View switches. The
top row of the LCD shows “Select EQ” and the
Main Counter. The bottom row shows track
names.

Dynamics Switch When enabled (flashing), 003
is in Channel View. In this view, 003 identifies
channels with dynamics plug-ins (such as com-
pressors or limiters) assigned to them by illumi-
nating their Channel Select switches. The top
row of the LCD shows “Select Dynamics” and
the Main Counter. The bottom row shows track
names.

Insert Switch When enabled (flashing), 003 is in
Channel View. In this view, 003 identifies chan-
nels with any kind of insert assigned to them
(including plug-ins or hardware I/O inserts) by
illuminating their Channel Select switches. The
top row of the LCD shows “Select Insert” and
the Main Counter. The bottom row shows track
names.

Pan/Send Switch When enabled (flashing), 003
is in Channel View. In this view, 003 identifies
channels with sends assigned to them by illumi-
nating their Channel Select switches. The top
row of the LCD shows “Select Pan Send A-E”
and the Main Counter. The bottom row shows
track names.

Page Switches These switches provide access to
additional pages of sends, plug-in parameters or
Memory Locations. The Page switches flash to
indicate a next or previous page is available.

Plug-In Master Bypass Switch This switch lets
you bypass either a single plug-in or all plug-ins
on a channel, depending on the current view.

ESC (Escape/Cancel) Switch When flashing,
this switch acts as a cancel button for certain op-
erations on 003 (such as Channel View selec-
tions) and many on-screen dialogs in Pro Tools.
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Transport and Navigation Controls

The 003 provides a standard set of Transport controls that mirror Pro Tools on-screen controls (when
in Pro Tools mode) and conform to standard MMC commands for controlling other devices (in MIDI
mode). Navigation keys and shortcut switches support Pro Tools zooming, banking, and navigation

features.
MIDI Map switches Miscellaneous switches
]
Mem Loc (Memory Location) switch (CTET ( Uiy Faderdue  Fous

WINDOWS TRANSPORT MODES
Mix Loop Play Loop Rec _QuickPunch

Windows Show/Hide switches Transport mode switches

Fader Display switches

Jog/Shuttle wheel Arrow keys

Q.

G @ GG £33 @@

I« « » > o

Transport controls

003 transport and navigation controls

FFW (Fast Forward) Fast-forwards through the
session from the current cursor position.

Transport Controls

These controls correspond to transport func-

tions in Pro Tools.

RTZ (Return to Zero) Sets the playback cursor to
the beginning of the session.

REW (Rewind) Rewinds through the session
from the current cursor position.
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STOP Stops playback or recording.

Play Begins playback from the current cursor po-
sition.

Record Arms Pro Tools for recording. Clicking
Play then initiates recording on record-enabled
tracks only.



Jog/Shuttle Wheel

The dual-concentric Jog/Shuttle wheel provides
additional navigation controls.

Shuttle Mode

The outer ring of the Jog/Shuttle wheel is a Shut-
tle control. When you move the Shuttle ring,
003 enters Shuttle mode. In this mode, you can
play forwards or backwards at a variable rate, de-
pending on the Shuttle position. Full clockwise
and counter-clockwise positions provide the
fastest shuttle rates. The Shuttle ring returns to
the center position (no shuttling) when you re-
lease the wheel.

% For more information, see “Navigating with
the Shuttle/Jog Wheel” on page 109.

Jog Mode

The inner part of the Jog/Shuttle wheel is a Jog

control. When you move the Jog wheel, 003 en-
ters Jog mode. In this mode, you can move the

session transport (and cursor) forwards or back-
wards.

% For more information, see “Navigating with
the Shuttle/Jog Wheel” on page 109.

The Jog control can be used to bank tracks to dif-
ferent faders.

For more information, see “Banking Chan-
nels on 003" on page 111.

The Jog control can also be used to continuously
zoom in or out horizontally or vertically on all
tracks.

For more information, see “Working With
Memory Locations” on page 110.

Jog/Shuttle Wheel Takeover

When using the Jog/Shuttle wheel, keyboard
and mouse commands are not supported, and
most 003 controls are unavailable. 003 faders
can be used at the same time as the Jog/Shuttle
wheel. However, 003 transport controls disable
the Jog/Shuttle wheel.

Normal operating mode is returned a few sec-
onds after last touching the Jog/Shuttle wheel.

Navigation and Display Keys and
Switches

These multi-purpose keys and switches control
the display of Pro Tools tracks on the 003 con-
trol surface, on-screen zoom functions, and
other Pro Tools navigation functions.

Arrow Keys

The Arrow keys are used to navigate tracks,
zoom in and out, navigate in text entry fields,
and drop Selection In and Out markers
on-the-fly.

Bank, Nudge, and Zoom switches

Coo O 6o Nusos ——zoom

Rz Rew P Stop Play Recorc

Arrow keys (Left, Right, Up, and Down)

Navigation and Display keys and switches

Basic Arrow key functionality is defined by the
Display switches.
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Fader Bank, Nudge, and Zoom Display
Switches

The Display switches define basic Arrow key
functionality, as follows:

Bank Switch When enabled (lit), the Arrow keys
let you bank 003 fader strips to the previous or
next eight tracks. You can also control and ad-
just selections and scroll in the Pro Tools Edit
window.

Nudge Switch When enabled (lit), the Arrow
keys let you nudge the display of tracks on 003
one track at a time. You can also control and ad-
just selections and scroll in the Pro Tools Edit
window.

Zoom Switch When enabled (lit), the Arrow keys
zoom the Pro Tools Edit window display.
Additional Arrow Key Functionality

You can use the Arrow keys to perform addi-
tional functions in Pro Tools, regardless of the
active Display switch.

For more information, see “Navigating in
the Edit Window” on page 108.
Windows Show/Hide Switches

Plug-In Switch Opens or closes the window for
the currently selected plug-in

Mix Switch Opens, brings forward, or closes the
Pro Tools Mix window

Edit Switch Opens, brings forward, or closes the
Pro Tools Edit window
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Record/Playback Transport Mode
Switches

Loop Play Switch Toggles Loop Playback on and
off

Loop Rec Switch Toggles Loop Record mode on
and off

QuickPunch Switch Toggles QuickPunch Record
mode on and off

Mem Loc (Memory Location)
Switch

The Mem Loc (Memory Location) switch pro-
vides access to all Memory Locations in a

Pro Tools session and can be used to set Memory
Locations.

For more information, see “Working With
Memory Locations” on page 110.

» (EIID 5
M Recall MIDIEdit

-

Mem Loc (Memory Location) switch

Memory Location switch



Miscellaneous Switches

Save Switch Pressing the Save switch twice is
equivalent to choosing File > Save in Pro Tools.

Undo Switch Pressing the Undo switch is equiva-
lent to choosing Edit > Undo in Pro Tools. (See
the Pro Tools Reference Guide for details on multi-
ple undo capabilities.)

Enter (OK) Switch Pressing the Enter switch is
equivalent to pressing Return or Enter on the
computer keyboard. This lets you OK on-screen
dialogs or create new Memory Locations in

Pro Tools directly from the control surface.

Utility Switch When enabled (lit), 003 enters
Utility mode. In this mode, you can run pre-pro-
grammed diagnostic tests of the 003 unit (such
as fader movement and LEDs) and reset MIDI
mappings to their factory presets. The Utility
switch is unavailable in Pro Tools mode.

See Appendix A, “Utility Mode (003 Only)”
for more information.

Fader Mute In Pro Tools mode, this switch tem-
porarily suspends 003 fader movement. When

enabled (flashing), this lets you work with

Pro Tools and monitor audio playback without
fader noise.

The Fader Mute feature has no effect on fader
automation or audio levels during playback.

To toggle fader movement on and off:

= While in Pro Tools mode, press the Fader
Mute switch

Focus In Pro Tools mode, this switch toggles the
LCD display between the current plug-in view
and the previous 003 view (such as Console or
Channel View).

To toggle between a plug-in view and the original
view:

= Press the Focus switch.

MIDI Map Switches

003 provides switches for using the control sur-
face as a MIDI controller.

For more information, see Chapter 12, “Us-
ing MIDI Mode with 003.”

MIDI Map A and B Switches When one of these
switches is enabled (lit), 003 is in MIDI mode. In
this mode, 003 functions as a MIDI control sur-
face for external devices and applications other
than Pro Tools. 003 supports two different
banks of MIDI Map presets, corresponding to
MIDI Map switch A and B.

MIDI Edit In MIDI mode, this switch lets you
edit and name custom MIDI maps.

MIDI Recall In MIDI mode, this switch lets you
recall and select MIDI map presets.
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Automation Section

This section provides switches for controlling
how automation data is written and played
back.

Write switch —@ D— Read switch
Touch (ot )

Touch switch —@ D— Off switch
(Latch )

Laten

@ D— Suspend switch

Latch switch

Automation section

Automation Mode Switches

The Write, Touch, Latch, Read, and Off switches
are used to set the Pro Tools Automation mode
for any track.

When the Meter switch is set to Auto, the Meter
LEDs for each channel display its Automation
status.

For more information, see “Working with
Automation” on page 112.

Automation Switch LEDs

The Write, Touch, Latch, and Read switch LEDs
individually light when at least one channel has
the corresponding Automation mode. The Off
switch LED flashes when no channels are set to
Write, Touch, or Latch, and at least one chan-
nel’s Automation mode is set to Off.

Multiple LEDs light when there are channels
with different Automation modes.
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Suspend Switch

When enabled (flashing), automation is sus-
pended for all channels.

For more information, see “Working with
Automation” on page 112.

Modifiers Section

The Modifiers section includes four switches for
modifying commands in combination with 003
switches, keyboard shortcuts, and Right-click
commands in Pro Tools:

Shift (Add) Switch This switch lets you extend a
track selection or add to a group of selected
items.

Option/Alt (All) Switch This switch lets you ap-
ply an action or command to all tracks in a
Pro Tools session.

Ctrl/Win Switch This switch lets you temporar-
ily disengage a control from grouped behavior.

Command/Ctrl Switch This switch lets you
fine-adjust controls and automation break-
points.

Option/Alt (All) switch

Shift (add)

()

Ctrl/Win H/Ctrl

Shift (Add) switch

I8

Ctrl/Win switch

1

Command/Ctrl switch

003 keyboard modifier keys



003 Shortcuts

Modifier switches provide shortcuts for 003
functions that can be accomplished without us-
ing your computer’s keyboard or mouse.

For a list of 003 shortcuts, see “003 Top
Panel Shortcuts” on page 113.

Pro Tools Shortcuts

For increased operational speed, there are many
Pro Tools keyboard and Right-click shortcuts to
give you fast access to a wide variety of tasks.
These shortcuts in Pro Tools use modifier keys,
(such as the Shift key) which are pressed in com-
bination with other keys or with a mouse ac-
tion.

003 Modifier switches mirror the functions of
modifier keys on the computer keyboard. For ex-
ample, 003’s Shift (Add) switch is equivalent to
your keyboard’s Shift key.

003 Switch (olgit)“QWERTY ?xi;tggERw
Shift (Add) Shift Shift

Option/Alt Option Alt

(All)

Ctrl/Win Control Win

Command/ Command Control

Ctrl

You can use the Modifier switches in any com-
bination with keys on your computer or a
mouse action while working with Pro Tools.

For a complete list of Pro Tools keyboard
and Right-click shortcuts, refer to the Short-
cuts Guide for your computer platform.

Mic/DI Input Controls

There are four high-quality preamplifiers with
adjustable gain and phantom power (switchable
in pairs, for Inputs 1-2 and Inputs 3-4). The
phantom power switches are on the back panel.

Inputs 1-4 show up as “Analog 1-4” in the de-
fault Pro Tools I/O Setup.

Input 1-4 Gain control

Mic/DI and HPF switches for Inputs 1-4
Mic/DI Input controls for Inputs 1-4

Inputs 1-4 have the following controls:

Input 1-4 Gain Controls Each knob adjusts gain
for the input, with a range of +15 dB to +60 dB
of gain.

Mic/DI Switches (Inputs 1-4) Each switch tog-
gles the corresponding input between micro-
phone (unlit) or DI input (lit).

The DI and Mic switch LEDs indicate the current
source input. The LEDs blink rapidly when the
input is clipping.

A Engage the Mic switch only if you have an
XLR cable plugged into the mic connector.
Leaving the switch engaged with nothing
connected may introduce low-level noise.

HPF (High Pass Filter) Switches (Input
1-4) These switches enable a high pass filter

(75 Hz, 12 dB/octave rolloff) on the correspond-
ing input, for filtering out rumble or AC hum.
The HPF LEDs are lit when the switch is enabled.
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Monitor Section

The Monitor section provides the following
control room monitoring features:

3/4-HP2 switch Alt CR switch
Aux In 7/8 switch

Aux In switch Mono switch

.

© 6 O

Input Level control Monitor Mute switch

Headphone 1 and 2 Level control

(Puxin-7/8  :/4~-HP2  fuxIn Alt CF.

Monitor and headphone controls

Alternate Input Routing Controls

Aux In to 7/8 Switch This switch routes the Aux
In input pair to Inputs 7 and 8 of Pro Tools, and
does not send it to the Main Monitor Outputs
unless this routing is set up in Pro Tools, or the
Aux In (to Monitor) switch is engaged. This lets
you route an alternate input signal (such asa CD
player) directly into Pro Tools without the need
to repatch any cables.

When Aux In to 7/8 is enabled (lit), Analog In-
puts 7-8 are disabled.

3/4-HP2 Switch This switch sets the Headphone
2 Output to mirror Output pair 3-4.

Aux In (to Monitor) Switch This switch routes
the Aux In input pair directly to the Main Mon-
itor and Headphone Outputs.

If you press the Aux In (to Monitor) switch in
conjunction with the Aux In to 7/8 switch, you
will hear the pre-fader input of the Aux In in the
Main Monitor outputs, and can record that in-
put into Pro Tools from Inputs 7/8. Addition-
ally, if you send the output of any track with in-
puts 7/8 back to the Main Monitor outputs, this
can result in a doubled signal.

56 003 Family Setup Guide

Alt CR (Control Room) Switch This switch mutes
the Main Monitor output and routes the signal
to the Alt Monitor output.

Mono Switch This switch temporarily combines
Output 1-2 in the Main and Alt Monitor Out-
puts and the Headphone Outputs. This is help-
ful for checking the phase relationships of stereo
material.

Monitor and Headphone Level Controls

Monitor Level Control These knobs control the
volume of the Main and Alt Monitor Outputs.
These outputs mirror Analog Outputs1-2, which
correspond to outputs 1-2 in Pro Tools.

Headphone 1 and 2 Level Controls These knobs
control the volume of the independent Head-
phone Outputs. The Headphone Outputs nor-
mally mirror outputs 1-2 in Pro Tools, and are
independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3-4 when the
3/4-HP2 switch is enabled (lit). Both head-
phones include Aux In signal when Aux In (to
monitor) is enabled.

Headphone output is not affected by the status
of the Monitor Mute switch, but does follow sta-
tus of the Mono switch.

Monitor Mute Switch This switch mutes the
Main and Alt Monitor Outputs only, and has no
effect on the Headphone Outputs. Monitor
Mute is automatically engaged when you power
up the unit.

Headphone Jacks

Headphone Output 1 and 2 jacks accept stan-
dard 1/4-inch stereo headphone connectors.
The jacks are located on the front of the 003.



chapter 6

003 Rack Front Panel

The 003 Rack front panel provides controls for Inputs 1-4, options for routing outputs and monitor-
ing alternate input sources, and indicators for connections status, sync source, and MIDI data.

Input 1-4 Gain control Status indicators
. | — | .
e =i Bl
o O O O O O O
NPUT 1 NPuT NPU INPUT 4
(oo rer ) (i 73 HP2__Axn __A\CR___Wong 2 S
® 3 o @ & @ &b @D & el e d e ®
Power switch | . X
Mic/DI and HPF switches for Inputs 1-4 Monitor section Headphone jacks

Figure 2. 003 Rack front panel

P Switch :
ower Switc Mic/DI Input Controls

There are four high-quality preamplifiers with

The Power switch is located on the front panel.

adjustable gain and phantom power (switchable
Headphone Jacks in pairs, for Inputs 1-2 and Inputs 3-4). The

Headphone Output 1 and 2 jacks accept stan- phantom power switches are on the back panel.

dard 1/4-inch stereo headphone connectors. Inputs 1-4 show up as “Analog 1-4” in the de-

fault Pro Tools 1/O Setup.
Inputs 1-4 have the following controls:

Input 1-4 Gain Controls Each knob adjusts gain
for the input, with a range of +15 dB to +60 dB
of gain.
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Mic/DI Switches (Inputs 1-4) Each switch tog-
gles the corresponding input between micro-
phone (unlit) or DI input (lit).

The DI/Mic switch LEDs indicate the current
source input. The LEDs blink rapidly when the
input is clipping.

A\ Engage the Mic switch only if you have an
XLR cable plugged into the mic connector.
Leaving the switch engaged with nothing
connected may introduce low-level noise.

HPF (High Pass Filter) Switches (Input 1-4)

These switches enable a high pass filter (75 Hz,
12 dB/octave rolloff) on the corresponding in-
put, for filtering out rumble or AC hum. The
HPF LEDs are lit when the HPF switch is enabled
(lit).

Monitor Section

The Monitor section provides the following
control room monitoring features:

Monitor and Headphone Level Controls

Headphone 1 and 2 Level Controls These knobs
control the volume of the independent Head-
phone Outputs. The Headphone Outputs nor-
mally mirror outputs 1-2 in Pro Tools, and are
independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3-4 when the
3/4-HP2 switch is enabled (lit). Both head-
phones include Aux In signal when Aux In (to
monitor) is enabled.

Headphone output is not affected by the status
of the Monitor Mute switch, but does follow sta-
tus of the Mono switch.
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Monitor Level Control These knobs control the
volume of the Main and Alt Monitor Outputs.
These outputs mirror Analog Outputs 1-2,
which correspond to outputs 1-2 in Pro Tools.

Alternate Input Routing Controls

Aux In to 7/8 Switch This switch routes the Aux
In input pair directly to Inputs 7-8 of Pro Tools,
and does not send it to the Main and Alt Moni-
tor Outputs. This lets you route an alternate in-
put signal (such as a CD player) directly into
Pro Tools without the need to repatch any ca-
bles.

When Aux In to 7/8 is enabled (lit), Analog In-
puts 7-8 are disabled.

3/4-HP2 Switch This switch sets Headphone 2
Output to mirror Output pair 3—4.

Aux In (to Monitor) Switch This switch routes
the Aux In input pair directly to the Main Mon-
itor and Headphone Outputs.

Alt CR (Control Room) Switch This switch mutes
the Main Monitor output and routes the signal
to the Alt CR output.

Mono Switch This switch temporarily combines
Output 1-2 in the Main and Alt Monitor Out-
puts and the Headphone Outputs. This is help-
ful for checking the phase relationships of stereo
material.

Monitor Mute Switch This switch mutes the
Main and Alt Monitor Outputs only, and has no
effect on the Headphone Outputs. Monitor
Mute is automatically engaged when you power
up the unit.



Status Indicators

Host (“1394”) Status Indicator

The Host status LED, marked “1394” below its
LED, indicates that communication has been es-
tablished between the unit and Pro Tools LE
software (or another software application)
through FireWire.

Sync Indicators

The Sync LEDs indicate the current clock source.
When the current clock source is not estab-
lished, the respective LED flashes.

If none of the Sync LEDs are lit, 003 Rack’s clock
source is set to Internal.

There are three Sync LEDs:

W Clk (Word Clock) LED Lights when clocking to
Word Clock.

S/PDIF LED Lights when clocking to the S/PDIF
on the RCA or Optical port.

ADAT LED Lights when clocking to ADAT on the
Optical port.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of
MIDI data on the MIDI In, MIDI Out 1, or MIDI
Out 2 ports. Individual LEDs are provided for
each port. Active sensing is not indicated.

Chapter 6: 003 Rack Front Panel
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003 and 003 Rack Back Panels

The 003 and 003 Rack back panels include au-
dio, MIDI and computer connectors for the unit
(see See Figure 3 on page 62). The functions of
each connector and their associated switches are
explained in this section.

The 003 and 003 Rack have identical connec-
tors. The 003’s Power switch is on its back panel,
whereas the 003 Rack’s Power switch is on its
front panel.

A\ Avid does not recommend the use of unbal-
anced cables. Unbalanced connections may
introduce noise into your audio system.
Whenever possible, use balanced cables to
make connections to 003 and 003 Rack.

Operating Levels and Headroom

All 003 and 003 Rack audio inputs and outputs
are set for 14 dB of headroom below 0 dB, or full
code. This means at the nominal reference input
level (+4 dBu or -10 dBV) you can have up to
14 dB of headroom before input or output clip-
ping occurs.

The maximum input and output of 003 or
003 Rack using balanced TRS cables on any of
the +4 dBu, 1/4-inch connectors is +18 dBu
(6.15 Vrms).

Sample Rate and Resolution
Support

The Analog-to-Digital and Digital-to-Analog
converters on all 003 and 003 Rack analog in-
puts and outputs, as well as the S/PDIF Digital
I/O ports, support sample rates of 44.1, 48, 88.2,
and 96 kHz. The Optical port can be set for eight
channels of ADAT Optical I/O (supporting up to
48 kHz) or two channels of S/PDIF Optical I/O.

All the analog and digital inputs and outputs on
003 and 003 Rack support up to 24-bit resolu-
tion audio.

Chapter 7: 003 and 003 Rack Back Panels
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Figure 3. 003 back panel

Analog Inputs

Mic Inputs 1-4

These are balanced, three-conductor XLR con-
nectors for microphone-level analog inputs.

Gain is controlled by the corresponding Input
Gain Control knob (located on the top panel of
003, and on the front panel of 003 Rack). The
source (Mic, Line, or DI) is chosen using the
Mic/DI switch.

A The XLR connectors on Inputs 1-4 are
wired specifically to match the impedance
of microphones. Do not use these XLR
connectors for line inputs; use the
1/4-inch connectors instead.
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DI Inputs 1-4

The DI (“Direct Inject” or “Direct Interface”) In-
puts are balanced connectors for guitars and
other instrument level sources that support
1/4-inch TS connections. Operating levels for
these inputs are fixed at +4 dBu.

Gain is controlled by the corresponding Input
Gain knob (located on the top panel of 003, and
on the front panel of 003 Rack). The source
(Mic, Line, or DI) is chosen using the Mic/DI
switch.

Phantom Power Switches

These switches apply 48V phantom power to
Mic Inputs 1-2 and Mic Inputs 3-4 channel
pairs, respectively. Enable these switches for mi-
crophones that require phantom power to oper-
ate.

For more information, see “Phantom
Power” on page 80.



Analog Inputs 5-8 and Operating Level
Switches

Analog Inputs 5-8 are balanced, 1/4-inch TRS
jacks for line-level analog audio input connec-
tions.

Operating levels for each of these line-level in-

puts is switchable between +4 dBu and -10 dBV,
using the Operating Level switches immediately
to the right of the input jacks.

While Inputs 5-8 do accept unbalanced connec-
tions, this may result in a noisier signal than a
balanced-to-balanced connection.

A\ Analog Inputs 7-8 are disabled when the
Aux In to 7/8 switch is enabled (lit).

Analog Outputs

Main Analog Outputs 1-8

These are impedance balanced, 1/4-inch TRS
jacks for line-level analog audio output connec-
tions. Operating levels for these outputs are
fixed at +4 dBu.

While the Main Analog Outputs do accept un-
balanced connections, this may result in a nois-
ier signal than a balanced-to-balanced connec-
tion.

Q If you plan on connecting Analog Outputs
© 1-8to-10 dBV gear, you may want to
place a transformer-based line level attenu-
ator between the 003 or 003 Rack output
and the input of the destination device to
compensate for level differences.

Monitor Section

Main Monitor Outputs

These outputs support balanced TRS, or unbal-
anced TS, 1/4-inch connections. To monitor
your mix, these outputs can be connected to a
mixing board, directly to a monitoring system
(such as a stereo power amp, powered speakers,
or another stereo destination).

The Main Monitor Outputs play the audio that
is routed to analog outputs 1 and 2 from within
Pro Tools, respectively. These analog outputs
feature 24-bit digital-to-analog converters. Op-
erating levels for these outputs are fixed at

+4 dBu.

Monitor gain level is controlled by the Monitor
Level control (located on the top panel of 003,
and on the front panel of 003 Rack).

Monitor output can be muted and the signal
routed to the Alt CR Output with the Alt CR
switch.

Alt Monitor Outputs

These outputs support balanced TRS, or unbal-
anced TS, 1/4-inch connections. These outputs
can be used to monitor your mix through an al-
ternate, or secondary studio monitoring system,
instead of the system connected to the Main
Monitor Outputs.

The Alt Monitor Out Left and Right play the au-
dio that is routed to analog outputs 1 and 2 from
within Pro Tools, respectively. These analog
outputs feature 24-bit digital-to-analog convert-
ers. Operating levels for these outputs are fixed
at +4 dBu.

Monitor gain level is controlled by the Monitor
Level control (located on the top panel of 003,
and on the front panel of 003 Rack).

Chapter 7: 003 and 003 Rack Back Panels
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These outputs are enabled when the Alt CR
switch is enabled (lit).

Aux In

These are balanced, 1/4-inch TRS connectors for
connecting alternate audio sources such as CD

players or tape decks. The signal from these in-
puts can be routed directly to the Main Monitor
Outputs (for monitoring) or to Inputs 7-8 (for

direct input into Pro Tools) from the top panel
of 003, or the front panel of 003 Rack.

Operating levels for these inputs are fixed at
+4 dBu.

When the Aux In switch is enabled (lit), Aux In
signal is routed to the Main Monitor Outputs.
Audio in Pro Tools that is routed to Analog 1-2
will not be mirrored at the Monitor Outputs.

When the Aux In to 7/8 switch is enabled (lit),
Aux In signal is routed to Inputs 7-8 and does
not pass directly to the Monitor Outputs.

When the Alt CR switch is enabled (lit), audio
routed to Aux In will pass out the Alt Monitor
Outputs.

Digital 1/0

S/PDIF Digital 1/0

The S/PDIF in and out ports are unbalanced
two-conductor phono (RCA) connectors that
utilize a full 24-bit, two-channel digital data
stream.

The Sony/Philips Digital Interface Format
(S/PDIF) is used in many professional and con-
sumer CD recorders and DAT recorders. For
highest digital signal integrity, and lower jitter,
use 75 Ohm coaxial cable for S/PDIF transfers
and keep the cable length to a maximum of 10
meters.
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003 and 003 Rack support consumer mode S/PDIF
output format (IEC60958-3) at sample rates of
44.1 kHz and 48 kHz, and professional mode
S/PDIF output format (IEC60958-4) at sample
rates of 88.2 kHz and 96 kHz. For information
on which S/PDIF formats are supported by your
S/PDIF-compatible gear, see the manufacturer’s
documentation.

Optical 1/0

These are a pair of TOSLINK-style connectors for
ADAT Optical (8 channels of I/O) or S/PDIF Op-
tical (2 channels of I/O) devices. You can choose
between these Optical I/O formats in the

Pro Tools Hardware Setup dialog.

The Optical port can be set for eight channels of
ADAT Optical I/O (supporting up to 48 kHz) or
two channels of S/PDIF Optical I/O.

The Optical I/O ports support 24-bit, 20-bit and
16-bit resolutions in both modes.

A Only one S/PDIF input pair can be used at a
time. For example, if you use the Optical In
for S/PDIF data, you cannot use the RCA
inputs.

At 96 kHz, it is recommended that you use
the S/PDIF (RCA) port

The Optical I/O ports use a standard optical
“lightpipe” cable.

A\ Avid recommends high-quality audio grade
optical cable for all optical connections.

When the 003 or 003 Rack is on, its Optical Out
port emits a red light.



About Lightpipe-Compatible Devices

Lightpipeis an industry standard, eight-channel
optical digital audio connection developed by
Alesis. Lightpipe is found on many devices, in-
cluding ADAT decks, modular digital
multitracks (MDMs), sound cards, standalone
A/D or D/A converters, and digital consoles.

Word Clock

The Word Clock In and Out ports let you con-
nect BNC cables to synchronize 003 and 003
Rack to incoming 1x Word clock, and synchro-
nize other devices to Pro Tools-generated Word
clock.

MIDI Connectors

The MIDI In and MIDI Out 1 and Out 2 ports are
standard 5-pin MIDI ports. The MIDI In port

supports 16 channels of MIDI input. Each MIDI
Out port supports 16 channels of MIDI output,

for a system total of 32 channels of MIDI output.

A MIDI driver for these MIDI ports is installed
when you install Pro Tools LE, and is recognized
automatically by Audio MIDI Setup (Mac) and
MIDI Studio Setup (Windows). These connec-
tors accept standard 5-pin MIDI cables.

Kensington Lock Port

Use the Kensington Lock port to secure your in-
terface with a Kensington Lock (not supplied).

For more information, visit the Kensington web-
site (www.kensington.com).

Footswitch Jack

This connector lets you use a footswitch pedal to
control either playback start/stop or recording
punch in/out. Both QuickPunch audio
punch-in and punch-out and MIDI punch-in
and punch-out recording are supported. The
footswitch connector is designed specifically for
instantaneous (momentary) on/off pedals with
a 1/4-inch TS connector. Continuous on/con-
tinuous off pedals can also be used, but may re-
sult in unexpected behavior.

IEEE-1394 (FireWire) Ports

These ports, marked “1394” in reference to their
IEEE specification, are commonly known as
FireWire ports. These provide connections to the
computer and other FireWire devices.

FireWire offers a high rate of data transfer and
reliability that makes it ideal for audio applica-
tions (such as Pro Tools with 003 family de-
vices). FireWire devices can be daisy-chained to-
gether without the need for terminators.

If you are using a Windows laptop that has
a 4-pin FireWire port (commonly labeled
“1394”), see “Additional Software on the
Pro Tools Installer Disc” on page 17 for
FireWire cable information.
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Connecting 003 or 003 Rack and FireWire Hard
Drives

The FireWire ports on 003 and 003 Rack do not
pass data when they are powered off. If you
daisy-chain FireWire devices from your com-
puter, it is best to connect FireWire hard drives
directly to your computer and not to the

003 family device. This will prevent hard drive
errors and data loss in case the 003 family device
is powered off.

A Connecting 003 to a FireWire port of an ex-
ternal drive that is connected to a computer
does not support maximum track count.
For information on supported PCI/PCM-
CIA/ExpressCard FireWire options, visit
www.avid.com.

Connecting Other FireWire Devices to 003 or
003 Rack

The second FireWire port on 003 or 003 Rack is
available for daisy-chaining FireWire devices
such as digital cameras or digital video record-
ers. Even when it is powered off, 003 and

003 Rack supply power from the computer
through their FireWire ports, letting you re-
charge batteries in other FireWire devices.
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Link Indicator

The Link indicator lights when a valid FireWire
connection is established (between the 003 fam-
ily device and a computer).

Power Switch
(003 Back Panel Only)

The Power switch for 003 is located on its back
panel.

The Power switch for the 003 Rack is located on
its front panel.

AC Power Connector

The AC power connectors on 003 and 003 Rack
accept a standard modular AC power cable.

003 and 003 Rack are auto power-selecting
(100V to 240V) and will work automatically
when plugged into an AC power receptacle in
any country.

A\ 003 and 003 Rack require AC power and
cannot be powered by the FireWire bus.



chapter 8

003 Rack+ Front Panel

The 003 Rack+ front panel provides controls for Inputs 1-8, options for routing outputs and moni-
toring alternate input sources, and indicators for connections status, sync source, and MIDI data. It
also includes a single 1/4-inch DI input linked to channel 1.

Front Panel DI 1 input Input Channel Gain Controls Status indicators

Power switch | |

Input Channel Select switches Monitor section Headphone jacks
Line-DI, 48V, HPF, and Pad switches

Figure 4. 003 Rack+ front panel

Power Switch Front Panel DI 1 Input

The Power switch is located on the front panel. The front panel DI 1 input routes to Input Chan-
nel 1 and accepts 1/4-inch balanced (TRS) and
unbalanced (TS) cables. This input supersedes
the rear panel channel 1 Line/DI input. The
Headphone output jacks 1 and 2 accept stan- Line-DI switch for Channel 1 must be engaged
dard 1/4-inch stereo headphone connectors. (see “Line-DI” on page 68).

Headphone Jacks
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Mic and Line/DI Input
Controls

The 003 Rack+ has eight input channels, each
featuring a high-quality preamplifier with ad-
justable gain, phantom power, a high-pass filter,
and a pad. These inputs show up as “Analog
1-8" in the default Pro Tools I/O Setup.

Inputs 1-8 have the following controls:

Input Channel Gain Controls

Each knob adjusts gain for the input, with a
range of +15 dB to +60 dB of gain. Gain control
applies to mic, line, or DI input signals, as well
as the front panel DI input.

Input Channel Select Switches

Pressing an Input Channel Select switch gives
you access to that channel’s Control switches.

Only one channel can be selected at a time, and
the following switches will be lit or unlit de-
pending on the status of the selected channel:

Line-DI When enabled (lit orange), the selected
channel receives input from the corresponding
Line/DI (1/4-inch TRS) input (or the front panel
DI if channel 1 is selected). These combination
inputs accept both balanced or unbalanced
line-level signals (from sources like outboard ef-
fect units), and low-level instrument signals
(from sources like guitars and basses).

When unlit, the selected channel receives input
from the mic (XLR) input.

68 003 Family Setup Guide

48V When enabled (lit red), 48 volts is applied
to the mic (XLR) input of the selected channel
for mics requiring phantom power (such as con-
denser mics).

Q If the Line-DI switch is enabled, 48V phan-
" tom power will not be applied to the
1/4-inch input.

HPF (High-Pass Filter) When enabled (lit
green), an analog 75 Hz, 12 dB/octave rolloff
high-pass filter is applied to the selected chan-
nel’s mic or Line/DI input for filtering out rum-
ble or AC hum.

Pad When enabled (lit green), a —20 dB pad is
applied to the selected channel’s mic or Line/DI
input.

Monitor Section

The Monitor section provides the following
control room monitoring features:

Monitor and Headphone Level Controls

Headphone 1 and 2 Level Controls These knobs
control the volume of the independent Head-
phone Outputs. The Headphone Outputs nor-
mally mirror outputs 1-2 in Pro Tools, and are
independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3-4 when the
3/4-HP2 switch is enabled (lit). Both head-
phones include Aux In signal when Aux In (to
monitor) is enabled.

Headphone output is not affected by the status
of the Monitor Mute switch, but does follow the
status of the Mono switch.



Monitor Level Control These knobs control the
volume of the Main and Alt Monitor Outputs.
These outputs mirror Analog Outputs 1-2,
which correspond to outputs 1-2 in Pro Tools.

Alternate Input Routing Controls

Aux In to 7/8 Switch This switch routes the Aux
In input pair directly to Inputs 7-8 of Pro Tools,
and does not send it to the Main and Alt Moni-
tor Outputs. This lets you route an alternate in-
put signal (such as a CD player) directly into
Pro Tools without the need to repatch any ca-
bles.

When Aux In to 7/8 is enabled (lit), Analog In-
puts 7-8 are disabled.

3/4-HP2 Switch This switch sets Headphone 2
Output to mirror Output pair 3-4.

Aux In (to Monitor) Switch This switch routes
the Aux In input pair directly to the Main Mon-
itor and Headphone Outputs.

Alt CR (Control Room) Switch This switch mutes
the Main Monitor output and routes the signal
to the Alt CR output.

Mono Switch This switch temporarily combines
Output 1-2 in the Main and Alt Monitor Out-
puts and the Headphone Outputs. This is help-
ful for checking the phase relationships of stereo
material.

Monitor Mute Switch This switch mutes the
Main and Alt Monitor Outputs only, and has no
effect on the Headphone Outputs. Monitor
Mute is automatically engaged when you power
up the unit.

Status Indicators

Host (“1394”) Status Indicator

The Host status LED, marked “1394” below its
LED, indicates that communication has been es-
tablished between the unit and Pro Tools LE
software (or another software application)
through FireWire.

Sync Indicators

The Sync LEDs indicate the current clock source.
When the current clock source is not estab-
lished, the respective LED flashes.

If none of the Sync LEDs are lit, 003 Rack’s clock
source is set to Internal.

There are three Sync LEDs:

W Clk (Word Clock) LED Lights when clocking to
Word Clock.

S/PDIF LED Lights when clocking to the S/PDIF
on the RCA or Optical port.

ADAT LED Lights when clocking to ADAT on the
Optical port.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of
MIDI data on the MIDI In and MIDI Out ports.
Individual LEDs are provided for each port. Ac-
tive sensing is not indicated.
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chapter 9

003 Rack+ Back Panel

The 003 Rack+ back panel includes audio, MIDI
and computer connectors for the unit (see
Figure 5 on page 72) The functions of each con-
nector and their associated switches are ex-
plained in this section.

A Avid does not recommend the use of unbal-
anced cables. Unbalanced connections may
introduce noise into your audio system.
Whenever possible, use balanced cables to
make connections to the 003 Rack+.

Operating Levels and Headroom

All 003 Rack+ audio inputs and outputs are set
for 14 dB of headroom below 0 dB, or full code.
This means at the nominal reference input level
(+4 dBu or-10 dBV) you can have up to 14 dB of
headroom before input or output clipping
occurs.

The maximum input and output of the

003 Rack+ using balanced TRS cables on any of
the +4 dBu, 1/4-inch connectors is +18 dBu
(6.15 Vrms).

Sample Rate and Resolution
Support

The Analog-to-Digital and Digital-to-Analog
converters on the 003 Rack+ analog inputs and
outputs, as well as the S/PDIF Digital I/O ports,
support sample rates of 44.1, 48, 88.2, and

96 kHz. The Optical port can be set for eight
channels of ADAT Optical I/O (supporting up to
48 kHz) or two channels of S/PDIF Optical I/O.

All the analog and digital inputs and outputs on
the 003 Rack+ support up to 24-bit resolution
audio.
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Mic inputs 1-8

Main and Alt
Analog Outputs 1-8  Monitor Outputs
| | Aux In

MIDI In
MIDI Out

FOOT SWITCH

Line/Dl inputs 1-8 Footswitch

FireWire ports

Figure 5. 003 Rack+ back panel

Analog Inputs

Mic Inputs 1-8

These are balanced, three-conductor XLR con-
nectors for microphone-level analog inputs.

Gain is controlled by the corresponding Input
Gain Control knob (located on the front panel
of 003 Rack+). The source (Mic, Line, or DI) is

chosen using the front panel Line-DI switch.

An unlit Line/DI switch means the mic (XLR) in-
put is active.

A The XLR connectors on Inputs 1-8 are
wired specifically to match the impedance
of microphones. Do not use these XLR
connectors for line inputs; use the
1/4-inch connectors instead.
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Line/DI Inputs 1-8

The combination Line/DI (“Direct Input,” “Di-
rect Inject,” or “Direct Interface”) inputs accept
both balanced 1/4-inch balanced TRS connec-
tors (for outboard effects and other line-level
sources) and unbalanced 1/4-inch TS connectors
(for guitars and other instrument level sources).

Gain is controlled by the corresponding Input
Gain knob (located on the front panel of

003 Rack+). The source (Mic, Line, or DI) is cho-
sen using the Line-DI switch.

An enabled (lit) Line-DI switch means the
Line/DI (1/4-inch) input is active.

(Y If you have an instrument connected to the
front panel DI 1 input and you have a line
or DI input connected to the rear panel
channel 1 Line/DI input, the front panel DI
1 input takes precedence over the rear panel
channel 1 Line/DI input.



Analog Outputs

Main Analog Outputs 1-8

These are impedance balanced, 1/4-inch TRS
jacks for line-level analog audio output connec-
tions. Operating levels for these outputs are
fixed at +4 dBu.

While the Main Analog Outputs do accept un-
balanced connections, this may result in a nois-
ier signal than a balanced-to-balanced connec-
tion.

Q If you plan on connecting Analog Outputs
© 1-8to-10 dBV gear, you may want to
place a transformer-based line level attenu-
ator between the 003 Rack+ output and the
input of the destination device to compen-
sate for level differences.

Monitor Section

Main Monitor Outputs

These outputs support balanced TRS, or unbal-
anced TS, 1/4-inch connections. To monitor
your mix, these outputs can be connected to a
mixing board, directly to a monitoring system
(such as a stereo power amp, powered speakers,
or another stereo destination).

The Main Monitor Outputs play the audio that
is routed to analog outputs 1 and 2 from within
Pro Tools, respectively. These analog outputs
feature 24-bit digital-to-analog converters. Op-
erating levels for these outputs are fixed at

+4 dBu.

Monitor gain level is controlled by the Monitor
Level control (located on the front panel of the
003 Rack+).

Monitor output can be muted and the signal
routed to the Alt CR Output with the Alt CR
switch.

Alt Monitor Outputs

These outputs support balanced TRS, or unbal-
anced TS, 1/4-inch connections. These outputs
can be used to monitor your mix through an al-
ternate, or secondary studio monitoring system,
instead of the system connected to the Main
Monitor Outputs.

The Alt Monitor Out Left and Right play the au-
dio that is routed to analog outputs 1 and 2 from
within Pro Tools, respectively. These analog
outputs feature 24-bit digital-to-analog convert-
ers. Operating levels for these outputs are fixed
at +4 dBu.

Monitor gain level is controlled by the Monitor
Level control (located on the front panel of
003 Rack+).

These outputs are enabled when the Alt CR
switch is enabled (lit).

Aux In

These are balanced, 1/4-inch TRS connectors for
connecting alternate audio sources such as CD
players or tape decks. The signal from these in-
puts can be routed directly to the Main Monitor
Outputs (for monitoring) or to Inputs 7-8 (for
direct input into Pro Tools) from the front panel
of the 003 Rack+.

Operating levels for these inputs are fixed at
+4 dBu.

When the Aux In switch is enabled (lit), Aux In
signal is routed to the Main Monitor Outputs.
Audio in Pro Tools that is routed to Analog 1-2
will not be mirrored at the Monitor Outputs.

When the Aux In to 7/8 switch is enabled (lit),
Aux In signal is routed to Inputs 7-8 and does
not pass directly to the Monitor Outputs.
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When the Alt CR switch is enabled (lit), audio
routed to Aux In will pass out the Alt Monitor
Outputs.

Digital 1/0

S/PDIF Digital 1/0

The S/PDIF in and out ports are unbalanced
two-conductor phono (RCA) connectors that
utilize a full 24-bit, two-channel digital data
stream.

The Sony/Philips Digital Interface Format
(S/PDIF) is used in many professional and con-
sumer CD recorders and DAT recorders. For
highest digital signal integrity, and lower jitter,
use 75 Ohm coaxial cable for S/PDIF transfers
and keep the cable length to a maximum of 10
meters.

The 003 Rack+ supports consumer mode S/PDIF
output format (IEC60958-3) at sample rates of
44.1 kHz and 48 kHz, and professional mode
S/PDIF output format (IEC60958-4) at sample
rates of 88.2 kHz and 96 kHz. For information
on which S/PDIF formats are supported by your
S/PDIF-compatible gear, see the manufacturer’s
documentation.

Optical 1I/0

These are a pair of TOSLINK-style connectors for
ADAT Optical (8 channels of 1/0) or S/PDIF Op-
tical (2 channels of I/O) devices. You can choose
between these Optical I/O formats in the

Pro Tools Hardware Setup dialog.

The Optical port can be set for eight channels of
ADAT Optical I/O (supporting up to 48 kHz) or
two channels of S/PDIF Optical I/O.
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The Optical I/O ports support 24-bit, 20-bit and
16-bit resolutions in both modes.

A\ Only one S/PDIF input pair can be used at a
time. For example, if you use the Optical In
for S/PDIF data, you cannot use the RCA in-
puts.

At 96 kHz, it is recommended that you use
the S/PDIF (RCA) port

The Optical I/O ports use a standard optical
“lightpipe” cable.

A\ Avid recommends high-quality audio grade
optical cable for all optical connections.

When the 003 Rack+ is on, its Optical Out port
emits a red light.

About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel
optical digital audio connection developed by
Alesis. Lightpipe is found on many devices, in-
cluding ADAT decks, modular digital
multitracks (MDMs), sound cards, standalone
A/D or D/A converters, and digital consoles.

Word Clock

The Word Clock In and Out ports let you con-
nect BNC cables to synchronize your 003 Rack+
to incoming 1x Word clock, and synchronize
other devices to Pro Tools-generated Word
clock.



MIDI Connectors

The MIDI In and MIDI Out ports are standard
5-pin MIDI ports. The MIDI In port supports 16
channels of MIDI input. The MIDI Out port sup-
ports 16 channels of MIDI output.

A MIDI driver for these MIDI ports is installed
when you install Pro Tools LE, and is recognized
automatically by Audio MIDI Setup (Mac) and
MIDI Studio Setup (Windows). These connec-
tors accept standard 5-pin MIDI cables.

A\ The 003 Rack+ only has one MIDI Out
port. However, MIDI Out 2 will still appear
in Pro Tools. When using the 003 Rack+
with Pro Tools, only use MIDI Out 1. Select-
ing MIDI Out 2 will produce no MIDI out-
put information.

Kensington Lock Port

Use the Kensington Lock port, located on the
right side of the device’s chassis, to secure your
003 Rack+ with a Kensington Lock (not sup-
plied).

For more information, visit the Kensington web-
site (www.kensington.com).

Footswitch Jack

This connector lets you use a footswitch pedal to
control either playback start/stop or recording
punch in/out. Both QuickPunch audio
punch-in and punch-out and MIDI punch-in
and punch-out recording are supported. The
footswitch connector is designed specifically for
instantaneous (momentary) on/off pedals with
a 1/4-inch TS connector. Continuous on/con-
tinuous off pedals can also be used, but may re-
sult in unexpected behavior.

IEEE-1394 (FireWire) Ports

These ports, marked “1394” in reference to their
IEEE specification, are commonly known as
FireWire ports. These provide connections to the
computer and other FireWire devices.

FireWire offers a high rate of data transfer and
reliability that makes it ideal for audio applica-
tions (such as Pro Tools with 003 family inter-
faces). FireWire devices can be daisy-chained to-
gether without the need for terminators.

If you are using a Windows laptop that has
a 4-pin FireWire port (commonly labeled
“1394”), see “Additional Software on the
Pro Tools Installer Disc” on page 17 for
FireWire cable information.

Connecting 003 Rack+ and FireWire Hard
Drives

The FireWire ports on the 003 Rack+ do not pass
data when they are powered off. If you
daisy-chain FireWire devices from your com-
puter, it is best to connect FireWire hard drives
directly to your computer and not to the

003 Rack+. This will prevent hard drive errors
and data loss in case the 003 Rack+ is powered
off.

A Connecting the 003 Rack+ to a FireWire
port of an external drive that is connected to
a computer does not support maximum
track count. For information on supported
PCI/PCMCIA/ExpressCard FireWire
options, visit www.avid.com.
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Connecting Other FireWire Devices 003 Rack+

The second FireWire port on 003 Rack+ is avail-
able for daisy-chaining FireWire devices such as
digital cameras or digital video recorders. Even

when it is powered off, 003 Rack+ supply power
from the computer through their FireWire ports,
letting you recharge batteries in other FireWire

devices.

Link Indicator

The Link indicator lights when a valid FireWire
connection is established (between the
003 Rack+ and a computer).

AC Power Connector

The AC power connectors on 003 Rack+ accepts
a standard modular AC power cable.

003 Rack+ is auto power-selecting (100V to
240V) and will work automatically when
plugged into an AC power receptacle in any
country.

A\ 003 Rack+ requires AC power and cannot
be powered by the FireWire bus.
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chapter 10

Making Studio Connections

To hear audio recorded into a Pro Tools session,
you will need to connect headphones or an ex-
ternal sound system (such as powered monitors
or a home stereo) to your 003 family interface.
Sound from your 003 family interface cannot be
played through your computer’s speakers or
your computer’s sound output.

Connecting Headphones

There are two stereo 1/4-inch headphone jacks
on 003 family interfaces.

[
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OO ‘? =

1/4-inch Headphone jacks

Headphone 1 and 2
Level control

Headphone jacks (Front panel of 003 Rack shown)

To connect headphones:

= Connect headphones with a 1/4-inch stereo
connector (or adapter) to the Headphone 1 or 2
jack.

To adjust headphone levels:

= Adjust the Headphone 1 or 2 Level knobs.
To set Headphone 2 Output to mirror Output pair
3-4:

= Press the 3/4-HP2 switch.

Connecting a Sound System

The Main Monitor Outputs on the back of 003
family interfaces support 1/4-inch plugs. These
connections can be balanced, TRS (Tip, Ring,
Sleeve) style connectors, or unbalanced connec-
tors. To listen to your Pro Tools session, these
outputs can be connected to any amplification
system: powered speakers, a home stereo sys-
tem, or an audio mixer.

Q An alternate monitoring system can be
" connected to the Alt Monitor Outputs.

Chapter 10: Making Studio Connections 77



When connecting to a stereo system, connect
the left channel to Main Monitor Output L, and
right channel to Main Monitor Output R.

Main Monitor Outputs
Monitor Outputs (all models)

Q Home stereo systems often use RCA
" connectors for analog audio connec-
tions. You can use an adaptor or a spe-
cial cable to convert from the TRS or
TS connectors used by and 003 Rack to
the RCA connectors on your home ste-
reo.

Main Monitor Outputs L and R play the audio
that is routed to analog outputs 1 and 2 within
Pro Tools.

The Monitor Level knob (located on the top
panel of 003, and on the front panel of 003 Rack
and 003 Rack+) adjusts the volume level of the
Monitor Outputs.

You can also connect a sound system to any of
the Analog Outputs 1-8, although you will not
have Monitor section controls available.

Q If you plan on connecting Analog Outputs
© 1-8to-10 dBV gear, you may want to
place a transformer-based line level attenu-
ator between your 003 family interface’s
output and the input of the destination de-
vice to compensate for level differences.
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Mirroring the Outputs on S/PDIF Out

When using your 003 family interface with
Pro Tools, you can send any pair of outputs
(such as outputs 1-2) to the S/PDIF digital out-
puts at the same time by assigning the stereo
mix to multiple output destinations. This is
commonly known as mirroring the outputs.

Output mirroring is useful for recording to mul-
tiple media, creating separate monitoring mixes,
or for output to digital effects processors.

For information on S/PDIF connections, see
“Connecting Equipment with Digital Ins
and Outs” on page 86

To mirror 003 family interface Outputs 1-2 on the
S/PDIF outputs:

1 Open the Pro Tools session whose channel
outputs you want to mirror.

2 In the Mix window, click the Output selector
of any audio or Auxiliary Input track to select
the main output destination, for example, Ana-
log 1-2.

3 Control-click (Mac) or Start-click (Windows)
the same Output selector and select an addi-
tional output pair from the same pop-up menu.

The newly selected destination is indicated by
an additional check mark in the output pop-up
menu, and a plus sign in the Output selector.



Connecting Audio Inputs

003 family inputs support microphones, guitars,
keyboards, and other types of instruments.

003 family interfaces have eight analog inputs.
On the 003 and 003 Rack, one set of inputs is la-
beled Mic Inputs 1-4 and DI Inputs 1-4, and the
other four are labeled Analog 5-8.

Mic Inputs 1-4

o

BlORE OFIOREIO!

DI Inputs 1-4

Four Mic and DI Inputs (003 and 003 Rack shown)

+0.:0:0.:@
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Analog Inputs 5-8
Four Analog Inputs (003 and 003 Rack shown)

On the 003 Rack+, XLR mic inputs are labeled 1-
8, and the combination Line/DI 1/4-inch inputs
are labeled 1-8.

Mic Inputs 1-8

Mic Inputs 1-8 (003 Rack+ shown)

Line/Dl inputs 1-8

| |

Line/DI Inputs 1-8 (003 Rack+ shown)

For stereo inputs, use an odd/even pair of inputs
(for example, Input 5 for the left input, and In-
put 6 for the right input.

You cannot use both a mic input and DI input
with the same input number at the same time.

For information about connecting specific au-
dio sources, see “Connecting a Microphone” on
page 80, and “Connecting Instruments to 003
Family Interfaces” on page 83.
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Connecting a Microphone

There are several ways to use your 003 family in-
terface with a microphone, depending on the
type of microphone and cables you use.

Mic Cables and Connectors

Some microphone cables use an XLR connector
to attach a microphone to an input (such as
those on 003 family interfaces). Other micro-
phones use a 1/4-inch connector. If you have a
choice, use an XLR connector to connect the mi-
crophone to your 003 family interface to yield
better results.

XLR connector

1/4-inch connector

XLR and 1/4-inch connectors

Phantom Power

Some microphones require power to operate.
This power, called phantom power, is supplied ei-
ther by a battery in the microphone, or through
an audio interface (such as your 003 family in-
terface) that can supply power through the mi-
crophone cable.
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Most condenser microphones (such as an AKG
C3000) require phantom power to operate. Dy-
namic microphones (such as a Shure SM57) do
not require phantom power to operate, but are
not harmed by it.

A Although phantom power can be used
safely with most microphones, ribbon mi-
crophones can be damaged by it. Always
turn off phantom power and wait at least
30 seconds before connecting a ribbon mi-
crophone.

003 family interfaces can only supply power
through a microphone cable with XLR connec-
tors.

If you are not sure about the phantom power re-
quirements for your microphone, see your mi-
crophone’s documentation or contact the man-
ufacturer.

Using a Mic with an XLR Connector

To use a microphone that has an XLR connector:

1 On the back of your 003 family interface, plug
your microphone cable into one of the XLR mic
inputs. The inputs are numbered left to right, so
Mic Input 1 is the leftmost input.

Mic Input 1

XLR cable plugged into Mic Input 1 (003 and 003 Rack
shown)



2 Depending on your device, do one of the fol-
lowing:
e If using the 003 or 003 Rack, press the
Mic/DI switch (located on the top panel of
the 003, and on the front panel of the 003
Rack) for the corresponding input so that it
is in the Mic (unlit) position.

Input 1-4 Gain control

NPUT 1 INPUT 2

® O O

Mic/Dl HPF Mic/Dl HPF Mic/Dl HPF Mic/Dl HPF

IC)CDC)C)C)C)C)(D|

Mic/DI and HPF switches for Inputs 1-4
003 and 003 Rack Mic/DlI switches
e If using the 003 Rack+, press the Input
Channel Select switch (located on the front
panel) for the corresponding input and

make sure the Line-DI switch is not en-
abled (unlit).

Input Channel Control Line-DI switch

Input 1-8 Gain Control

o O C =
O O O =

1 2 3 4 5 6 7 8 i
I@ ) [Ip |
48V
Phantom

Power
switch

Input Channel Select switches

003 Rack+ Input Channel Select switches and Input
Channel Control switches

3 If your microphone requires phantom power,
make sure the microphone is connected and do

one of the following depending on your device:

e If using the 003 or 003 Rack, press the
Phantom Power switch (labeled 48V) on
the back of the device for the correspond-
ing input pair. Each Phantom Power switch
sends 48V to its corresponding input pair.

e If using the 003 Rack+, press the Input
Channel Select switch (located on the front

panel) for the corresponding input and
press the 48V switch so that it is lit (red).

©‘F 5.0 @? +(®)
| |

Phantom Power
(Mic Inputs 1 and 2)

Phantom Power
(Mic Inputs 3 and 4)

Phantom Power switches (003 and 003 Rack shown)

4 When Pro Tools is launched and the input is
routed to a Pro Tools track, you can adjust the
input level with the Input Gain Control knobs
(located on the top panel of the 003, and the
front panel of the 003 Rack and 003 Rack+).
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Using a Mic with a 1/4-Inch
Connector

To use a microphone that has a 1/4-inch
connector with your 003 family interface:

1 Do one of the following, depending on your
device:

e Ifusing the 003 or 003 Rack, on the back of
your device plug the 1/4-inch connector
from your microphone into one of the DI
inputs. From the back, the inputs are num-
bered left to right, so DI Input 1 is the left-
most input.

@..® .

N\

003 and 003 Rack with 1/4-inch cable plugged into DI
Input 1

d

—or-

¢ If using the 003 Rack+, plug your mic’s 1/4-
inch connector into the DI 1 1/4-inch in-
put on the front panel (or into a rear-panel
1/4-inch Line/DI input).

DI 1 mV

5 @@@2
O &) o€) o€ ™

quuuuui
|

Input Channel Control Line-DI switch

Input 1-8 Gain Control

Input Channel Select switches

003 Rack+ with 1/4-inch cable plugged into DI 1 input
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2 Do one of the following, depending on your
device:
e If using the 003 or 003 Rack, press the
Mic/DI switch (located on the top panel of
the 003, and on the front panel of the 003
Rack) for the corresponding input so that it
is lit (yellow).

Input 1-4 Gain control

INPUT 1 INPUT 2 INPUT 3 INPUT 4

O O O O

Mic/DI HPF Mic/DI HPF Mic/DI HPE Mic/DI HPE

l@@@@@@@@

Mic/DI and HPF switches for Inputs 1-4
003 and 003 Rack+ Mic/DI switches

—or-

e If using the 003 Rack+, press the Input
Channel Select switch (located on the front
panel) for the corresponding input and
press the Line-DI switch so that it is lit (or-
ange).

A If you are using a microphone with a 1/4-
inch connector, do not choose the “Mic” in-
put source because the 003 family interface
will not register any signal.

3 When Pro Tools is launched and the input is
routed to a Pro Tools track, you can adjust the
input level with the Input Gain Control knob.



Connecting Instruments to
003 Family Interfaces

The 1/4-inch inputs on 003 family interfaces
support both higher output “line-level” devices
and low-output instruments (such as electric or
acoustic guitars). This section contains exam-
ples for connecting both types to your 003 fam-
ily interface.

Instruments such as electric guitar or electric
bass usually have a lower level of output than in-
struments and electronic audio sources such as
mixers, samplers, keyboards, turntables, and
synthesizers.

The higher level of output is commonly called
“line-level” and the instruments that produce
these higher levels are called line-level devices.

On 003 and 003 Rack, DI Inputs 1-4 support
low-level instruments and line-level instru-
ments. Analog Inputs 5-8 support line-level in-
struments only.

On the 003 Rack+, Line/DI inputs 1-8 (as well as
the front panel DI 1 input) support low-level in-
struments and line-level instruments.

To use a guitar with the 003 family interface:

1 Do one of the following, depending on your
device:
¢ On the back of the 003 or 003 Rack, plug
your guitar cable into one of the DI inputs.
From the back, the inputs are numbered
left to right, so DI Input 1 is the leftmost in-
put.

d a5
OFfo

N\

003 and 003 Rack with 1/4-inch cable plugged into DI
Input 1

e If using the 003 Rack+, plug your guitar ca-
ble into the front panel DI 1 1/4-inch input
(or into a rear-panel 1/4-inch Line/DI in-

put).
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2 Do one of the following, depending on your
device:
e If using the 003 or 003 Rack, press the
Mic/DI switch (located on the top panel of
the 003, and on the front panel of the 003
Rack) for the corresponding input so that it
is lit (yellow).

Input 1-4 Gain control

Mic/DI and HPF switches for Inputs 1-4

003 and 003 Rack Mic/DI switches

—or-

e If using the 003 Rack+, press the Input
Channel Select switch (located on the front
panel) for the corresponding input, and
press the Line-DI switch so that it is lit (or-
ange).

Line-DI switch

DI 1 input Input 1-8 Gain control

003 RACK +

Input Channel Select switches
003 Rack+ with 1/4-inch cable plugged into front panel
DI 1 input

3 When Pro Tools is launched and the input is
routed to a Pro Tools track, you can adjust the
input level with the Input Gain Control knob.

003 Family User Guide

To use a keyboard or mixer with 003 or 003 Rack:

1 On the back of the 003 or 003 Rack, plug your
keyboard, mixer, or other audio source into any
of the DI inputs or Analog Inputs by doing one
of the following:

e Use Analog Inputs 5-8 if you need to select
—-10 dBV or +4 dBu operating level for your
keyboard.

—or-

e Use DI Inputs 1-4 if Analog Inputs 5-8 are
unavailable, or if you do not need to set the
operating level. DI Inputs 1-4 are available
even if a mic is connected to Mic Inputs
1-4 (although both cannot be active at the
same time).

For stereo inputs, (such as a stereo keyboard or
the stereo output from a mixer), use an
odd/even pair of inputs. For example, connect
the left channel to DI Input 1, and right channel
to DI Input 2.

From the back, the inputs are numbered left to
right, so DI Input 1 is the leftmost input.

gd.igidesinn
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Stereo keyboard plugged into Analog Inputs 5-6



2 If you are using any DI inputs, press the
Mic/DI switch (located on the top panel of the
003, and on the front panel of the 003 Rack) for
the corresponding input so that it is in the DI
(lit) position.

Input 1-4 Gain control

INPUT 1 INPUT2

O O O ©

oD rier J (i) WioD__HPr
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Mic/DI and HPF switches for Inputs 1-4

Mic/DI switches (located on the top panel of 003, and
front panel of 003 Rack)

A For line-level devices, the Input Gain Control
knob should be turned down all the way.

3 If you are using any of the Inputs 5-8, set ei-
ther a-10 dBV or +4 dBu operating level for the
corresponding input using the Operating Level
switch (located on the back panel). For informa-
tion on the appropriate operating level for your
input device, see the manufacturer’s specifica-
tions.

F— . = =
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Operating Level switches
for Analog Inputs 5-8

003 and 003 Rack’s four Analog Inputs

4 Set your instrument’s volume to its optimal
level. For example, the optimal level for most
keyboards is between 80% and 100% of maxi-
mum volume.

5 When Pro Tools is launched and the input is
routed to a Pro Tools track, if you are using the
DI Inputs you can adjust the input level with the
Input Gain Control knob.

To use a keyboard or mixer with 003 Rack+:

1 On the back of the 003 Rack+, plug your key-
board, mixer, or other audio source into any of
the Line/ DI inputs.

qy o eeee

A\

Stereo keyboard plugged into Line/Dl inputs 1-2
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For stereo inputs, (such as a stereo keyboard or
the stereo output from a mixer), use an
odd/even pair of inputs. For example, connect
the left channel to Line/DI Input 1, and right
channel to Line/DI Input 2.

2 On the front panel, press the Input Channel
Select switch (located on the front panel) for
each corresponding input, making sure the

Line-DI switch is enabled (lit) for each channel.

Line-DI switch

Input 1-8 Gain control

Input Channel Select switches

003 Rack+ Front

3 Set your instrument’s volume to its optimal
level. For example, the optimal level for most
keyboards is between 80% and 100% of maxi-
mum volume.

4 When Pro Tools is launched and the input is
routed to a Pro Tools track, you can adjust the
input level with the Input Gain Control knob.

A\ Forline-level devices, the Input Gain Control
knobs should be turned down all the way.
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Connecting Equipment with
Digital Ins and Outs

Each 003 family interface provide up to ten dig-
ital inputs and outputs, including:

e Eight channels of ADAT Optical input and
output, or two channels of Optical S/PDIF in-
put. Avid recommends high-quality audio
grade optical cable for all optical connections.

e Two channels of S/PDIF digital input and out-
put (RCA connectors).

ol . ONC-NO)

|
RCA S/PDIF In and Out ports

Optical In and Out ports
Digital connectors

Up to 18 channels of I/O can be achieved by us-
ing the S/PDIF RCA 1/0O, Optical (ADAT) 1/0,
and analog I/O at the same time.

A\ Only one S/PDIF input pair can be used at a
time. For example, if you use the optical in-
put for S/PDIF data, you cannot use the
RCA inputs. For more information on con-
figuring Digital I/O, see “Configuring
Pro Tools LE Software” on page 22.

For more information on each I/O type, see
“Digital I/O” on page 64

For information on connecting digital ef-
fects devices, see “Using External Effects
Devices” on page 88.

For information on recording from a Digital
I/O, see “Recording from a Digital Device”
on page 90.



To connect your 003 family interface to a S/PDIF
digital device using RCA cables:

1 Using RCA (coaxial) cables, connect the 003
family interface S/PDIF In to the S/PDIF output
of the external device.

2 Connect the 003 family interface S/PDIF Out
to the S/PDIF input of the external device.

To connect your 003 family interface to a S/PDIF
device using Optical (ADAT) cables:

1 Using an optical cable, connect the Optical
output on the Optical device to the Optical In
port on the 003 family interface.

2 Connect the Optical input on the Optical de-
vice to the Optical Out port on the 003 family
interface. (When the 003 or 003 Rack is on, its
Optical Out port emits a red light.)

To connect your 003 family interface to an ADAT
device using Optical (ADAT) cables:

1 Using an optical cable, connect the Optical
output on the ADAT device to the Optical In
port on your 003 family interface.

2 Connect the Optical input on the ADAT de-
vice to the Optical Out port on the 003 family
interface. (When your 003 family interface is on,
its Optical Out port emits a red light.)

Word Clock

003 family interfaces provide Word Clock In
and Out connectors on the back panel that let
you synchronize, or “clock” Pro Tools LE and
the 003 family interface to industry standard
Word clock. Word clock is used to synchronize a
wide range of devices such as non-linear video
systems and other types of equipment typically
found in professional audio facilities.

With both Word clock input and output, your
Pro Tools LE system can act as Word clock
“slave” or “master.”

Do not confuse Word clock and other forms
of “clock reference” with time code and other
forms of “positional reference.” For an over-
view of synchronization terms and concepts,
see the Sync & Surround Concepts Guide.

To connect your 003 family interface to Word
clock:

= Using high-quality, 75 Ohm BNC cables (not
included), connect the 003 family interface
Word Clock In and Out connectors to the appro-
priate ports on the other Word clock-capable de-
vices in your studio.

Using Word Clock with
Pro Tools LE

Pro Tools LE with 003 family interfaces can act
as Word clock master, or as a slave to Word clock
supplied by an external device.

Pro Tools LE as Word Clock Master

003 family interface Word clock output is al-
ways active, letting Pro Tools supply Word clock
to any connected devices that support standard
Word clock.

To use Pro Tools LE as Word clock master:

1 Make sure all connections are correct between
the 003 family interface and your external de-
vices.

2 Configure all external devices to slave to the
Word clock coming from the 003 family inter-
face. (Be sure to match the sample rate setting of
the Pro Tools session, and verify the termination
requirements and other internal settings for the
device; see the manufacturer’s documentation
for the requirements for your other equipment.)
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3 Launch Pro Tools.
4 Choose Hardware > Setup.

5 Click the Clock Source pop-up menu and select
Internal.

6 Click OK.

Pro Tools LE as Word Clock Slave

In order to slave Pro Tools to an external Word
clock source, you must configure Word clock as
the Pro Tools Clock source, as follows:

To configure Pro Tools LE with the 003 family
interface as a Word clock slave:

1 Make sure all Word clock and audio connec-
tions are correct as described earlier in this sec-
tion.

2 Make sure the external Word clock source is
powered on, and configured to output 1x Word
clock. (Be sure to verify any required termina-
tion; see the manufacturer’s documentation for
the particular requirements for your device.)

3 Launch Pro Tools.
4 Choose Hardware > Setup.

5 Click the Clock Source pop-up menu and select
Word Clock.

6 Click the Sample Rate pop-up menu and
match the sample rate of the external Word
clock source.

7 Click OK.
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Using External Effects
Devices

003 family interfaces can make dedicated con-
nections to external analog or digital devices.
You can send and return signals to analog de-
vices using the analog inputs and outputs on
003 family interfaces. You can also send and re-
turn a digital signal to an external device that
supports digital I/O (such as a reverb unit), and
monitor the return by connecting its analog
outputs to available inputs on 003 family inter-
faces.

When you use the digital inputs and outputs on
your Pro Tools LE system as effects sends and re-
turns to a digital effects device, Pro Tools LE
should be the clock master in most cases. Set
your digital effects device to accept an external
digital clock so that it synchronizes to

Pro Tools LE.

To connect an external analog device to your
system:

1 Connect each input of the external signal pro-
cessor to an available analog output on the 003
family interface.

2 Connect each output of the external signal
processor to an available analog input on the
003 family interface.

Q If you plan to use the external device as an
Insert in Pro Tools, connect it to inputs and
outputs of the same number (for example,
Input 5 and Output 5) of the 003 family
interface.



To set up a send to an external digital effects
device (digital sends/returns only):

1 Connect the digital inputs and outputs of the
external signal processor to the appropriate dig-
ital connectors (the S/PDIF RCA connectors or
the Optical ports) on 003 family interface.

2 In Pro Tools, choose Setup > Hardware.

3 Under Optical Format, do one of the follow-
ing:

e If the external effects device is a S/PDIF de-
vice and connected to the S/PDIF RCA
jacks, select ADAT (if the selected sample
rate is 44.1 or 48 kHz) or None (if the se-
lected sample rate is 88.2 or 96 kHz). The
RCA jack is only active when Optical S/PDIF
is not enabled.

e If the external effects device is a S/PDIF de-
vice and connected to the Optical ports, se-
lect S/PDIF.

o If the external effects device is an ADAT
Optical compatible device, select ADAT.

4 Click the Clock Source pop-up menu and select
Internal.

5 Click the Sample Rate pop-up menu and select
a sample rate. The sample rate of the Pro Tools

session and external digital device must match.
If necessary, change the sample rate of the digi-
tal device.

6 Click OK.

You can use the I/O Setup dialog (Setup >
I/O) to label the inputs and outputs you are
using in Pro Tools LE and identify them as
inserts or sends when working in a session.
See the Pro Tools Reference Guide for
details.

Monitoring and Recording
from Alternate Sources

003 family interfaces provide a pair of addi-
tional inputs for monitoring and recording from
an external sound source such as a CD player or
tape deck. This alternate input is equipped with
1/4-inch TRS connectors and is designed for in-
put signals with a nominal operating level of
+4 dBu.

(

QIO

o

Aux In

Aux In for alternate sound sources

@ To monitor an external device through the
Alternate Source Inputs, the 003 family in-
terface must be powered on.

To monitor an alternate sound source through the
Monitor Outputs of your 003 family interface:

1 Connect the outputs of the external device to
the left and right Aux In connectors on the back
panel of the 003 family interface.

2 Route the signal to the Monitor Output by
pressing the Aux In switch (located on the top
panel of 003, and on the front panel of 003 Rack
and the 003 Rack+) so that it is enabled (lit).

3 If you want to monitor the signal through the
Alternate Monitor Outputs, press the Alt CR
switch. Any tracks within Pro Tools that are sent
to the Monitor Outputs will not be heard.

4 Adjust Monitor Output or Headphone Output
levels to audition the input.
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To record an alternate sound source directly into
Pro Tools:

1 Connect the outputs of the external device to
the left and right Aux In connectors on the back
panel of the 003 family interface.

2 Route the signal directly to Inputs 7-8 in
Pro Tools by pressing the Aux In to 7-8 switch
(located on the top panel of 003, and on the
front panel of 003 Rack and the 003 Rack+) so
that it is enabled (lit).

When the Aux In to 7-8 switch is enabled, In-
puts 7 and 8 on the back panel are inactive. Also,
because the signal can be monitored from

Pro Tools, it no longer passes directly to the
Monitor Outputs.

Recording from a Digital
Device

If you are recording from an optical or S/PDIF
device, you will need to select a Clock Source. In
most cases, you will synchronize the Pro Tools
clock to the external device.

If you are using an optical device for recording,
you also need to set the Optical Format.

To configure Pro Tools LE for a digital source:

1 Connect an ADAT or Optical S/PDIF format
device to the Optical In connector, or an RCA
S/PDIF format device to the S/PDIF In connector
on the back of the 003 family interface.

2 Choose Setup > Hardware.
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3 Under Optical Format, do one of the follow-
ing:

e If the external digital device is a S/PDIF de-
vice and connected to the S/PDIF RCA
jacks, select ADAT (if the selected sample
rate is 44.1 or 48 kHz) or None (if the se-
lected sample rate is 88.2 or 96 kHz). The
RCA jack is only active when Optical
S/PDIF is not enabled.

o If the external digital device is a S/PDIF de-
vice and connected to the Optical ports, se-
lect S/PDIF.

e If the external digital device is an ADAT
Optical compatible device, select ADAT.

A\ You can use only one pair of S/PDIF inputs
(either RCA or Optical) at a time.

4 From the Clock Source pop-up menu, do one
of the following:
e If you are synchronizing the Pro Tools
clock to the external device, select ADAT,
RCA (S/PDIF), or Optical (S/PDIF), depending
on where you connected your digital de-
vice.

A Your digital input device must be connected
and powered on. If your input device is not
powered on, leave the Clock Source set to
Internal.

e Select Internal if you are synchronizing the
external device to the 003 family interface.

You can use the I/O Setup dialog (Setup >
I/0) to label the inputs and outputs you are
using in Pro Tools LE and identify them as
inserts or sends when working in a session.
See the Pro Tools Reference Guide for
details.



5 Click the Sample Rate pop-up menu and select
a sample rate. The sample rate of the Pro Tools

session and external digital device must match.
If necessary, change the sample rate of the digi-
tal device.

6 Click OK.

Connecting a Recorder for
Mixdowns

After you record and mix your sessions using
your 003 family interface, you may want to mix
them down to a DAT, or other stereo 2-track re-
cording device.

Connecting an Analog Deck

« Connect your recorder’s inputs to the Alt
Monitor Outputs (or any other output pair) on
the back of the family interface. These outputs
are 1/4-inch jacks. You may need adapter cables
if your mixdown deck has RCA inputs.

Alt Monitor Outputs
Alt Monitor Outputs and other outputs

Connecting a Digital Deck

o If you have a DAT or other digital device that
can receive S/PDIF digital audio data, connect it
to the S/PDIF In and S/PDIF Out RCA jacks on
the back of the 003 family interface.

(©)
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RCA S/PDIF In and Out ports

S/PDIF In and Out ports
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Connecting a Lightpipe-Compatible
Device (ADAT)

To connect a Lightpipe-compatible device (ADAT)
to your 003 family interface:

1 Connect the Optical output on the ADAT to
the Optical In port on the 003 family interface.

2 Connect the Optical input on the ADAT to the
Optical Out port on the 003 family interface.

. =1 © @ ©

|
Optical In and Out

Optical In and Out ports

MIDI Connections

The MIDI ports on 003 family interfaces let you
take advantage of all the MIDI features of

Pro Tools LE, including recording and editing
MIDI tracks.

If you need additional MIDI ports you can add a
compatible MIDI interface (such as a MIDI I/O).

To connect your MIDI device to your 003 family
interface:

1 Connect a standard 5-pin MIDI cable from the
MIDI Out port of your device to the MIDI In

port on the back panel of the 003 family inter-
face.

2 Connect another MIDI cable from the
MIDI In port of your device to one of the
MIDI Out ports on the back panel of the 003
family interface.

Q The MIDI Out port can be selected in
" Pro Tools or a supported third-party
application.
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A\ The 003 Rack+ only has one MIDI Out port.
However, MIDI Out 2 may still appear in
Pro Tools. When using the 003 Rack+ with
Pro Tools, only use MIDI Out 1. Selecting
MIDI Out 2 will produce no MIDI output
information.

Monitoring MIDI Instruments with 003
Family Interfaces

If you have a MIDI instrument that has analog
outputs, you can connect it to your 003 family
interface to monitor its output.

To connect your MIDI instrument for monitoring in
Pro Tools:

» Connect the MIDI instrument’s audio output
to a Line/DI (003 Rack+) input, or to a DI or An-
alog Input on the back panel of the 003 or 003
Rack.
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MIDI instrument audio outputs plugged into 003 and
003 Rack Analog Inputs 5-6

qy e eeieee
\ N\

MIDI instrument audio outputs plugged into 003 Rack+
Line/DI Inputs 1-2

92 003 Family User Guide

Using a Footswitch

The footswitch connector on your 003 family
interface lets you use a footswitch pedal to con-
trol either playback start/stop or recording
punch in/out. Both QuickPunch audio punch-
in and punch-out and MIDI punch-in and
punch-out recording are supported.

The footswitch connector is designed specifi-
cally for instantaneous (momentary) on/off
pedals with a 1/4-inch TS connector. Continu-
ous on/continuous off pedals can also be used,
but may result in unexpected behavior.

To use a footswitch control:

1 Connect a footswitch to the footswitch con-
nector on the back panel of the 003 family inter-
face.

2 Launch Pro Tools.
3 Choose Setup > Hardware.

4 Select Record Punch In/Out or Playback
Start/Stop.

5 Click OK.



Pro Tools Mode with 003

In Pro Tools mode, the 003 can be used as a con-
trol surface for your Pro Tools sessions.

003 is in this mode when the 003 unit is con-
nected to a computer and Pro Tools LE software
is running.

If Pro Tools is running and no Pro Tools session
is open, the unit normally displays “Open or
create a new session.” When a session is being
launched, the display changes to “Loading a
session.”

Q If no session is open and a Workspace
" browser is open and being used to audition
an audio file, the unit displays “Working.”

When a Pro Tools session is open, the unit mir-
rors the on-screen controls. 003 faders, transport
switches, rotary knobs, and switches control the
corresponding elements in Pro Tools. You can
also use 003 MIDI ports as you would those on a
standard MIDI interface.

In Pro Tools mode, the Monitor section and
MIDI I/O ports are available with a session open
or closed.

To put 003 in Pro Tools mode:

1 Make sure the 003 unit is properly connected
to the computer and powered on.

2 If Mute is disabled (unlit), enable Mute by
pressing the Monitor Mute switch so that it is lit.

3 Launch Pro Tools LE and open or create a
Pro Tools session.

Saving a Session

You can invoke the Save Session command from
003.

To save the current session:

1 Press the Save switch. The switch flashes to in-
dicate that another press will result in a Save.

2 Do one of the following:

e To save the session, press the Save switch a
second time.

— Or —

e To cancel the save, press the ESC switch.
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Working in Console View

Console View provides a global view of a given
control type across the 003 (such as send A for
the current bank of channels).

003 is in Console View when any of the Console
View switches (Pan, Send, or Insert) is lit in the
Console View section.

Q When you first open a Pro Tools session,
the top row of the 003 is in Console View
with the Pan switch enabled (lit). This
default view is sometimes called the
Home View.

Pan switch
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Pan switch in Console View section

¢ In Console View, the touch-sensitive faders on
003 mirror the volume faders in Pro Tools. Fader
assignments are shown on-screen in Pro Tools
by blue outlines around the track names.

+ In Console View, the LED rings surrounding
the rotary encoders indicate either the pan posi-
tion, the send level, or the insert control level
for each channel, depending on which Console
View switch is enabled (lit).

There are three Console Views, based on their
corresponding switch name: Pan View, Send
View, and Insert View.
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Pan View Workflows

When the Pan switch is enabled (lit), 003 is in
Pan View. This is the default View when you
first open a Pro Tools session. In this view, you
can use the rotary encoders to adjust pan on the
current bank of tracks, select and rename tracks,
and assign inputs or outputs in Assign mode.

For information on assigning inputs and
outputs in Assign mode, see “Assigning
Pro Tools Paths (Input, Output, Sends,
Inserts)” on page 104.
To adjust a track’s panning controls:
1 Press the Pan switch to put 003 in Pan View.
2 Do one of the following:

o If the track is a stereo track, toggle the Me-
ter switch to Left or Right.

— Or —

e If the track is a mono track, toggle the Me-
ter switch to Left.

3 Adjust a channel’s panning by turning its ro-
tary encoder.

Selecting Tracks

To select a track:
1 Press the Pan switch to put 003 in Pan View.

2 Press a Channel Select switch that is unlit to
select the track.

To select a range of tracks:

1 Press the Pan switch to put 003 in Pan View.

2 Press a Channel Select switch that is unlit to
select the track.



3 Hold Shift (Add) and press the Channel Select
switch for an unselected (unlit) track.

All tracks between the first track selected and the
additional track will also be selected.

To remove subsequent tracks in range of selected
tracks:

1 Press the Pan switch to put 003 in Pan View.

2 Hold Shift (Add) and press the Channel Select
switch for a selected (lit) track in the middle (or
beginning) of a range.

All tracks following the selected track will be de-
selected.

To select all tracks:

1 Press the Pan switch to put 003 in Pan View.

2 Hold Opt/Alt All and press the Channel Select
switch for any unselected (unlit) track.

To deselect all tracks:

1 Press the Pan switch to put 003 in Pan View.

2 Hold Opt/Alt All and press the Channel Select
switch for any selected (lit) track.

To select or deselect noncontiguous tracks:

1 Press the Pan switch to put 003 in Pan View.

2 Do one of the following:
¢ In Pan View, hold Command/Ctrl and
press the Channel Select switch for an un-
selected (unlit) tracks to select them.

¢ In Pan View, hold Command/Ctrl and

press the Channel Select switch for any se-
lected (lit) tracks to deselect them.

Renaming Tracks

To rename a track:

1 Press the Pan switch to put 003 in Pan View.

2 Double-press the Channel Select switch for
the track you want to rename.

3 Enter the new name in the Track Name/Com-
ments dialog.

4 Click Enter.

Send View Workflows

When the Send switch is enabled (lit), 003 is in
Send View. In this view, you can adjust send
level with the rotary encoders, toggle pre- and
post-fader operation of sends, and assign sends
in Assign mode.

For information on assigning sends in As-
sign mode, see “Assigning Pro Tools Paths
(Input, Output, Sends, Inserts)” on
page 104.

To display a Send position (A-J):
1 Press the Send switch to put 003 in Send View.

2 Press the Insert/Send Position switch that cor-
responds to the send position that you want to
adjust. The five Console View switches are
dual-function (A/F, B/G, C/H, D/I, E/]). Press the
switch to toggle from the current send to the
corresponding one (such as Send A to F or Send
Fto A).

To adjust send levels:

1 Press the Send switch to put 003 in Send View.

2 Press the Insert/Send Position switch (A/F,
B/G, C/H, D/I, E/]) that corresponds to the send
position that you want to adjust.

3 Adjust a channel’s send level by turning its ro-
tary encoder.
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To toggle a send between pre- and post-fader
operation:

1 Press the Send switch to put 003 in Send View.

2 Press the Channel Select switch under a send
name to toggle its pre- and post-fader setting.

Insert View Workflows

When the Insert switch is enabled (lit), 003 is in
Insert View. In this view, the LCD shows the
names of currently-assigned inserts (hardware
inserts or plug-ins) across all channel strips for a
given insert position (Inserts A-J in Pro Tools).

If a hardware insert or plug-in is selected in
Pro Tools, its name flashes in the LCD.

In this view, you can display inserts, plug-in
controls, bypass plug-ins, and assign inserts in
Assign mode.

For information on assigning inserts in As-
sign mode, see “Assigning Pro Tools Paths
(Input, Output, Sends, Inserts)” on
page 104.

Working with Inserts

To display the inserts on an Insert position (A-J):

1 Press the Insert switch (Console View section)
to put 003 in Insert View.

2 Press the Insert/Send Position switch that cor-
responds to the insert position that you want to
view. The five Console View switches are
dual-function (A/F, B/G, C/H, D/I, E/]). Press the
switch to toggle from the current insert to the
corresponding one (such as Insert A to F or In-
sert F to A).
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The names of inserts on that insert position are
displayed in the LCD. (While the names of hard-
ware I/O inserts are displayed, they have no ed-
itable parameters, so the Channel Select
switches and the rotary encoders have no effect
on them.)

To display the controls for a plug-in:

1 Press the Insert switch (Console View section)
to put 003 in Insert View.

2 Press the Insert/Send Position switch that cor-
responds to the insert position that you want to
view. The five Console View switches are
dual-function (A/F, B/G, C/H, D/I, E/]). Press the
switch to toggle from the current insert to the
corresponding one (such as Insert A to F or In-
sert F to A).

3 Press the Channel Select switch under a
plug-in name.

003 displays the plug-in’s controls across all
channel strips. Controls are assigned to the ro-
tary encoders. Switched controls (such as Master
Bypass or Phase Invert) are controlled by Chan-
nel Select switches.

4 To display any additional pages of plug-in
controls, press the Left and Right Page switches.

@ The Left or Right Page switch flashes when
" an additional page is available.
To bypass a plug-in:

1 Press the Insert switch (Console View section)
to put 003 in Insert View.

2 Hold Command/Ctrl and press the Channel
Select switch under the plug-in name.

The LCD screen displays the name of bypassed
plug-ins in all capital letters.



Working in Channel View

Channel View provides a way to temporarily fo-
cus on all the plug-ins, inserts or sends on a sin-
gle channel.

003 is in Channel View when any of the first
four Channel View Select switches (EQ, Dynam-
ics, Insert, or Pan/Send) is lit in the Channel
View section.

« In Channel View, controls are displayed hori-
zontally across the LCD and can be adjusted
with the channel rotary encoders and switches.
From this view, you can view and edit parame-
ters for all the sends on a single track, or all the
parameters of a single plug-in.

¢ In Channel View, the touch-sensitive faders
on 003 mirror the volume faders in Pro Tools.

¢ In Channel View, the LED rings above the ro-
tary encoders indicate values for the selected
control, such as plug-in parameters, insert lev-
els, or pan values and send levels, depending on
which Channel View switch is lit.

EQ Plug-In Workflows in Channel
View

When the EQ switch is enabled (lit), 003 identi-
fies channels with equalizer plug-ins assigned to
them by illuminating their Channel Select
switches. If no EQ plug-ins are present for the
current bank of channels, no Channel Select
switches will be lit.

In this view, you can display the controls for EQ
plug-ins across all channel strips.

To display all EQ plug-ins on a track:

= Press the EQ switch to put 003 in Channel
View.

To display the controls for an EQ plug-in:

1 Press the EQ switch to put 003 in Channel
View.

2 Press a lit Channel Select switch.

Controls for the first EQ plug-in on that track
are assigned to the rotary encoders and dis-
played in the LCD. Switched controls (such as
Master Bypass or Phase Invert) are controlled by
Channel Select switches.

3 To display any additional pages of plug-in
controls, press the Left and Right Page switches.

Q The Left or Right Page switch flashes when
" an additional page is available.

To cycle through all the EQ plug-ins on a channel:

1 Press the EQ switch to put 003 in Channel
View.

2 Hold the EQ switch and repeatedly press the
track’s Channel Select switch.

If a plug-in window is open on-screen, it will up-
date to reflect the plug-in selected on 003.

Dynamics Plug-In Workflows in
Channel View

When the Dynamics switch is enabled (lit), 003
identifies channels with dynamics plug-ins
(such as compressors or limiters) assigned to
them by illuminating their Channel Select
switches. If no dynamics plug-ins are present for
the current bank of channels, no Channel Select
switches will be lit.

In this view, you can display the controls for dy-
namics plug-ins across all channel strips.

To display all Dynamics plug-ins on a track:

= Press the Dynamics switch to put 003 in
Channel View.
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To display the controls for a Dynamics plug-in:

1 Press the Dynamics switch to put 003 in
Channel View.

2 Press a lit Channel Select switch.

Controls for the first Dynamics plug-in on that
track are assigned to the rotary encoders and dis-
played in the LCD. Switched controls (such as
Master Bypass or Phase Invert) are controlled by
Channel Select switches.

3 To display any additional pages of plug-in
controls, press the Left and Right Page switches.

Q The Left or Right Page switch flashes when
" an additional page is available.

To cycle through all the Dynamics plug-ins on a
channel:

1 Press the Dynamics switch to put 003 in
Channel View.

2 Hold the Dynamics switch and repeatedly
press the track’s Channel Select switch.

If a plug-in window is open on-screen, it will up-
date to reflect the plug-in selected on the 003.

Insert Workflows in Channel View

When the Insert switch is enabled (lit), 003
identifies channels with any kind of insert as-
signed to them (software plug-ins or hardware
1/0 inserts) by illuminating their Channel Select
switches. If no inserts are present for the current
bank of channels, no Channel Select switches
will be lit.
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In this view, you can display inserts or plug-in
controls, bypass plug-ins, and assign inserts in
Assign mode.

For information on assigning inserts in As-
sign mode, see “Assigning Pro Tools Paths
(Input, Output, Sends, Inserts)” on
page 104.

To display the inserts on a track:

1 Press the Insert switch (Channel View section)
to put 003 in Channel View.

2 Press a lit Channel Select switch.

3 Do one of the following:
e To display Inserts A-E, press the Page Left
switch.
—or-
e To display Inserts F-J, press the Page Right
switch.

The names of the inserts are displayed in the
LCD. (While the names of hardware I/O inserts
are displayed, they have no editable parameters,
so the Channel Select switches and the rotary
encoders have no effect on them.)

To display the controls for a plug-in:

1 Press the Insert switch (Channel View section)
to put 003 in Channel View.

2 Press a lit Channel Select switch to display the
inserts for the corresponding track.

3 Do one of the following:
e To display Inserts A-E, press the Page Left
switch.
—or-
e To display Inserts F-], press the Page Right

switch.

4 Press the Channel Select switch under a
plug-in name.



003 displays the plug-in controls across all chan-
nel strips. Controls are assigned to the rotary en-
coders. Switched controls (such as Master Bypass
or Phase Invert) are controlled by Channel Se-
lect switches.

5 To display any additional pages of plug-in
controls, press the Left and Right Page switches.

Q The Left or Right Page switch flashes when
" an additional page is available.
To cycle through all the inserts on a channel:

= Hold the Insert switch and repeatedly press
the track’s Channel Select switch.

To bypass a single plug-in:

1 Press the Insert switch (Channel View section)
to put 003 in Channel View.

2 Press a lit Channel Select switch to display the
inserts for the corresponding track.

3 Do one of the following:

e To display Inserts A-E, press the Page Left
switch.

— Or —

¢ To display Inserts F-J, press the Page Right
switch.

4 Press the Channel Select switch under a
plug-in name.

5 Press the Plug-In Master Bypass switch.

To bypass all plug-ins on a channel:

1 Press the Insert switch (Channel View section)
to put 003 in Channel View.

2 Press a lit Channel Select switch to display the
inserts for the corresponding track.

3 Press the Plug-In Master Bypass switch.

In mixed mode situations, where some plug-ins
are bypassed and some are not, pressing the
Master Bypass switch changes all plug-ins to by-
passed. Press Master Bypass again to take all
plug-ins out of bypass.

Q Hardware I/0 inserts cannot be bypassed in
Pro Tools, so the Plug-In Master Bypass
switch has no effect on them.

Pan/Send Workflows in Channel
View

When the Pan/Send switch is enabled (lit), 003
identifies channels with sends assigned to them
by illuminating their Channel Select switches. If

no sends are present for the current bank of
channels, no Channel Select switches will be lit.

In this view, you can display sends, adjust send
levels, and toggle pre- and post-fader operation.

To display the sends on a track:

1 Press the Pan/Send switch to put 003 in Chan-
nel View.

2 Press a lit Channel Select switch.

3 Do one of the following:

¢ To display Sends A-E, press the Left Page
switch.

—Or —

¢ To display Sends F-J, press the Right Page
switch.

The LCD display for the first channel strip
shows track pan position for that track. (If the
track is a stereo track, you can toggle between
left and right pan by pressing the Meter switch
immediately to the right of the rotary encoders.)

The LCD display for channels 3-7 shows the
send names. Their rotary encoders control the
levels for the corresponding send.
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The Channel Select switches on channels 3-7
toggle pre- and post-fader metering for the cor-
responding send.

To adjust send levels for any of the sends on a
single track:

1 Press the Pan/Send switch in the Channel
View switch section.

2 Press the Channel Select switch for the track
with sends you want to view.

3 Adjust a channel’s send level by turning its ro-
tary encoder.

To adjust pan levels on a track that has sends:

1 Press the Pan/Send switch in the Channel
View switch section.

2 Press the Channel Select switch for the track
with sends that has panning you want to adjust.

3 Do one of the following:
e If the track is a stereo track, toggle the Me-
ter switch to Left or Right.
—or-
e If the track is a mono track, toggle the Me-
ter switch to Left.

4 Adjust the track’s panning by turning the ro-
tary encoder in the first fader strip.

To toggle a send between pre- and post-fader
operation:

1 Press the Pan/Send switch to put 003 in Chan-
nel View.

2 Press a lit Channel Select switch to display the
sends for the corresponding track.

3 Press the Channel Select switch under a send
name to toggle its pre- and post-fader setting.
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Display Options in Console
and Channel View

Displaying Full Names of Tracks, Insert
Parameters, and Other Elements

Track names and other parameters displayed on
the lower row of the LCD are abbreviated to six
characters. Full names can be temporarily dis-
played on the top row of the LCD.

To display full names of tracks and insert
parameters, do one of the following:

= In Pan View, hold Display and press the Chan-
nel Select switch for the track whose name you
want to see displayed fully. The name displays
on the left side of the top row of the LCD dis-

play.

— Or —

= In Insert View, when editing plug-in parame-
ters, hold Display and press the Channel Select
switch for the parameter whose name you want
to see displayed fully. The name displays on the
far right side of the top row of the LCD display.

Displaying Settings Instead of Track or
Control Names

The lower row of the LCD shows track or control
names by default. The display can be changed to
temporarily show settings, or be reset to always
show settings. The Display Mode switch flashes
during a temporary display or when the LCD de-
fault has been reset to always show settings.



Depending on the current Console or Channel
View, you can display insert, plug-in, or
pan/send settings.

See “Working in Console View” on page 94
and “Working in Channel View” on
page 97 for information on the different
Console and Channel Views.

In most temporary display views, faders and ro-
tary encoders can be used to change settings as
you are temporarily viewing them.

To reset the LCD display to show settings for all
views instead of track or control names:

= Hold Command/Ctrl and press Display.

To return the LCD display to its default state
(showing track or control names in all views):

= Press the flashing Display Mode switch.

To temporarily display fader level in the LCD
(Console Pan View):

1 Press the Pan switch to put 003 in Pan View.

2 Hold the Display Mode switch. The lower row
of the LCD shows fader levels for the current
bank of channels (such as Channels 1-8).

Q Fader levels can be adjusted with faders
while the Display mode switch is pressed.

To temporarily display send level in the LCD
(Console Send View):

1 Press the Send switch to put 003 in Send View.

2 Hold the Display Mode switch. The lower row
of the LCD shows send level for the current bank
of sends (such as Send A for Channels 1-8).

Q Send levels can be adjusted with rotary
" encoders (or with faders in Flip mode)
while the Display mode switch is pressed.

To temporarily display insert or plug-in parameters
in the LCD (Console or Channel View):

1 Do one of the following:

e Make sure the Insert switch is lit in the
Console View section.

— Or —

e Make sure the EQ, Dynamics, Insert, or
switch is lit in the Channel View section

2 Press Channel Select for the an insert or
plug-in that you want to display.

3 Hold the Display Mode switch. The lower row
of the LCD shows the insert or plug-in settings.

Q Parameters with ranges can be adjusted
~ with rotary encoders (or with faders in Flip
mode) while the Display mode switch is
pressed. Controls such as On/Off cannot be
changed when the Display mode switch is
pressed.

To temporarily display the channel pan setting and
send levels in the LCD (Channel View):

1 Press the Pan/Send switch to put 003 in Chan-
nel View.

2 Press Channel Select for the channel with the
pan and sends you want to display.

3 Hold the Display Mode switch. The lower row
of the LCD shows the channel pan setting in the
first fader strip and send levels for the cur-
rently-selected channel in fader strips 3-8.

(¥ Pan settings and fader levels can be
adjusted with rotary encoder while the Dis-
play mode switch is pressed.
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Creating Custom Plug-In Maps

You can customize the arrangement of plug-in
parameters on 003 and save them in customized
plug-in maps.

Plug-In maps can be saved as presets and ex-
ported for use across different sessions and sys-
tems.

For complete information on creating and
managing plug-in maps, see the Pro Tools
Reference Guide.

Putting a Plug-In into Learn Mode

When you first put a plug-in into Learn mode, a
new plug-in map is created (with the default
name “Custom Map”), and the plug-in is fo-
cused on the control surface, but with a blank
page of controls, ready for mapping.

Only one plug-in can be in Learn mode at a
time.

To put a plug-in into Learn mode, do one of the
following:

= Click the Learn button in the plug-in window.

» From the Map Options pop-up menu, choose
New Map.

To take a plug-in out of Learn mode, do one of the
following:

= Click the active Learn button in the plug-in
window.

= Close the plug-in window.

= Click the Learn button in a different plug-in
window.
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Q If you move a plug-in to a different insert
" position, or make it inactive, it is automati-
cally taken out of Learn mode.

Creating and Editing Plug-In Maps

To create a custom map of plug-in parameters:

1 Open the plug-in whose mapping you want to
customize.

2 Put the plug-in into Learn mode. 003 displays
a blank page of plug-in controls across all chan-
nel strips, ready for mapping.

3 In the plug-in window, click the plug-in pa-
rameter you want to map. The parameter name
appears in the plug-in window Parameter menu.

4 If necessary, press the Page switches to reveal
additional pages of controls on 003.

5 On 003, do one of the following:

e Turn the encoder or press the channel Se-
lect switch where you want to map the pa-
rameter.

—or-

e If 003 is in Flip mode, touch the fader or
press the channel Select switch where you
want to map the parameter.

6 Repeat steps 3-5 for each parameter you want
to map.

7 Take the plug-in out of Learn mode.

To change parameter mapping in a plug-in map:

1 Open the plug-in whose custom map you
want to change.

2 Choose the map you want to change from the
plug-in window Map Preset pop-up menu.

3 Put the plug-in into Learn mode. 003 displays
the plug-in controls.



4 Do the following for each parameter mapping
you want to change:

¢ In the plug-in window, click the new
plug-in parameter. The parameter name ap-
pears in the plug-in window Parameter
menu.

¢ On the control surface, page to the encoder
or Select switch (or in Flip mode, fader)
where you want to change the mapping,
and turn the encoder, press the switch, or
touch the fader.

5 Take the plug-in out of Learn mode.

To remove parameter mapping from a plug-in map:

1 Open the plug-in whose custom map you
want to change.

2 Choose the map you want to change from the
plug-in window Map Preset pop-up menu.

3 Put the plug-in into Learn mode. 003 displays
the plug-in controls

4 Do the following for each parameter mapping
you want to remove:
e Make sure the Parameter menu displays No
Control.

¢ On the control surface, page to the encoder
or Select switch (or in Flip mode, fader)
where you want to remove the mapping,
and turn the encoder, press the switch, or
touch the fader.

5 Take the plug-in out of Learn mode.

Navigating and Editing Values
in Entry Fields

You can navigate and edit numerical values in
Pro Tools windows (such as Selection Start, End,
and Length, or Pre- and Post-Roll in the Edit or
Transport windows) with the Arrow keys.

To navigate between fields in the Edit window,
Transport window, or a plug-in window:

= Press the Left or Right Arrow key.

To change a value in a selected field:

= Press the Up or Down Arrow key.

Working with Tracks

Navigating the New Track Dialog
when Creating a New Track

You can navigate the New Tracks dialog with
the Arrow keys.

To increase or decrease the number of tracks:

= Press the Up or Down Arrow key.

To scroll through the track types:

= Hold Command/Ctrl and press the Up or
Down Arrow key.

To scroll through the track formats:

= Hold Command/Ctrl and press the Left or
Right Arrow keys.
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Naming Tracks of Adding Track
Comments

To open the Track Name/Comments dialog (to
change a track’s name or comments):

» In Pan View, double-click the track’s Channel
Select switch.

To close the Track Name/Comments dialog:

= In the Channel View section, press the ESC
switch.

Navigating Track Name Field in the Track Name
Dialog

You can move the cursor when you are naming
tracks in the Track Name dialog.

To move the cursor while naming a track, do any of
the following:

= Press the Left or Right Arrow key to move the
cursor backward or forward through the name
field.

= Press the Up or Down Arrow key to move the
cursor to the beginning or end of the field.

= Hold Command/Ctrl and press the Up (or
Left) or Down (or Right) Arrow key to move to
the previous or next track name field.

Assigning Pro Tools Paths
(Input, Output, Sends,
Inserts)

Channel inputs, outputs, inserts, and sends can

be assigned directly from the 003 in Assign
mode.
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Inputs and outputs are assigned in Pan View,
sends are assigned in Send View, and inserts are
assigned in Insert View.

Inputs and Outputs

To assign an input or output:

1 Press the Pan switch in the Console View sec-
tion.

2 On the channel where you want to make the
assignment, do one of the following:
e To assign the output of a track, press its
Channel Select switch for 2 seconds.

e To assign the input of a track, hold Shift

and press the track’s Channel Select switch
for 2 seconds.

The LCD changes to display the selected path
and the Channel Select switch flashes.

3 If you are assigning a different input or output
path type than the current type displayed on the
LCD (such as a bus instead of an interface), do
the following to select a new path type:

¢ Hold Command/Ctrl and press the Chan-
nel Select switch to display the name of the
current path type in the main menu. The
main menu includes a dash (“~”) for no as-
signment, intrfc (interface), bus, and
plug-in (inputs only).

e Use the rotary encoder to scroll through
the list of path types.

e Press the flashing Channel Select switch to
select the path type.

4 Use the rotary encoder to navigate through
the available input or output paths in the sub-
menu.



5 Do one of the following:

e When the desired path is displayed, press
the flashing Channel Select to confirm the
assignment.

If you have multiple assignments in prog-
ress, hold Opt/Alt All and press any flash-
ing Channel Select to save all assignments
at once.

e Hold Command/Ctrl and press the Chan-
nel Select switch if you need to return to
the previous menu level.

e Press the flashing ESC switch to cancel the
assignment.

To remove an input or output:

1 On the channel where you want to remove
the assignment, do one of the following:

e To remove the input of a track, hold Shift
and press the track’s Channel Select switch
for 2 seconds.

— Oor —

¢ To remove the output of a track, press its
Channel Select switch for 2 seconds.

2 For the assignment you want to remove, hold
Command/Ctrl and press the Channel Select
switch the amount of times necessary to return
to the main menu for assigning inputs or out-
puts. This menu includes a dash (“~") for no as-
signment, intrfc (interface), bus, and plug-in
(inputs only).

3 Turn the rotary encoder counter-clockwise un-
til the dash (“~") for no assignment is visible.

4 Do one of the following:
e Press the flashing Channel Select switch to
confirm the removal.
—or-
e Press the flashing ESC switch to cancel the
removal and restore the assignment.

Sends

To assign a send:

1 Press the Send switch in the Console View sec-
tion.

2 On the channel where you want to make the
assignment, press its Channel Select switch for 2
seconds.

The LCD changes to display the bus or output
currently assigned to the selected send, and the
Channel Select switch flashes.

3 If you are assigning a different send path type
than the current type displayed on the LCD
(such as a bus instead of an interface), do the fol-
lowing to select a new path type:
¢ Hold Command/Ctrl and press the Chan-
nel Select switch to display the name of the
current path type in the main menu. The
main menu includes a dash (“-") for no as-
signment, intrfc (interface), and bus.
e Use the rotary encoder to navigate through
the list of path types.
e DPress the flashing Channel Select switch to
select the path type.

4 Use the rotary encoder to navigate through
the available send paths in the submenu.

5 Do one of the following:

¢ Press the flashing Channel Select to con-
firm the assignment.

If you have multiple assignments in
progress, hold Opt/Alt All and press any
flashing Channel Select to save all as-
signments at once.

e Hold Command/Ctrl and press the Chan-
nel Select switch if you need to return to
the previous menu level.

e Press the flashing ESC switch to cancel the
assignment.
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To remove a send:

1 On the channel where you want to remove
the assignment, press its Channel Select switch
for 2 seconds.

2 For the assignhment you want to remove, hold
Command/Ctrl and press the Channel Select
switch the amount of times necessary to return
to the main menu for assigning sends. This
menu includes a dash (“~") for no assignment,
intrfc (interface), and bus.

3 Turn the rotary encoder counter-clockwise un-
til the dash (“~") for no assignment is visible.

4 Do one of the following:
¢ Press the flashing Channel Select switch to
confirm the removal.

e Press the flashing ESC switch to cancel the
removal and restore the assignment.

Inserts

To assign an insert:

1 Press the Insert switch in the Console View
section.

2 On the channel where you want to make the
assignment, press its Channel Select switch for 2
seconds.

The LCD changes to display the plug-in or out-
put currently assigned to the selected insert, and
the Channel Select switch flashes.
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3 If you are assigning a different insert path type
than the current type displayed on the LCD, do
the following to select a new path type:

¢ Hold Command/Ctrl and press the Chan-
nel Select switch to display the name of the
current path type in the main menu. The
main menu includes a dash (“~”) for no as-
signment, plugin (plug-in), and 1/O.

e Use the rotary encoder to navigate through
the list of path types.

e Press the flashing Channel Select switch to
select the path type.

4 If you are assigning a plug-in insert, navigate
down through the submenu levels as necessary.
e Use the rotary encoder to navigate through
the list of plug-in submenus.
¢ Press the flashing Channel Select switch to
select the submenu.

¢ Repeat these steps if necessary, to navigate
through additional plug-in submenu lev-
els.

Q You can hold Command/Ctrl and press the
" Channel Select switch if you need to return
to the previous menu level.

The types of plug-in submenus is determined by
the Organize Plug-In Menus preference in

Pro Tools. See the Pro Tools Reference Guide for
more information.

5 When the desired submenu path is displayed,
use the rotary encoder to navigate through the
available insert paths in the menu.



6 Do one of the following:

e Press the flashing Channel Select to con-
firm the assignment.

If you have multiple assignments in prog-
ress, hold Opt/Alt All and press any flash-
ing Channel Select to save all assignments
at once.

¢ Hold Command/Ctrl and press the Chan-
nel Select switch if you need to return to
the previous menu level.

e Press the flashing ESC switch to cancel the
assignment.

To remove an insert:

1 On the channel where you want to remove
the assignment, press its Channel Select switch
for 2 seconds.

2 For the assignment you want to remove, hold
Command/Ctrl and press the Channel Select
switch the amount of times necessary to return
to the main menu for assigning inserts. This
menu includes a dash (“-”) for no assignment,
plugin (plug-in), and I/O.

3 Turn the rotary encoder counter-clockwise un-
til the dash (“-”) for no assignment is visible.

4 Do one of the following:
¢ Press the flashing Channel Select switch to
confirm the removal.
—or-
¢ Press the flashing ESC switch to cancel the
removal and restore the assignment.

Working with Output Windows

Output windows for tracks and sends can be
opened or closed, and the track output can be
made active or inactive.

Track Output Windows

To open (or close) a track Output window:
1 Press the Pan switch to put 003 in Pan View.

2 Hold the Ctrl/Win switch and press the Chan-
nel Select switch for a track to open (or close) its
Output window.

To open (or close) multiple track Output windows:

= In Pan View, hold Shift (Add)+Ctrl/Win and
press the Channel Select switch for each track
whose window you want to open (or close).

To make a track’s output inactive:

= In Pan View, hold Command/Ctrl+Ctrl/Win
and press the Channel Select switch for a track
to make it output inactive.

Send Output Windows

To toggle a send’s pre- and post-fader operation:
1 Press the Send switch to put 003 in Send View.

2 Press a Channel Select switch for the send
whose pre- and post-fader setting you want to
change. When you release the Channel Select
switch, the LCD shows the new setting.

To mute or unmute a send:

1 Press the Send switch to put 003 in Send View.

2 Hold Command/Ctrl and press the Channel
Select switch for a send on a track to mute or un-
mute it. When the send is muted, its name ap-
pears in all caps in the LCD.
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To open (or close) a send’s Output window:

1 Press the Send switch to put 003 in Send View.

2 Hold Ctrl/Win and press the Channel Select
switch for a track to open (or close) its Output
window.

To open (or close) multiple send Output windows:

1 Press the Send switch to put 003 in Send View.

2 Hold Shift (Add) and Ctrl/Win and press the
Channel Select switch for each track whose win-
dow you want to open (or close).

Recording

To enable or disable tracks for recording:

1 Press the Rec Arm switch so that it is enabled
(flashing). When the Record Arm function is en-
abled, “Record Arm” is displayed in the top row
of the LCD display.

2 Do one of the following:

e To enable a track for recording, press the
Channel Select switch for the track you
want to enable for recording. When a track
is armed for recording, its Channel Select
switch flashes. During recording, its Chan-
nel Select switch is lit continuously.

e To disable a track for recording, press the

Channel Select switch for the track you
want to disable for recording.

3 To deactivate the Record Arm function, press
the Record Arm switch a second time (or press
the ESC switch).

Tracks that are armed for recording will remain
armed after Rec Arming mode is disabled.
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Navigating in the Edit Window

Zooming in the Edit Window

You can zoom in or out in the Edit window, in
order to increase or decrease the waveform or
MIDI resolution.

To zoom in horizontally for all tracks:

1 Press the Zoom switch.

2 Press the Right Arrow key.

To zoom out horizontally for all tracks:

1 Press the Zoom switch.

2 Press the Left Arrow key.

To zoom in vertically for all tracks:

1 Press the Zoom switch.

2 Press the Up Arrow key.

To zoom out vertically for all tracks:

1 Press the Zoom switch.

2 Press the Down Arrow key.

To continuously zoom in or out horizontally for all
tracks:

= Hold the Nudge switch and rotate the inner
Jog wheel clockwise or counter-clockwise.

To continuously zoom in or out vertically for all
tracks:

= Hold Shift (Add)+Opt/Alt (All)+Nudge and ro-
tate the inner Jog wheel clockwise or coun-
ter-clockwise.



Navigating with the Shuttle/Jog
Wheel

Shuttle Mode

To play forwards at a variable rate:

= Rotate the outer Shuttle ring clockwise.

To play backwards at a variable rate:

= Rotate the outer Shuttle ring counter-clock-
wise.

Jog Mode

To move the Transport (or cursor) forwards:

= Rotate the inner Jog wheel clockwise.

To move the Transport (or cursor) backwards:

= Rotate the inner Jog wheel counter-clockwise.

Page Scrolling the Edit Window

To scroll the Edit window one page at a time:

1 Press the Bank, Nudge, or Zoom switch.

2 Hold Command/Ctrl and press the Left or
Right Arrow key.

Moving the Cursor and Making
Selections

To move the cursor or Edit selection up or down
one track:

1 Press the Bank or Nudge switch.

2 Press the Up or Down Arrow key.

To extend an Edit selection up or down one track:

1 Press the Bank or Nudge switch.

2 Hold Shift and press the Up or Down Arrow
key.

Setting Selection Start and End
Points

You can make a selection in the Edit window:
during playback with the Arrow keys.

To make a selection while playing:

1 Make sure to select Options > Link Timeline and
Edit Selection.

2 Click in the track near where you want to
make the selection.

3 Start playback.

4 Press the Down Arrow key at the point where
you want the selection to begin.

5 Press the Up Arrow key at the point where you
want the selection to end.

General Editing

Setting Track Controls to Defaults

The Default switch is used to reset a fader (or
fader-mapped plug-in parameter) to its default
setting.

To set a channel’s fader or plug-in parameter to its
default setting:

= Hold the Default switch and press the Chan-
nel Select switch on a track.

To set all channel faders or plug-in parameters to
their default settings:

= Hold the Default and Opt/Alt (All) switches
and press the Channel Select switch on a track.
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Undoing Pro Tools Operations

You can undo Pro Tools operations from 003.
(See the Pro Tools Reference Guide for details on
multiple undo capabilities.)

To undo an action:

= Press the Undo switch.

To redo an action:

= Hold Shift (Add) and Command/Crtl and
press the Undo switch.

Working With Memory
Locations

Pro Tools Memory Locations (Markers) can be
created directly from 003 during playback or
while the Transport is stopped.

To create a Memory Location:

1 Cue Pro Tools to the desired location, or begin
playback.

2 At the desired location, press Enter (located
among the switches above and to the left of the
Navigation keys).

3 Use the mouse to configure the Memory Loca-
tion dialog on-screen.

4 Press Enter again to save, or press Undo to can-
cel.

To open (or close) the Memory Location window:

= Hold Shift (Add) and press the Mem Loc
switch.

To display Memory Locations:

1 Press the Mem Loc switch.
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When the switch is enabled (flashing), the LCD
shows the first eight Memory Locations in the
bottom row of the LCD display.

2 To display any additional pages of Memory
Locations, press the Left and Right Page
switches.

Q The Left or Right Page switch flashes when
" an additional page is available.

To recall a Memory Location:

1 Press the Mem Loc switch to display Memory
Locations in the LCD display.

2 To display any additional pages of Memory
Locations, press the Left and Right Page
switches.

3 Do one of the following:

¢ Press the Channel Select switch that corre-
sponds to the Memory Location.

e To return to the previous view without se-
lecting a Memory Location, press Mem Loc

again, or any of the Console or Channel
View switches.

Controlling Track Display on
the Control Surface

Using Flip Mode

In Flip mode, control assignments are trans-
ferred from the rotary encoders to the corre-
sponding channel faders.

To transfer controls from the rotary encoders to
the touch-sensitive faders:

= Press the Flip switch. This switch flashes when
Flip mode is activated.



To exit Flip mode (and transfer controls from
faders back to the rotary encoders):

= While in Flip mode, press the Flip switch.

Flip Mode Views

There are several types of Flip mode, depending
on the view.

Send Flip Mode When you are in Console Send
View, the Flip switch moves the send level con-
trols to the channel faders, and the send pan
controls to the rotary encoders. The LCD shows
the selected send (A-E, or F-J) for each channel.

In addition, the Mute switch controls Send
mute, whereas the Solo switch continues to con-
trol the track’s output muting and the Select
switch continues to control Send Pre/Post sta-
tus.

For mono tracks with stereo sends, only the left
pan indicator shows a pan position; the right
pan indicator is inactive.

For stereo tracks with stereo sends, you can con-
trol either the left or right send pan from the ro-
tary encoder.

To assign a stereo send channel to a rotary
encoder:

= While in Send Flip mode, press the Meter
switch immediately to the right of the rotary en-
coders and select Left or Right.

Both the LCD and the Meter Mode LEDs indi-
cate whether the left or right pan position is dis-
played. The rotary encoder LEDs show pan posi-
tioning.

Plug-In Flip Mode When you are in Channel
View (or Console Insert View) and working with
a plug-in insert, the Flip switch moves any
plug-in control assignments from the rotary en-
coders to the faders, allowing you to use the

touch-sensitive faders to edit and automate
plug-in control values. The types of plug-in con-
trols depend on the particular plug-in you are
using.

See “Working in Channel View” on
page 97 for more details on working with
pan controls and sends in Channel View.

Pan/Send Flip Mode When you are in Channel
View and working with the pan and send assign-
ments on a channel, the Flip switch moves the
send level controls to channel faders 3-7, and
the send pan controls to rotary encoders 3-7.
(The first Channel’s LCD display and rotary en-
coder continue to show track pan position for
that track.)

In this mode, the Channel Select switches toggle
pre- and post-fader metering for the correspond-
ing send.

For stereo tracks with stereo sends, you can con-
trol either the left or right send pan from the ro-
tary encoder. See “Send Flip Mode” on page 111.

Banking Channels on 003

To move the display of tracks on 003 forward or
backward eight channels at a time:

1 Press the Bank switch.

2 Press the Left or Right Arrow key.

To move the display of tracks on 003 forward or
backward one channel at a time:

1 Press the Nudge switch.

2 Press the Left or Right Arrow key.

To scroll the display of tracks on 003 forwards

= Hold the Nudge switch and rotate the inner
Jog wheel clockwise to scroll tracks to subse-
quent faders.

Chapter 11: Pro Tools Mode with 003

111



To scroll the display of tracks on 003 backwards:

= Hold the Nudge switch and rotate the inner
Jog wheel counter-clockwise to scroll tracks to
previous faders.

Banking Master Faders

To bank all Master Fader tracks in the current
session to the right-hand side of the control
surface:

» Press the Mstr Fader switch so that its LED is
flashing.

To return the control surface to the previous view:

» Press the Mstr Fader switch so that its LED is
unlit.

Muting Fader Movement

Because 003 faders are motorized, they move to
follow automation when playing back and re-
cording (when the track is set to an automation
read or write mode, and not Off). During critical
listening passes, the sound of the fader motors
and their automated movements may be dis-
tracting. You can temporarily shut off (or mute)
motorized fader movement using the Fader
Mute switch.

To mute fader movement:

= Press the Fader Mute switch so that its LED is
flashing.

To unmute fader movement:

» Press the Fader Mute switch so that its LED is
unlit.
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Working with Automation

The Automation mode can be set from 003 for a
single track, all selected tracks, or all tracks in
the session. You can also suspend automation
globally.

To set the Automation Mode for a single track:

= Hold an Automation Mode switch and press
the Channel Select switch on a track.

To set the Automation Mode for all tracks

= Hold the Option/Alt All and press an Automa-
tion Mode switch.

To set the Automation Mode for all selected tracks

= Hold the Option/Alt (All)+Shift (Add) and
press an Automation Mode switch.

To suspend automation for all tracks:
= Press the Suspend switch.

To return all tracks to their previous Automation
modes, press the Suspend switch again.



003 Top Panel Shortcuts

003 provides shortcuts for many common 003 tasks in Pro Tools mode.

Display Options

Display Options Shortcuts

Task

Shortcut

Display full name of a track in top LCD row
(Pan mode)

Hold Display and press Channel Select switch for a track

Display full name of insert parameter (Insert
View, Plug-In Edit mode)

Hold Display and press Channel Select switch for an
insert

Reset lower row of LCD display to show fader
values (Pan View), send gain levels (Send
View), and pan and send levels (Pan/Send
Channel View)

Command/Ctrl+Display

Track Shortcuts

Track Shortcuts

Task

Shortcut

Select or deselect contiguous tracks (Home
View or Pan View)

Hold Shift (Add) and press Channel Select switch for
each track

Select or deselect all tracks (Home View or Pan
View)

Hold Alt and press Channel Select switch for any track

Select or deselect noncontiguous tracks (Pan
View)

Hold Command/Ctrl and press Channel Select switch for
each track

Open track’s Track Name/Comments dialog
(Home View or Pan View)

Double-click track’s Channel Select switch

Scroll track types in New Track dialog (Bank,
Nudge, or Zoom mode)

Command/Ctrl+Up or Down Arrow key

Scroll track formats in New Track dialog (Bank,
Nudge, or Zoom mode)

Command/Ctrl+Left or Right Arrow key

Move to previous track in Track Name/Com-
ments dialog (Bank, Nudge, or Zoom mode)

Command/Ctrl+Up or Left Arrow key
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Track Shortcuts

Task

Shortcut

Move to next track in Track Name/Comments
dialog (Bank, Nudge, or Zoom mode)

Command/Ctrl+Down or Right Arrow key

Scroll Timebase formats in New Track dialog
(Bank, Nudge, or Zoom mode)

Command/ Ctrl+Ctrl/Win+Opt/Alt All+Up or Down Arrow
key

Add or Remove entries in New Track dialog
(Bank, Nudge, or Zoom mode)

Command/Ctrl+Shift (Add)+Up or Down Arrow key

Make track’s output inactive or active (Pan
View)

Hold Command/Ctrl+Ctrl/Win and press Channel Select
switch for a track

Mute or unmute send (Send View)

Hold Command/Ctrl and press Channel Select switch for
a track send

Make send output inactive or active (Pan View)

Hold Command/Ctrl+Ctrl/Win and press Channel Select
switch for a track send

Input Assign Mode Shortcuts

Input Assign Mode Shortcuts

Task

Shortcut

Enable Input Assign mode

Hold Shift and press Channel Select switch of a track for
two seconds

Display all input, output, send, or insert menus
(Assign mode)

Hold Command/Ctrl and press Channel Select switch for
a track

Remove an insert (Console or Channel Insert
View, and if applicable, EQ or Dynamics View)

Hold Default and press Channel Select switch for an
insert

Output Window Shortcuts

Output Window Shortcuts

Task

Shortcut

Open or close track Output window (Pan View)

Hold Ctrl/Win and press Channel Select switch for a
track

Open or close multiple track Output windows
(Pan View)

Hold Ctrl/Win+Shift (Add) and press Channel Select
switch for each track
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Output Window Shortcuts

Task Shortcut

Open or close send Output window (Send View) Hold Ctrl/Win and press Channel Select switch for a
track send

Open or close multiple send Output windows Hold Ctrl/Win+Shift (Add) and press Channel Select

(Pan View) switch for each track send

Plug-In Shortcuts

Plug-In Shortcuts

Task Shortcut

Open or close a plug-in window (Console or Hold Ctrl/Win and press Channel Select switch for a
Channel Insert View) plug-in

Inactivate or activate a plug-in (Console or Hold Command/Ctrl and press Channel Select switch for
Channel Insert View) a plug-in

Bypass or unbypass plug-in (Console or Chan- Hold Command/Ctrl and press Channel Select switch for
nel Insert View, and if applicable, EQ or Dynam- a track plug-in

ics View)

Navigation Shortcuts

Navigation Shortcuts

Task Shortcut

Scroll Edit window one pane at a time (Bank, Command/Ctrl+ Left or Right Arrow key
Nudge, or Zoom mode)

Editing Shortcuts
Editing Shortcuts
Task Shortcut
Extend cursor or selection (Bank or Nudge Shift (Add)+Up or Down Arrow key
mode)
Reset fader to is default setting Hold Default and press Channel Select switch for a track
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Editing Shortcuts

Task

Shortcut

Reset all faders or plug-in parameters to their
factory default settings (Plug-In Edit mode)

Hold Default+Opt/Alt All and press Channel Select
switch for a track or plug-in

Redo an edit (Edit > Redo in Pro Tools)

Command/ Ctrl+Shift (Add)+Undo

Memory Location Shortcuts

Memory Location Shortcuts

Task

Shortcut

Choose a Marker Memory Location

Hold Mem Loc switch and press Channel Select for a
Memory Location

Open or close the Marker Memory Location dia-
log

Shift+Mem Loc

Automation Shortcuts

Automation Shortcuts

Task

Shortcut

Set Automation mode for a track

Hold Automation switch (Write, Touch, Latch, Read, or
Off) and press Channel Select track

Set Automation mode for all tracks

Hold Option/Alt All and press Automation switch (Write,
Touch, Latch, Read, or Off)

Set Automation mode for all selected tracks

Hold Option/Alt All+Shift (Add) and press Automation
switch (Write, Touch, Latch, Read, or Off)
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Using MIDI Mode with 003

Overview of MIDI Mode

In MIDI mode, 003 can control hardware MIDI
devices and software other than Pro Tools. Each
of 003’s faders, rotary encoders, and 45 of its
switches and the footswitch can be custom pro-
grammed to send control data on any continu-
ous controller (0-127) and MIDI channel (1-16).
003 switches can also send MIDI Machine Con-
trol (MMC) transport control messages (RW, FF,
ST, PL, and RC).

Two banks (A and B), each with four presets
(1-4), are provided so that you can recall up to
eight unique MIDI maps. Each preset can save
custom maps of two pages of supported con-
trols. 003 provides the following default preset
maps:

e Standard MIDI Map (MIDI Map A and B,

preset 1)

e 003 Map (MIDI Map A and B, preset 2)
e Strike Map (MIDI Map A and B, preset 3)

¢ Uninitialized Preset (MIDI Map A and B,
preset 4)

MIDI mode can be used in different ways, de-
pending on which other 003 operating mode is
active when MIDI mode is enabled, as follows:

Pro Tools Mode Use MIDI mode to control a
ReWire application (such as Propellerhead’s Rea-
son), stand-alone software instrument, or exter-
nal MIDI device.

A ReWire-client applications (such as Reason)
on Windows will not recognize 003 as a
MIDI device (port) while Pro Tools is run-
ning. Consequently, to use a ReWire client’s
“learn” MIDI controller function, you must
quit Pro Tools, launch the ReWire-client ap-
plication as a stand-alone application, and
then “learn” 003 controllers. The next time
you launch the ReWire-client application
with Pro Tools, you can successfully use 003
MIDI mode to control the “learned” parame-
ters in the ReWire-client application.

Third-Party Software Mode Use MIDI mode to
control your third-party audio application (us-
ing a driver such as the Avid CoreAudio Driver
on Mac).

When using MIDI mode with a third-party ap-
plication, route the third-party application’s
output to ASIO or CoreAudio and make any
changes to the Pro Tools Playback Engine before
enabling MIDI mode.

Standby Mode Use MIDI mode to control an ex-
ternal MIDI device.
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Selecting MIDI Mode

To select MIDI mode, do one of the following:

= Press the unlit MIDI Map A switch for the
MIDI Map A presets (A1-4).

— Or —

= Press the unlit MIDI Map B switch for the
MIDI Map B presets (B1-4).

MIDI Map switches

When in MIDI mode, the switch LED lights for
the selected MIDI Map: A or B.

The last saved (or default) MIDI map is recalled.

To exit MIDI mode:
= Press the lit MIDI Map switch (A or B).
If you edited a MIDI Map preset without saving,

you are prompted to save your changes (see
“Saving MIDI Map Presets” on page 123).
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About Preset Pages

Each 003 MIDI Map preset includes two pages of
unique assignments for each mappable fader,
rotary encoder, and switch.

For example, the channel 1 fader can be as-
signed to continuous controller 21 on MIDI
channel 1 on page 1 and to continuous control-
ler 37 on MIDI channel 10 on page 2 of the same
preset. This lets you use the same controller for
two completely different mappings within the
same preset.

However, you will typically want to use the
same control for related functions (such as using
the faders to control volume on MIDI channels
1-8 on page 1 and on MIDI channels 9-16 on

page 2).

To switch between pages of a preset:

= In MIDI mode, press the Bank switch. The
Bank switch LED is lit when on page 2 and not
lit when on page 1 of a preset.

Bank switch



Recalling MIDI Map Presets

To recall a MIDI Map preset (A1-4 or B1-4) from
flash memory:

1 Press either the MIDI Map A switch or the
MIDI Map B switch.

2 Press MIDI Recall. The MIDI Recall switch LED
flashes.

R —

MIDI Recall switch

The LCD display for the first two channel strips
show the number and name of the current MIDI
Map preset.

The LCD display for channels 6-8 show three
MIDI mode commands: Recall, Save, and Can-
cel. The commands are selected by pressing the
corresponding switches in the Channel View
section.

MIDI Recall display

ch1 ch2 ch6 ch7 ch 8

Preset# | Name

num name || Recall Save Cancel

3 Scroll through the available presets using the
rotary encoder 1.

4 To select the displayed preset, select Recall by
pressing the Page Right switch.

5 To recall the selected preset from Flash mem-
ory, select Flash by pressing the Dynamics
switch.

6 Do one of the following:
¢ To confirm and load the preset, select OK
by pressing the Master Bypass switch (Mas-
ter Bypass).

— Or —

¢ To cancel without loading the preset, select
Cancel by pressing the ESC switch.

For information on editing preset MIDI
maps, see “Editing MIDI Map Presets” on
page 121.

For information on naming and saving pre-
sets, see “Naming MIDI Map Presets” on
page 123 and “Saving MIDI Map Presets”
on page 123.

To exit MIDI Recall mode:

= Press the flashing MIDI Recall switch. 003 ex-
its MIDI Recall mode and the switch LED stops
flashing.
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Mapping Controls

003 faders, rotary encoders, and switches can be
assigned, or mapped, to MIDI continuous con-
trollers (CC) and MIDI channels. As many as
eight presets (A1-4 and B1-4) can store unique,
custom MIDI maps, each with two pages of
unique MIDI assignments for each control.

Assignable Controls in MIDI Mode

Faders

Each fader can be mapped to No Assign or any
MIDI continuous controller (CC) and MIDI
channel. Minimum and maximum MIDI values,
as well as custom names, can be specified for
each fader.

Rotary Encoders

Each rotary encoder can be mapped to No As-
sign or any MIDI continuous controller (CC)
and MIDI channel. Minimum and maximum
MIDI values, as well as custom names, can be
specified for each rotary encoder.

Switches

Up to 45 switches and the footswitch on 003 can
be mapped to No Assign or any MIDI continu-
ous controller (CC) and MIDI channel. Switches
can also be set to MMC transport control mes-
sages (Rewind, Fast Forward, Stop, Play, and Re-
cord). Custom names can be specified for each
switch.

Switches can be set to Momentary or Latch
mode (see “Momentary or Latch Mode” on
page 122).
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The following switches are assignable controls:
¢ Channel Mute switches
¢ Channel Solo switches

¢ Channel View switches

Channel View switches are also used to navi-
gate, select, and save MIDI mode presets.

O T part Pt - - [ - [
- - e e e e

Figure 1. Channel View switches

e Console View switches

Console View selectors

e Record Arm switch

e Arrow keys

(IR

Arrow keys

e Transport controls

Transport controls are mapped to standard MIDI
Machine Control (MMC) messages (RW, FF, ST,
PL, and RC) by default, but can be re-assigned to
any CC number.

Transport controls

e Footswitch



The following controls are not assignable in
MIDI mode:

e Mic/DI Input controls

e Monitor section controls

e Miscellaneous controls

e Automation section switches

e Modifier section switches

Q Though the Mic/DI Input controls and the
Monitor section controls are not assignable
in MIDI mode, they continue to function for
audio independently of MIDI mode.

Editing MIDI Map Presets

This section provides instructions for editing
MIDI controller assignments (mapping) for 003
faders, rotary encoders, and switches.

Q Custom mappings can be saved as presets.
" Presets can be created, named, and saved
before editing controller mappings.

To enter MIDI Edit mode:

1 Select the MIDI Map you want to edit (see “Re-
calling MIDI Map Presets” on page 119).

2 Press the MIDI Edit switch.

MIDI Edit switch

The switch’s LED flashes, and the LCD display
shows parameters similar to the following tables
(which show default assignments for Fader 1 as
an example):

MIDI Edit display, channels 1-4 (Fader 1 example)

ch1 ch 2 ch3 ch 4
Select ctrl Chan cC
Faderl 1 7

¢ The currently selected control (Faderl by
default or the last edited control) is shown
in the lower row of channel 1.

e Channel 3 shows the assigned MIDI Chan-
nel in the lower row.

e Channel 4 shows the assigned CC value in
the lower row.

MIDI Edit display, channels 5-8 (Fader 1 example)

ch5 ch 6 ch?7 ch8
LoVal Hival Mode Name
0 127 Faderl

¢ The upper row shows the available param-
eter names for (MIDI) LoVal, HiVal, Mode,
and Name.

¢ The lower row shows the current value
(1-127) for LoVal, HiVal, Mode (for
switches only), and the current control
name (for example, Faderl).

To select a control for MIDI Mapping, do one of the
following:

= To scroll through the list of available controls,
turn the rotary encoder for channel 1.

— Or —

= Touch the fader or switch that you want to
edit.

A\ Rotary encoders can only be selected by
turning the rotary encoder for channel 1.
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To set the MIDI channel:

» Turn the rotary encoder for channel 3 (Chan)
until the channel you want is displayed (1-16).

To set the CC#:

» Turn the rotary encoder for channel 4 (CC#)
until the CC value you want is displayed
(0-127).

Any control can be set to no assignment (“No
Asgn”) by turning the encoder below 0.

For switches, turn the rotary encoder past 127 to
select MMC transport control messages: Re-
wind, Fast Forward, Stop, Play, and Record (RW,
FF, ST, PL, and RC).

To set the High and Low MIDI values (controller
range):

1 Turn the rotary encoder for channel S to set a
Minimum MIDI Value (0-127).

2 Turn the rotary encoder for channel 6 to set a
Maximum MIDI Value (0-127).

To name a control:
1 Select the control you want to name.

2 Turn the rotary encoder for channel 8 (Name).
This displays the Name parameters in the LCD.

3 Turn the rotary encoder for channel 2 to scroll
and select lower-case, upper-case, or numerics
for the first character of the custom name.

4 When the desired character is displayed, turn
the rotary encoder for channel 1 to move to the
next character. The cursor flashes for the se-
lected character.

5 Repeat steps 3—4 for the remaining characters
of the control name.
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6 When you are done, do one of the following:

e To confirm the new control name, select
OK by pressing the Master Bypass switch.

— Or —

¢ To cancel without renaming the control,
select Cancel by pressing the ESC switch.

To exit MIDI Edit mode:

= Press the flashing MIDI Edit switch. The MIDI
Edit switch LED stops flashing.

You must manually save changes to MIDI Map
presets. If you do not, your changes will be lost
when you recall a different MIDI Map preset or
power off 003. For information on saving pre-
sets, see “Saving MIDI Map Presets” on

page 123.

Momentary or Latch Mode

Switches can be set to Momentary or Latch
mode.

Momentary Mode The specified High MIDI
Value (HiVal) is transmitted when the switch is
pressed, and the specified Low MIDI Value
(LoVal) is transmitted when the switch is re-
leased.

Latch Mode The output of the switch toggles be-
tween the specified High and Low MIDI values
when pressed.

To program a switch for Momentary or Latch
mode:
1 Enter MIDI Edit mode.

2 Select the switch you want to edit.

3 Turn the rotary encoder for channel 7 (Mode)
to select Latch or Momnt (momentary).



Naming MIDI Map Presets

MIDI Map presets can have custom names of up
to 28 characters. This makes it easier to manage
multiple presets for different devices.

To name a MIDI Map preset:
1 Press the MIDI Map preset switch.

2 Select the MIDI Map preset you want to name.

3 Select the Preset Name by pressing the Dy-
namics switch.

4 Turn the rotary encoder for channel 2 to scroll
and select lower-case, upper-case, or numerics
for the first character of the custom name.

5 When the desired character is displayed, turn
the rotary encoder for channel 1 to move to the
next character (its cursor flashes).

6 Repeat steps 4-5 for the remaining characters
of the preset name.

7 When you are done, do one of the following:

¢ To confirm the new preset name, select OK
by pressing the Master Bypass switch.

— Or —

¢ To cancel without naming the preset, select
Cancel by pressing the ESC switch.

8 Save the MIDI Map preset.

Saving MIDI Map Presets

Presets are snapshots of MIDI mapping assign-
ments that can be saved and recalled. You can
store up to eight presets (A1-4 and B1-4) to save
custom CC mapping and MIDI channel assign-
ment for a variety of devices, with custom
names. Presets can be recalled at any time to
switch to a different MIDI mapping.

Every preset contains two pages: one active and
one inactive. When you save a preset, changes
made to either page are saved.

003 presets can be saved to flash memory to save
custom mapping of programmable controls,
custom names, and all other parameters associ-
ated with MIDI Map presets.

A\ Edited presets must be manually saved to
flash memory to be able to be recalled later.
003 warns you to save any changed presets
before you exit MIDI mode, but it does not
automatically save presets as you edit them.

To save presets:

1 Press the MIDI Recall switch. The MIDI Recall
switch LED flashes.

2 Do one of the following:

e Select Save by pressing the Master Bypass
switch. If a preset has been edited, the LCD
displays asterisks (**) before and after
“SAVE.”

¢ To cancel, select Cancel by pressing the ESC
switch.
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3 Do one of the following:
¢ To confirm and save the preset, select OK
by pressing the Master Bypass switch.
—or-
¢ To cancel without saving the preset, select
Cancel by pressing the ESC switch.

Factory Default

003 lets you reset any preset to its factory default
setting (see “Factory Presets” on page 124).

A Recalling the default preset overwrites the
preset stored in flash memory. To be able to
recall the preset currently stored in flash
memory, you must save it to a different pre-
set than the one you for which you want to
recall the default. For example, if you want
to recall the default preset for A1, save the
currently loaded preset to A4 first.

To reset a MIDI Map preset to its factory default
setting:
1 Enter MIDI mode.

2 Press the MIDI Recall switch. The MIDI Recall
switch LED flashes.

3 Select the MIDI Map preset you want to reset.

4 Select Recall by pressing the Page Right switch.

5 Select Default by pressing the flashing Insert
switch. The Insert switch lights solid.

6 Do one of the following:
e Select OK by pressing the Master Bypass
switch. The selected MIDI Map preset is
overwritten by its default preset.

¢ To cancel without overwriting flash mem-
ory and the selected preset with its factory

default preset, select Cancel by pressing the
ESC switch.

124 003 Family User Guide

Factory Presets

003 comes with factory presets saved in flash
memory. Presets A1-4 and B1-4 provide factory
preset MIDI Maps for the following:

Standard MIDI Map Use this preset for standard
MIDI controller mappings (for example, with a
third-party application). See Table 13 on

page 125.

003 Map Use this preset to control a ReWire cli-
ent (such as Reason). See Table 14 on page 131.

Strike Map Use this preset to control Avid’s
Strike plug-in. See Table 15 on page 137.

Uninitialized Preset Use this preset as a starting
point for your own custom mappings. All map-
pable 003 controls are unassigned.



Standard MIDI Map Preset

Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
PAGE 1

EQ1 1 122 Latch Local 0-127
Dynmcs1 1 123 Latch AllOff 0-127
Insertl 1 124 Latch OmniOn 0-127
PanSnd1 1 125 Latch OmniOff 0-127
Page <1 1 126 Latch MonoOn 0-127
Page >1 1 127 Latch PolyOn 0-127
MstByp1 1 NoAsgn Latch MstByp N/A
Escl 1 NoAsgn Latch Esc N/A
Slct 1 1 NoAsgn Latch Slct 1 N/A
Slct 2 1 NoAsgn Latch Slict 2 N/A
Slct 3 1 NoAsgn Latch Slct 3 N/A
Sict 4 1 NoAsgn Latch Sict 4 N/A
Slct 5 1 NoAsgn Latch Slct 5 N/A
Sict 6 1 NoAsgn Latch Sict 6 N/A
Slct 7 1 NoAsgn Latch Slct 7 N/A
Sict 8 1 NoAsgn Latch Sict 8 N/A
Solo 1 1 15 Latch Solo 1 0-127
Solo 2 2 15 Latch Solo 2 0-127
Solo 3 3 15 Latch Solo 3 0-127
Solo 4 4 15 Latch Solo 4 0-127
Solo 5 5 15 Latch Solo 5 0-127
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Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
Solo 6 6 15 Latch Solo 6 0-127
Solo 7 7 15 Latch Solo 7 0-127
Solo 8 8 15 Latch Solo 8 0-127
Mute 1 1 14 Latch Mute 1 0-127
Mute 2 2 14 Latch Mute 2 0-127
Mute 3 3 14 Latch Mute 3 0-127
Mute 4 4 14 Latch Mute 4 0-127
Mute 5 5 14 Latch Mute 5 0-127
Mute 6 6 14 Latch Mute 6 0-127
Mute 7 7 14 Latch Mute 7 0-127
Mute 8 8 14 Latch Mute 8 0-127
Encdri 1 10 N/A Encdri 0-127
Encdr2 2 10 N/A Encdr2 0-127
Encdr3 3 10 N/A Encdr3 0-127
Encdr4 4 10 N/A Encdr4 0-127
Encdrb 5 10 N/A Encdrb 0-127
Encdr6 6 10 N/A Encdr6 0-127
Encdr7 7 10 N/A Encdr7 0-127
Encdr8 8 10 N/A Encdr8 0-127
Faderl 1 7 N/A Faderl 0-127
Fader2 2 7 N/A Fader2 0-127
Fader3 3 7 N/A Fader3 0-127
Fader4 4 7 N/A Fader4 0-127
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Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
Faderb 5 7 N/A Faderb 0-127
Fader6 6 7 N/A Fader6 0-127
Fader7 7 7 N/A Fader7 0-127
Fader8 8 7 N/A Fader8 0-127
REW1 — MMC RW Moment REW N/A
FF1 — MMC FF Moment FF N/A
STOP1 — MMC ST Moment STOP N/A
PLAY1 — MMC PL Moment PLAY N/A
RECORD1 — MMC RC Moment RECORD N/A
RTZ1 — NoAsgn Moment RTZ N/A
Nav Up1l 1 102 Moment Nav Up 0-127
Nav Down1l 1 103 Moment Nav Dn 0-127
Nav Leftl 1 104 Moment Nav L 0-127
Nav Rightl 1 105 Moment Nav R 0-127
Rec Arm1 1 106 Latch RecArm 0-127
PanMd1 1 107 Latch Pans 0-127
SndMd1 1 108 Latch Sends 0-127
InsMd1 1 109 Latch Insert 0-127
A/F1 1 110 Latch A/F 0-127
B/G1 1 111 Latch B/G 0-127
C/H1 1 112 Latch C/H 0-127
D/I1 1 113 Latch D/I 0-127
E/J1 1 114 Latch F/J 0-127
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Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
Footswitch1 8 11 Moment Footsw 0-127
PAGE 2

EQ2 1 122 Latch Local 0-127
Dynmcs2 1 123 Latch AllOff 0-127
Insert2 1 124 Latch OmniOn 0-127
PanSnd2 1 125 Latch OmniOff 0-127
Page <2 1 126 Latch MonoOn 0-127
Page >2 1 127 Latch PolyOn 0-127
MstByp2 1 NoAsgn Latch MstByp N/A
Esc2 1 NoAsgn Latch Esc N/A
Slct 9 1 NoAsgn Latch Slct 9 N/A
Slct10 1 NoAsgn Latch Sict 10 N/A
Slct11 1 NoAsgn Latch Slct 11 N/A
Slct12 1 NoAsgn Latch Slct 12 N/A
Slct13 1 NoAsgn Latch Slct 13 N/A
Sict14 1 NoAsgn Latch Sict 14 N/A
Slctl5 1 NoAsgn Latch Slct 15 N/A
Sict16 1 NoAsgn Latch Sict 16 N/A
Solo 9 1 15 Latch Solo 9 0-127
Solo10 2 15 Latch Solo 10 0-127
Solol1l 3 15 Latch Solo 11 0-127
Solo12 4 15 Latch Solo 12 0-127
Solo13 5 15 Latch Solo 13 0-127
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Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
Solo14 6 15 Latch Solo 14 0-127
Solo15 7 15 Latch Solo 15 0-127
Solo16 8 15 Latch Solo 16 0-127
Mute 9 1 14 Latch Mute 9 0-127
Mute10 2 14 Latch Mute 10 0-127
Mute11 3 14 Latch Mute 11 0-127
Mute12 4 14 Latch Mute 12 0-127
Mutel13 5 14 Latch Mute 13 0-127
Mutel14 6 14 Latch Mute 14 0-127
Mutel15 7 14 Latch Mute 15 0-127
Mute16 8 14 Latch Mute 16 0-127
Encdr9 1 10 N/A Encdr9 0-127
Encdr10 2 10 N/A Encdr10 0-127
Encdrll 3 10 N/A Encdrll 0-127
Encdr12 4 10 N/A Encdr12 0-127
Encdrl3 5 10 N/A Encdrl3 0-127
Encdri4 6 10 N/A Encdri4 0-127
Encdrl5 7 10 N/A Encdrl5 0-127
Encdr16 8 10 N/A Encdrl6 0-127
Fader9 1 7 N/A Fader9 0-127
Fader10 2 7 N/A Fader10 0-127
Fader1l 3 7 N/A Fader11l 0-127
Fader12 4 7 N/A Fader12 0-127
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Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
Fader13 5 7 N/A Fader13 0-127
Fader14 6 7 N/A Fader14 0-127
Fader15 7 7 N/A Fader15 0-127
Fader16 8 7 N/A Fader16 0-127
REW2 — MMC RW Moment REW N/A
FF2 — MMC FF Moment FF N/A
STOP2 — MMC ST Moment STOP N/A
PLAY2 — MMC PL Moment PLAY N/A
RECORD2 — MMC RC Moment RECORD N/A
RTZ2 — NoAsgn Moment RTZ N/A
Nav Up2 1 102 Moment Nav Up 0-127
Nav Down2 1 103 Moment Nav Dn 0-127
Nav Left2 1 104 Moment Nav L 0-127
Nav Right2 1 105 Moment Nav R 0-127
Rec Arm2 1 106 Latch RecArm 0-127
PanMd2 1 107 Latch Pans 0-127
SndMd2 1 108 Latch Sends 0-127
InsMd2 1 109 Latch Insert 0-127
A/F2 1 110 Latch A/F 0-127
B/G2 1 111 Latch B/G 0-127
C/H2 1 112 Latch C/H 0-127
D/12 1 113 Latch D/I 0-127
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Table 13. Default Standard MIDI Map, presets A1 and B1

Controller MIDI Channel CC# Mode Name LoVal/Hival
E/J2 1 114 Latch F/J 0-127
Footswitch2 8 11 Moment Footsw 0-127

003 Map Preset

Table 14. Default 003 Map, presets A2 and B2
Controller MIDI Channel CC# Mode Name LoVal/Hival
PAGE 1
EQ1 1 122 Latch Local 0-127
Dynmcs1 1 123 Latch AllOff 0-127
Insertl 1 124 Latch OmniOn 0-127
PanSnd1 1 125 Latch OmnioOff 0-127
Page <1 1 126 Latch MonoOn 0-127
Page >1 1 127 Latch PolyOn 0-127
MstByp1 1 118 Latch custom 0-127
Escl 1 119 Latch custom 0-127
Slet 1 1 0 Latch Slet 1 0-127
Slct 2 1 1 Latch Slct 2 0-127
Slct 3 1 2 Latch Slct 3 0-127
Slct 4 1 3 Latch Slct 4 0-127
Slct 5 1 4 Latch Slct 5 0-127
Slct 6 1 5 Latch Slct 6 0-127
Slet 7 1 6 Latch Slet 7 0-127
Slct 8 1 NoAsgn N/A Slct 8 N/A
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Table 14. Default 003 Map, presets A2 and B2

Controller MIDI Channel CC# Mode Name LoVal/Hival
Solo 1 1 62 Latch Solo 1 0-127
Solo 2 1 63 Latch Solo 2 0-127
Solo 3 1 64 Latch Solo 3 0-127
Solo 4 1 65 Latch Solo 4 0-127
Solo 5 1 66 Latch Solo 5 0-127
Solo 6 1 67 Latch Solo 6 0-127
Solo 7 1 68 Latch Solo 7 0-127
Solo 8 1 69 Latch Solo 8 0-127
Mute 1 1 78 Latch Mute 1 0-127
Mute 2 1 79 Latch Mute 2 0-127
Mute 3 1 80 Latch Mute 3 0-127
Mute 4 1 81 Latch Mute 4 0-127
Mute 5 1 82 Latch Mute 5 0-127
Mute 6 1 83 Latch Mute 6 0-127
Mute 7 1 84 Latch Mute 7 0-127
Mute 8 1 85 Latch Mute 8 0-127
Encdrl 1 46 N/A Encdrl 0-127
Encdr2 1 a7 N/A Encdr2 0-127
Encdr3 1 48 N/A Encdr3 0-127
Encdr4 1 49 N/A Encdr4 0-127
Encdrb 1 50 N/A Encdrb 0-127
Encdré 1 51 N/A Encdré 0-127
Encdr7 1 52 N/A Encdr7 0-127
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Table 14. Default 003 Map, presets A2 and B2

Controller MIDI Channel CC# Mode Name LoVal/Hival
Encdr8 1 53 N/A Encdr8 0-127
Faderl 1 16 N/A Faderl 0-127
Fader2 1 17 N/A Fader2 0-127
Fader3 1 18 N/A Fader3 0-127
Fader4 1 19 N/A Fader4 0-127
Fader5 1 20 N/A Fader5 0-127
Fader6 1 21 N/A Fader6 0-127
Fader7 1 22 N/A Fader7 0-127
Fader8 1 23 N/A Fader8 0-127
REW1 — MMC RW Moment REW N/A
FF1 — MMC FF Moment FF N/A
STOP1 — MMC ST Moment STOP N/A
PLAY1 — MMC PL Moment PLAY N/A
RECORD1 — MMC RC Moment RECORD N/A
RTZ1 — 115 Moment RTZ N/A
Nav Upl 1 102 Moment Nav Up 0-127
Nav Down1 1 103 Moment Nav Dn 0-127
Nav Leftl 1 104 Moment Nav L 0-127
Nav Rightl 1 105 Moment Nav R 0-127
Rec Arm1 1 106 Latch RecArm 0-127
PanMd1 1 107 Latch Pans 0-127
SndMd1 1 108 Latch Sends 0-127
InsMd1 1 109 Latch Insert 0-127
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Table 14. Default 003 Map, presets A2 and B2

Controller MIDI Channel CC# Mode Name LoVal/Hival
A/F1 1 110 Latch A/F 0-127
B/G1 1 111 Latch B/G 0-127
C/H1 1 112 Latch C/H 0-127
D/I1 1 113 Latch D/I 0-127
E/J1 1 114 Latch F/J 0-127
Footswitch1 1 94 Moment Footsw 0-127
PAGE 2

EQ2 1 122 Latch Local 0-127
Dynmcs2 1 123 Latch AllOff 0-127
Insert2 1 124 Latch OmniOn 0-127
PanSnd2 1 125 Latch OmniOff 0-127
Page <2 1 126 Latch MonoOn 0-127
Page >2 1 127 Latch PolyOn 0-127
MstByp2 1 NoAsgn Latch MstByp 0-127
Esc2 1 NoAsgn Latch Esc 0-127
Sict 9 1 NoAsgn Latch Slct 9 0-127
Slct10 1 NoAsgn Latch Slct 10 0-127
Slct11 1 NoAsgn Latch Slct 11 0-127
Slct12 1 NoAsgn Latch Slct 12 0-127
Slct13 1 NoAsgn Latch Slct 13 0-127
Sict14 1 NoAsgn Latch Sict 14 0-127
Slct15 1 NoAsgn Latch Sict 15 0-127
Slct16 1 NoAsgn Latch Slct 16 0-127
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Table 14. Default 003 Map, presets A2 and B2

Controller MIDI Channel CC# Mode Name LoVal/Hival
Solo 9 1 15 Latch Solo 9 0-127
Solo10 2 15 Latch Solo 10 0-127
Solol1l 3 15 Latch Solo 11 0-127
Solo12 4 15 Latch Solo 12 0-127
Solo13 5 15 Latch Solo 13 0-127
Solo14 6 15 Latch Solo 14 0-127
Solo15 7 15 Latch Solo 15 0-127
Solo16 8 15 Latch Solo 16 0-127
Mute 9 1 14 Latch Mute 9 0-127
Mute10 2 14 Latch Mute 10 0-127
Mutel1 3 14 Latch Mute 11 0-127
Mute12 4 14 Latch Mute 12 0-127
Mute13 5 14 Latch Mute 13 0-127
Mute14 6 14 Latch Mute 14 0-127
Mutel5 7 14 Latch Mute 15 0-127
Mute16 8 14 Latch Mute 16 0-127
Encdr9 1 10 N/A Encdr9 0-127
Encdr10 2 10 N/A Encdr10 0-127
Encdril 3 10 N/A Encdril 0-127
Encdr12 4 10 N/A Encdr12 0-127
Encdrl3 5 10 N/A Encdrl3 0-127
Encdrl4 6 10 N/A Encdrl4 0-127
Encdrl5 7 10 N/A Encdrl5 0-127
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Table 14. Default 003 Map, presets A2 and B2

Controller MIDI Channel CC# Mode Name LoVal/Hival
Encdr16 8 10 N/A Encdrl6 0-127
Fader9 1 7 N/A Fader9 0-127
Fader10 2 7 N/A Fader10 0-127
Faderll 3 7 N/A Faderl1l 0-127
Fader12 4 7 N/A Fader12 0-127
Faderl13 5 7 N/A Fader13 0-127
Fader14 6 7 N/A Fader14 0-127
Fader15 7 7 N/A Fader15 0-127
Fader16 8 7 N/A Fader16 0-127
REW2 — MMC RW Moment REW N/A
FF2 — MMC FF Moment FF N/A
STOP2 — MMC ST Moment STOP N/A
PLAY2 — MMC PL Moment PLAY N/A
RECORD2 — MMC RC Moment RECORD N/A
RTZ2 1 NoAsgn Moment RTZ N/A
Nav Up2 1 102 Moment Nav Up 0-127
Nav Down2 1 103 Moment Nav Dn 0-127
Nav Left2 1 104 Moment Nav L 0-127
Nav Right2 1 105 Moment Nav R 0-127
Rec Arm2 1 106 Latch RecArm 0-127
PanMd2 1 107 Latch Pans 0-127
SndMd2 1 108 Latch Sends 0-127
InsMd2 1 109 Latch Insert 0-127
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Table 14. Default 003 Map, presets A2 and B2

Controller MIDI Channel CC# Mode Name LoVal/Hival
A/F2 1 110 Latch A/F 0-127
B/G2 1 111 Latch B/G 0-127
C/H2 1 112 Latch C/H 0-127
D/12 1 113 Latch D/I 0-127
E/J2 1 114 Latch F/J 0-127
Footswitch2 8 11 Moment Footsw 0-127

Strike Map Preset

Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
PAGE 1

EQ1 2 80 Latch MstrEQ 0-127
Dynmcs1l 2 81 Latch MstrDyn 0-127
Insertl 2 82 Latch Jam 0-127
PanSnd1 2 83 Latch Surrnd 0-127
Page <1 2 100 Moment Scrol< 0-127
Page >1 2 101 Moment Scrol> 0-127
MstByp1 2 79 Latch MstFdr 0-127
Escl 2 64 Latch Latch 0-127
Slct 1 2 20 Latch Ins 1 0-127
Slct 2 2 21 Latch Ins 2 0-127
Slct 3 2 22 Latch Ins 3 0-127
Slct 4 2 23 Latch Ins 4 0-127
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Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
Slct 5 2 24 Latch Ins 5 0-127
Slct 6 2 25 Latch Ins 6 0-127
Slet 7 2 26 Latch Ins 7 0-127
Slct 8 2 27 Latch Ins 8 0-127
Solo 1 2 48 Latch Solo 1 0-127
Solo 2 2 49 Latch Solo 2 0-127
Solo 3 2 50 Latch Solo 3 0-127
Solo 4 2 51 Latch Solo 4 0-127
Solo 5 2 52 Latch Solo 5 0-127
Solo 6 2 53 Latch Solo 6 0-127
Solo 7 2 54 Latch Solo 7 0-127
Solo 8 2 55 Latch Solo 8 0-127
Mute 1 2 63 Latch Mute 1 0-127
Mute 2 2 85 Latch Mute 2 0-127
Mute 3 2 86 Latch Mute 3 0-127
Mute 4 2 87 Latch Mute 4 0-127
Mute 5 2 88 Latch Mute 5 0-127
Mute 6 2 89 Latch Mute 6 0-127
Mute 7 2 90 Latch Mute 7 0-127
Mute 8 2 91 Latch Mute 8 0-127
Encdrl 2 110 N/A Pan 1 0-127
Encdr2 2 111 N/A Pan 2 0-127
Encdr3 2 112 N/A Pan 3 0-127
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Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
Encdr4 2 113 N/A Pan 4 0-127
Encdrb 2 114 N/A Pan 5 0-127
Encdr6 2 115 N/A Pan 6 0-127
Encdr7 2 116 N/A Pan 7 0-127
Encdr8 2 117 N/A Pan 8 0-127
Faderl 2 74 N/A Vol 1 0-127
Fader2 2 71 N/A Vol 2 0-127
Fader3 2 91 N/A Vol 3 0-127
Fader4 2 93 N/A Vol 4 0-127
Fader5 2 73 N/A Vol 5 0-127
Fader6 2 72 N/A Vol 6 0-127
Fader7 2 5 N/A Vol 7 0-127
Fader8 2 84 N/A Vol 8 0-127
REW1 — MMC RW Moment REW N/A
FF1 — MMC FF Moment FF N/A
STOP1 — MMC ST Moment STOP N/A
PLAY1 — MMC PL Moment PLAY N/A
RECORD1 — MMC RC Moment RECORD N/A
RTZ1 — NoAsgn Moment NoAsgn N/A
Nav Upl 2 NoAsgn Latch NoAsgn N/A
Nav Down1l 2 NoAsgn Latch NoAsgn N/A
Nav Leftl 2 NoAsgn Latch NoAsgn N/A
Nav Rightl 2 NoAsgn Latch NoAsgn N/A
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Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
Rec Arm1 2 NoAsgn Latch NoAsgn N/A
PanMd1 2 NoAsgn Latch NoAsgn N/A
SndMd1 2 NoAsgn Latch NoAsgn N/A
InsMd1 2 NoAsgn Latch NoAsgn N/A
A/FL 2 NoAsgn Latch NoAsgn N/A
B/G1 2 NoAsgn Latch NoAsgn N/A
C/H1 2 NoAsgn Latch NoAsgn N/A
D/11 2 NoAsgn Latch NoAsgn N/A
E/J1 2 NoAsgn Latch NoAsgn N/A
Footswitch1 2 94 Moment Footsw 0-127
PAGE 2

EQ2 2 80 Latch MstrEQ 0-127
Dynmcs2 2 81 Latch MstDyn 0-127
Insert2 2 82 Latch Jam 0-127
PanSnd2 2 83 Latch Surrnd 0-127
Page <2 2 100 Moment Scrol< 0-127
Page >2 2 101 Moment Scrol> 0-127
MstByp2 2 79 Latch MstFdr 0-127
Esc2 2 64 Latch Latch 0-127
Slct 9 2 28 Latch Ins 9 0-127
Slct10 2 29 Latch Ins 10 0-127
Slet11 2 30 Latch Ins 11 0-127
Slct12 2 31 Latch Ins 12 0-127
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Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
Slct13 2 35 Latch Ins OH 0-127
Slct14 2 41 Latch Ins Rm 0-127
Slct15 2 46 Latch Ins TB 0-127
Slct16 2 47 Latch Ins Ms 0-127
Solo 9 2 56 Latch Solo 9 0-127
Solo10 2 57 Latch Solo10 0-127
Solol1l 2 58 Latch Solol1l 0-127
Solo12 2 59 Latch Solo12 0-127
Solo13 2 60 Latch SoloOH 0-127
Solo14 2 61 Latch SoloRm 0-127
Solo15 2 62 Latch SoloTB 0-127
Solol16 2 NoAsgn Latch NoAsn N/A
Mute 9 2 103 Latch Mute 9 0-127
Mute10 2 104 Latch Mute10 0-127
Mute11 2 105 Latch Mute11 0-127
Mute12 2 106 Latch Mute12 0-127
Mutel3 2 107 Latch MuteOH 0-127
Mute14 2 108 Latch MuteRm 0-127
Mute15 2 109 Latch MuteTB 0-127
Mutel6 2 NoAssign Latch NoAsn N/A
Encdr9 2 118 N/A Pan 9 0-127
Encdr10 2 119 N/A Pan 10 0-127
Encdril 2 98 N/A Pan 11 0-127
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Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
Encdr12 2 99 N/A Pan 12 0-127
Encdrl3 2 9 N/A OH Wid 0-127
Encdr14 2 14 N/A Rm Wid 0-127
Encdrl5 2 15 N/A TB Drv 0-127
Encdr16 2 75 N/A ClsMic 0-127
Fader9 2 24 N/A Vol 9 0-127
Fader10 2 25 N/A Vol 10 0-127
Faderll 2 26 N/A Vol 11 0-127
Fader12 2 27 N/A Vol 12 0-127
Faderl13 2 76 N/A Overhd 0-127
Fader14 2 92 N/A Room 0-127
Fader15 2 95 N/A TkBack 0-127
Fader16 2 7 N/A Master 0-127
REW2 — MMC RW Moment REW N/A
FF2 — MMC FF Moment FF N/A
STOP2 — MMC ST Moment STOP N/A
PLAY2 — MMC PL Moment PLAY N/A
RECORD2 — MMC RC Moment RECORD N/A
RTZ2 2 NoAsgn Moment NoAsn N/A
Nav Up2 2 NoAsgn Latch NoAsn N/A
Nav Down2 2 NoAsgn Latch NoAsn N/A
Nav Left2 2 NoAsgn Latch NoAsn N/A
Nav Right2 2 NoAsgn Latch NoAsn N/A
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Table 15. Default Strike Map, presets A3 and B3

Controller MIDI Channel CC# Mode Name LoVal/Hival
Rec Arm2 2 NoAsgn Latch NoAsn N/A
PanMd2 2 NoAsgn Latch NoAsn N/A
SndMd2 2 NoAsgn Latch NoAsn N/A
InsMd2 2 NoAsgn Latch NoAsn N/A
A/F2 2 NoAsgn Latch NoAsn N/A
B/G2 2 NoAsgn Latch NoAsn N/A
C/H2 2 NoAsgn Latch NoAsn N/A
D/12 2 NoAsgn Latch NoAsn N/A
E/J2 2 NoAsgn Latch NoAsn N/A
Footswitch2 2 94 Moment Footsw N/A
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Utility Mode (003 Only)

003 is in this mode when the Utility switch is
enabled (flashing). In Utility mode, you can run
pre-programmed diagnostic tests of the 003
unit. The Utility switch is unavailable in

Pro Tools mode.

Utility functions include the following:
¢ Software and firmware version display
e Tests for the LCD display, LEDs, switches,
rotary encoders, faders, MIDI, and audio.

e Return MIDI Maps to factory default set-
tings. See Chapter 12, “Using MIDI Mode
with 003.”

A\ Utility mode is not available in Pro Tools
mode. Pro Tools must be closed to enable
Utility mode.

Accessing Utility Mode

To enter Utility mode:

1 If Pro Tools is running, choose Pro Tools > Quit
(Mac) or File > Exit (Windows).

2 Press the Utility switch.
The Utility switch flashes when it is enabled.

The LCD shows the top level Utility functions
across the lower row: Version and Test. The cor-
responding Channel View switches flash for
each available Utility option.

Navigating Utility Mode

When running a Utility mode test, you can re-
turn to the previous Utility page or exit the test
at anytime.

To return to the previous Utility page:

= Press the flashing Display Mode switch.

To exit a test:

= Press the flashing ESC switch or Display Mode
switch.

Exiting Utility Mode

To exit Utility mode:

1 If a test is running, press ESC or Display Mode
to exit the test.

2 Press the flashing Utility mode switch.
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Viewing Firmware Version
Data

This Utility function lets you check the current
firmware version and other statistics useful
when upgrading, or when contacting technical
support.

To display firmware version data:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select Version by pressing the flashing EQ
switch.

The LCD shows version information about vari-
ous components of the unit.

3 To exit and return to the previous Utility
mode display, press the flashing Display Mode
switch.

LCD Display Test

Use this test to assess the performance of the
LCD.

To test the LCD:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Select the LCD test by pressing the flashing
Dynamics switch.

The 003 automatically scrolls all of its character
sets across the LCD display.
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4 To stop scrolling and quickly tell if any area of
the display is damaged, press and hold any
switch except for the Display Mode switch.

5 Do one of the following:
¢ To return to the previous Utility page, press
the flashing Display Mode switch.

¢ To exit the test at anytime, press the flash-
ing ESC switch or Display Mode switch.

LED Tests

Use this test to display all LEDs simultaneously
or cycle through the LEDs.

To test LEDs:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Select the LED menu by pressing the flashing
Insert switch.
4 Do one of the following
e To display all LEDs, press the flashing Dy-
namics switch.
¢ To cycle through all the LEDs, press the

flashing Insert switch.

5 To exit the test at anytime, press any switch.



Switch Test

Use this test to evaluate the performance of
switches.

To test switches:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Select the Switch test display by pressing the
flashing Pan/Send switch.

4 Press any top panel switch to test it. The LCD
shows the name, region and number for each
switch as you test it.

5 To exit the test at anytime, press the Display
Mode switch.

Encoder Test

Use this test to evaulate the performance of the
rotary encoders or the Jog/Shuttle wheel.

To test the encoders:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Enter the Encoder test by pressing the flashing
Page Left switch.

4 Rotate any encoder (or the Jog/Shuttle wheel)
to test it. Encoder value is displayed in the LCD
while testing.

5 To exit the test at anytime, press the Display
Mode switch.

Fader Tests

Utility mode provides tests for fader and group
performance. You can use these routines to trou-
bleshoot the mechanical elements of the faders.

Automated Fader Tests

These automated fader tests check fader perfor-
mance. You can use these routines to trouble-
shoot the mechanical elements of the faders.
To test fader resolution:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Select the Fader menu by pressing the flashing
Page Right switch.

4 Select one of the basic automated fader tests:
Triang, Sine, or Step.

A\ Do not touch the faders during a Fader test.

The faders will automatically move in a triangu-
lar, sine, or step pattern, as selected.

5 To exit the test at anytime, press any switch.
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Fader Group Test

To test fader group resolution:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Select the Fader menu by pressing the flashing
Page Right switch.

4 Enter the Group test by select the flashing
Page Left switch.

5 One by one, touch and move each fader. The
other seven faders follow, and the LCD shows
the resolution for each fader as they move
through their range so you can compare fader
performance as both a group master and slave.

6 To exit the test at anytime, press the flashing
Display Mode switch.

Touch Test

This test lets you test the touch sensitivity of
each fader. The LCD display shows when a fader
is touched and what frequency the fader is cur-
rently recognizing. The fader frequency value is
updated in real time.

To test the touch sensitivity of the faders:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Select the Fader menu by pressing the flashing
Page Right switch.
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4 Enter the Touch test by select the flashing
Page Right switch.

5 One by one, touch and move each fader. The
LCD shows the resolution for each fader as they
move through their range.

6 To exit the test at anytime, press the flashing
Display Mode switch.

Vegas Mode

Vegas Mode

Vegas mode randomly lights every switch, me-
ter, and display on the unit, and runs the faders
in sine wave mode.

To enter Vegas mode:

1 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

2 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

3 Start “Vegas” mode by pressing the flashing
Page Right switch.

4 To exit the test at anytime, press any switch.



MIDI Test

003 includes a MIDI loopback test to check
MIDI input and output connections. A standard
5-pin MIDI cable is required.

To test MIDI input and output connections:

1 On the back of the 003, connect a standard 5-
pin MIDI cable from the MIDI In port to the
MIDI Out 1.

2 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

3 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

4 Press the ESC switch to toggle to the second
page of Utility tests.

5 Start the “MIDI” test by pressing the flashing
Dynamics switch.

6 Press the EQ switch to begin testing MIDI Out
1.

If data is received on the MIDI jack, the LCD
shows “Pass.” If DATA is not received, the LCD
shows “Fail.”

7 Connect a standard 5-pin MIDI cable from the
MIDI In port to the MIDI Out 2 and repeat the
test to check MIDI Out 2.

8 When finished, press the flashing Display
switch.

Audio Test

003 includes audio loopback tests (see “Routing
Path for Audio Tests” on page 150) to check var-
ious audio connections. For each test, a valid au-
dio source and external sound system must be
set up for the specific inputs or outputs being
tested. See “Making Studio Connections” on
page 77 for information on connecting devices.

Cables corresponding to each connector type
are required. See “003 and 003 Rack Back Pan-
els” on page 61 for cabling requirements for
each connector.

When testing a digital input, the digital source
must be connected to one of the 003 digital out-
puts and the source must be configured to clock
to the 003 digital output.

All tests run at 44.1 kHz.
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Routing Path for Audio Tests

Audio Test

Routing Path

Intl

Internal loopback of all analog and
digital I/0 channels (Analog Input 1
to Analog Output 1, Analog Input 2
to Analog Output 2, and so on).

Sgnl

003 generates a 440 Hz sine wave
on all analog and digital outputs.
Level is adjustable from O dB to
—42 dB with the rotary encoder in
the second fader strip.

Spin 1/2

S/PDIF (RCA) Inputs to Analog
Outputs 1-2.

Spin 3/4

S/PDIF (RCA) Inputs to Analog
Outputs 3—4.

Spin 5/6

S/PDIF (RCA) Inputs to Analog
Outputs 5-6.

Spin 7/8

S/PDIF (RCA) Inputs to Analog
Outputs 7-8.

Spin All

S/PDIF (RCA) Inputs to all Analog
Output pairs.

SpOt 1/2

Analog Inputs 1-2 to S/PDIF (RCA)
Outputs.

SpOt 3/4

Analog Inputs 3-4 to S/PDIF (RCA)
Outputs.

SpOt 5/6

Analog Inputs 5-6 to S/PDIF (RCA)
Outputs.

SpOt 7/8

Analog Inputs 7-8 to S/PDIF (RCA)
Outputs.

SpOt Al

All Analog input pairs to S/PDIF
(RCA) Outputs.

SpAg

Simultaneous routing of S/PDIF
(RCA) Inputs to Analog Outputs 1-2
and Analog Inputs 1-2 to S/PDIF
(RCA) Outputs.

Adat

Simultaneous routing of ADAT
Optical Inputs to Analog Outputs
1-8 and Analog Inputs 1-8 to ADAT
Optical Outputs.
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Testing Audio Connections

To test audio connections:

1 Make the necessary connection for the input
and output you are testing. See “Routing Path
for Audio Tests” on page 150.

2 Enter Utility mode. If the Utility switch is not
enabled (flashing), press it.

3 Select the Test menu by pressing the flashing
Insert switch.

The LCD shows the first page of Utility tests.

4 Press the ESC switch to toggle to the second
page of Utility tests.

5 Enter “Audio” test mode by pressing the flash-
ing Inserts (Channel View) switch.

6 Begin an Audio test by pressing the Channel
View switch that corresponds to the test you
want to run.

7 For the S/PDIF In and Out tests, press the Dy-
namics or Insert switch repeated times to toggle
through the different test, or to test all of the
S/PDIF routing paths.

8 When finished, press the flashing Display
switch.



appendix b

Configuring AMS (Mac 0S X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI in-
terface as generic ports. With Mac OS X, you use
Apple’s Audio MIDI Setup (AMS) utility to iden-
tify external MIDI devices connected to your
MIDI interface and configure your MIDI studio
for use with Pro Tools.

To configure your MIDI studio in AMS:

1 Do one of the following:
¢ Launch Audio MIDI Setup (located in Ap-
plications/Utilities). Click Window > Show
Window to view MIDI studio.

e [n Pro Tools, choose Setup > MIDI > MIDI

Studio. In Audio MIDI Setup, click Window >
Show MIDI Window.

2 Click the MIDI Devices tab. AMS scans your
system for connected MIDI interfaces. If your
MIDI interface is properly connected, it appears

in the window with each of its ports numbered.

ana Autic MID! Setup
Acittay Devices | WD Dwices |
. - 3
—— SR o - f.ﬂ 7
Rk i Sescan D Ten Senep
Digi 001
MITEE

] e

[4 : ]

Audio MIDI Setup (MIDI Devices tab)

3 For any MIDI devices connected to the MIDI
interface, click Add Device. A new external device
icon with the default MIDI keyboard image will
appear.

4 Drag the new device icon to a convenient lo-
cation within the window.

Appendix B: Configuring AMS (Mac OS X Only)
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5 Connect the MIDI device to the MIDI inter-
face by clicking the arrow for the appropriate
output port of the device and dragging a con-
nection or “cable” to the input arrow of the cor-
responding port of the MIDI interface.

ann Audia MID Setisp
Audio Devices -~ MIDE Devices |

Mol &8 £ W oo

Vi b B Contiguration At Devr M Drite  Show e B Test Satep

—— | ush

Making MIDI input and output connections

6 Click the arrow for the appropriate input port
of the device and drag a cable to the output ar-

row of the corresponding port of the MIDI inter-
face.

Q To remove a connection, select the cable and
" press Delete. To delete all connections, click
Clear Cables.

7 Repeat steps 3-6 for each MIDI device in your
MIDI setup.

To configure an external MIDI device:

1 Select the external device icon and click Show
Info (or double-click the new device icon).

[¥]a]

new external device

External Device Icon
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2 Select a manufacturer and model for the new
device from the corresponding pop-up menus.
(If the Manufacturer and Model pop-up menus
do not provide a name for your particular de-
vice, you can type a name.)

Device Name .j P-8000

i | Manufacturer Roland :l

More Properties | ¥

(cancel ) (GORS)

Naming a new MIDI device

Q For Manufacturer and Model names, AMS
- refers to one or more files with the suffix

“.middev” in the directory Root/Library/
Audio/MIDI Devices. Pro Tools installs a
file that contains information for many
commercially available MIDI devices,
named “Digidesign Device List.middev.” If
the Manufacturer or Model names for any of
your external MIDI devices is not available
in the AMS Manufacturer and Model pop-up
menus, you can add them by editing the
.middev file in any text editor (such as
TextEdit).



3 Click the More Information arrow to expand
the dialog, then enable the appropriate MIDI
channels (1-16) for the Transmits and Receives
options. (These determine which channels the
device will use to send and receive MIDI.)

Device Name  JP-8000

Manufacturer Ro[and.
Model |1P-8000

More Properties
[Basi | expert |

]

Transmits
Channels
[rla]afalsfel7]alafofn]az]ss[uefss]ue]
[} MIDH Time Code

[ Clack

Receives
Channels

[a]a]afa]s[s]z]s]s]ae]un]aa]aa]aa]as]as]

Tl Clock [} MIDI Time Code
Features
| General MIDI =
) MDY Machine Control Syskx 1D
(G @D

Enabling MIDI channels

4 Click the device image. The window expands
to show images for various MIDI devices (such
as keyboards, modules, interfaces, and mixers).
Select an icon for your device.

¥ Select an icon for this device

leon Set: | Generic H

Device Name  JP-8000
Manufacturer Ro[and.
Maodel P' m" 7

[t

More Properties | &

H]

) BRY e
(ol ) (06D
Selecting a device icon
@ To use your own custom icons, you can
place TIFF image files in /Library/

Audio/MIDI Devices/Generic/Images, and
they will appear as choices in the AMS de-

vice window.

5 Click OK.

The device names you enter appear as MIDI in-
put and output choices in Pro Tools.
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Patch Name Support

Pro Tools supports XML (Extensible Markup
Language) for storing and importing patch
names for you external MIDI devices. Pro Tools
installs MIDI patch name files (.midnam) for the
factory default patch names of many common
MIDI devices. These files reside in directories,
sorted by manufacturer, in /Library/Audio/MIDI
Patch Names/Digidesign.

To import MIDI patch names into Pro Tools:

1 Verify the MIDI Device name in the Audio
MIDI Setup window (see “Audio MIDI Setup” on
page 151).

2 Verify the Instrument or MIDI track output is
correctly assigned to the MIDI device.

3 Click the Instrument or MIDI track Patch Se-
lect button.

—
=
=
=
2
=
=
=
=
=

Patch Select button Patch Select button
(Edit window) (Mix window)

Patch Select button
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4 In the Patch Select dialog, click Change.
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Patch name file Kone _ incrurmant Patch Every 3 hec
( r'mlmq-...' ) [ Clear ) ( Cancel ) (SDone)

Change button
Patch Select dialog

5 In the Open dialog, navigate to /Library/Au-
dio/MIDI Patch Names/Digidesign/<name of
manufacturer>, and select the MIDI Patch Name
file (midnam) for the MIDI device.

6 Click Open.

The Patch Select dialog is populated with patch
names and the Patch Name Bank pop-up menu
appears in the upper left hand corner of the win-
dow.

Once patch names have been imported into
Pro Tools, they are available for that MIDI de-
vice in all sessions.

To clear patch names:

= In the Patch Select dialog, click Clear, and the
click Done.

Q MIDI patch name files (.midnam) can be ed-
ited in any text editor, or you can use third-
party patch librarian and editor software to
create your own custom patch names.



Configuring MIDI Studio Setup

(Windows Only)

MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the
MIDI controllers and sound modules that are
connected to your system, and control the rout-
ing of MIDI data between your MIDI equipment
and Pro Tools.

MSS automatically finds MIDI interfaces, and
lets you specify a custom name for each of the
MIDI ports within the MIDI Studio Setup docu-
ment.

MSS also supports XML-based patch file names
for storing and importing patch names for your
external MIDI devices.

Entire MIDI Studio Setup configurations created
within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized
into three sections. Interface controls are at the
top of the window. All the currently defined in-
struments are displayed in the Instrument Name
list on the left side of the window. A detailed
view of MIDI parameters is shown in the Proper-
ties section on the right.

Folasd [50
P 038

MIDI Studio Setup window
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Interface Controls

Create Adds a new instrument to the Instru-
ment Name list.

Delete Deletes the instrument or instruments se-
lected in the Instrument Name list.

Import Imports an existing MIDI Studio Setup
file.

Export Exports the current MIDI Studio Setup
file.

Show Duplicate Emulated Ports When this op-
tion is selected and you are using a MIDI inter-
face that supports timestamping (such as MIDI
1/0), in addition to the MIDI ports on your 003
Family interface, the MIDI Studio setup window
shows both the DirectMusic time-stamped out-
put ports, and non-stamped duplicate emulated
output ports.

A\ Some MIDI Interfaces will not properly load
or unload their drivers unless you quit and
re-launch Pro Tools. Check the documenta-
tion that came with your MIDI interface for
more information.

Instrument List

The Instrument list contains all the currently
defined instruments. Selecting an instrument in
the list displays that instrument’s properties in
the Properties section of the window.
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Properties Section

The Properties section lets you edit information
for new instruments, or instrument currently se-
lected in the Instrument list.

Froperties

Instrument Mame: [Proteus
Manuacturer
Modei:

Input Port. Digidesign MIDIIC 1 Port1 -
Qutput Port Digidesign MIDIIC 1 Port1 =

Send Channels:

MzlzT=lsle[7]=
9 10 11 12 13 14 15 16

fzl=T2l2l=sl7]=

Receive Channels: & I kT @ 168 B S

MIDI Studio Setup Properties section

When a previously defined instrument is se-
lected in the Instrument list, the Properties sec-
tion changes to reflect the properties of the se-
lected instrument.

To define an instrument with MIDI Studio Setup:
1 Choose Setup > MIDI > MIDI Studio.

2 Click Create.

3 In the Instrument Name field, type the name
of your instrument, and press Enter.

@ If you do not enter an instrument name, the
" Instrument Name field will automatically
inherit information from the Manufacturer
and Model pop-up menu.

4 Set a manufacturer and model for the new de-
vice from the corresponding pop-up menus. If
the Manufacturer and Model pop-up menus do
not provide a name for your particular device,
select None.

5 From the Input pop-up menu, select the input
port on your MIDI interface that is connected to
the MIDI Out of your instrument.



6 From the Output pop-up menu, select the out-
put port on your MIDI interface that is con-
nected to the MIDI In of your instrument.

7 Enable the appropriate MIDI channels (1-16)
for the Send Channels and Receive Channels op-
tions (These determine which channels send
and receive MIDI.)

Instrument Name

The Instrument Name field shows the user-de-
finable instrument name for the currently se-
lected instrument.

Manufacturer

The Manufacturer pop-up menu provides a list
of MIDI equipment manufacturers. This list is
derived from the XML-based MIDI device files.

For more information, see “MIDI Patch
Name Support” on page 157.

Model

The Model pop-up menu provides a list of MIDI
devices, filtered by the manufacturer name. This
list is derived from the XML-based MIDI device
files provided with your Pro Tools installation.

For more information, see “MIDI Patch
Name Support” on page 157.

Input Port

The Input Port pop-up menu displays a list of
available MIDI interface input ports. Inputs will
include 003 and any additional MIDI interfaces
enabled on your system. The MIDI interface

port that is set and displayed here is the port
through which MIDI data is sent from the exter-
nal MIDI device specified in the Instrument
Name field into your MIDI interface.

A\ Ifyou set the input port to None, the defined
instrument will not appear as a choice in a
MIDI Input selector.

Output Port

The Output Port pop-up menu displays a list of
available MIDI interface output ports. The port
set and displayed here is the port through which
MIDI data is sent from your MIDI interface to
the MIDI device specified in the Instrument
Name field.

A\ If you set the output port to None, the de-
fined instrument will not appear as a choice
in a MIDI Output selector.

Send Channels

The Send Channels grid sets the send channels
for the MIDI device specified in the Instrument
Name field.

Receive Channels

The Receive Channels grid sets the receive chan-
nels for the MIDI device specified in the Instru-
ment Name field.

MIDI Patch Name Support

Pro Tools supports XML (Extensible Markup
Language) for storing and importing patch
names for your external MIDI devices. Pro Tools
installs MIDI patch name files ((midnam) for the
factory default patch names of many common
MIDI devices. These files reside in directories,
sorted by manufacturer, in C:\Program Files\
Common Files\Digidesign \MIDI Patch Names\
Digidesign.
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To import MIDI patch names into Pro Tools:

1 Verify the MIDI Device name in the MIDI Stu-
dio Setup window (see “MIDI Studio Setup” on
page 155).

2 Verify the Instrument or MIDI track output is
correctly assigned to the MIDI device.

3 Click the Instrument or MIDI track Patch Se-
lect button.

Patch Select button Patch Select button
(Edit window) (Mix window)

Patch Select button

4 In the Patch Select dialog, click Change.
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Palch name file, None

Change Clear |

Change button

Patch Select dialog

5 In the Open dialog, navigate to C:\Program
Files\Common Files\Digidesign \MIDI Patch
Names\Digidesign \<name of manufacturer>,
and select the MIDI Patch Name file (.midnam)
for the MIDI device.

6 Click Open.
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The Patch Select dialog is populated with patch
names and the Patch Name Bank pop-up menu
appears in the upper left hand corner of the win-
dow.
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Patch Select dialog with patch names

Once patch names have been imported into
Pro Tools, they are available for that MIDI de-
vice in all sessions.

To clear patch names:

= In the Patch Select dialog, click Clear and then
click Done.

Q MIDI patch name files (.midnam) can be ed-
ited in any text editor, or you can use third-
party patch librarian and editor software to
create your own custom patch names.



appendix d

Hard Drive Configuration and Maintenance

It is recommended that you start with a newly N
formatted external or secondary internal audio s“pported Drive Formats and

drive. You should also periodically defragment Drive Types
your audio drive to ensure continued system

performance. Drive Formats
A\ Always back up any important data on your Mac Mac systems should use drives formatted
drive before formatting it, as it will erase all with HFS+ or HFS file system only.

data on the drive.
A\ HFS drives are supported as Transfer drives

only.
Avoid Recordlng to the Windows Windows XP systems should use drives
System Drive formatted as NTFS only.
Recording to your system drive is not recom- Windows systems can also support Mac
mended. Recording and playback on a system drives formatted with HFS+ system (also
drive may result in lower track counts or fewer commonly referred to as Mac OS Extended).
plug-ins. Refer to the Pro Tools Reference Guide for

more information (Help > Pro Tools Refer-
ence Guide).

Hard drive performance depends on factors in-
cluding system configuration, number of tracks,
session sample rate, density of edits, and the use
of crossfades and other processes such as Beat
Detective in a session.

For complete hard drive requirements, visit our
website (www.avid.com).
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SCSI Hard Drives

Avid recommends qualified SCSI hard drives
and a qualified SCSI host bus adapter (HBA) card
or (on Windows systems) a qualified built-in
SCSI HBA connector on the motherboard.

For complete information on track count and
the supported number and configuration of
SCSI drives, visit our website (www.avid.com).

FireWire Hard Drives

Avid recommends qualified FireWire drives and
(on Windows systems) a qualified FireWire host
adapter.

For complete information on track count and
the supported number and configuration of
FireWire drives, visit our website
(www.avid.com).

IDE/ATA/SATA Hard Drives

A qualified internal IDE/ATA/SATA drive may be
used as a dedicated audio drive.

For complete information on track count with
internal drives, visit our website
(www.avid.com).
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Formatting an Audio Drive

Formatting Mac Audio Drives
For optimum performance, audio drives should

be formatted as Mac OS Extended (Journaled).

To format an audio drive:

1 Launch the Disk Utility application, located in
Macintosh HD/Applications/Utilities.

2 Click the Erase tab.

Disk Utility (Mac OS X)

3 Select the drive you want to initialize in the
column on the left side of the window.

4 Choose the Mac 0S Extended (Journaled) for-
mat.

A\ Do not choose the “Case-Sensitive” format
option. Pro Tools will not operate properly
with case-sensitive formatted drives.

5 Type a name for the new volume.

6 If you plan to connect the drive to a Mac OS 9
computer, select Install Mac OS 9 Drivers.
(Mac OS 9 options only appear in 10.5 or below)

7 Click Erase.

The drive appears on the Desktop with the new
volume name.



Formatting Windows Audio Drives

For optimal performance, audio drives should
be formatted as NTES.

A\ Pro Tools only supports Basic drive types.
Do not convert the drive to a Dynamic type.
To format an audio drive:

1 Right-click Computer (Windows 7,
Windows Vista) or My Computer (Windows XP)
and choose Manage.

2 Under Storage, choose Disk Management.

[
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Disk Management window (Windows XP)

3 If the volume is “Healthy,” do the following:

Q Healthy volumes are volumes that have pre-
" viously been partitioned and formatted.

¢ In the Disk Management window, right-
click the hard drive you will use for audio
and choose Format.

¢ In the Format window, name the volume.

* Choose a file system. For optimum perfor-
mance, audio drives should be formatted as
NTFS.

e Select Perform a quick format.

e Make sure Enable file and folder compression
is not selected.

¢ Set the Allocation unit size to Default.
e Click OK.

4 If the volume is “Unallocated,” do the follow-
ing:
¢ In the Disk Management window, Right-
click the hard drive you will use for audio
and choose New Partition.

¢ In the New Partition Wizard window, click
Next.

e When prompted, select the partition type.

@ Avid recommends using Primary partitions,
" instead of Extended partitions.

¢ Follow the on-screen instructions to select
a partition size and other partition settings.

e When prompted, choose a file system. For
optimum performance, audio drives
should be formatted as NTES.

e Select Perform a quick format.

e Make sure Enable file and folder compression
is not selected.

e Set the Allocation unit size to Default.
e Click OK.

Partitioning Drives

Partitioning creates a logical volume or volumes
on a physical drive, almost as if you were creat-
ing virtual hard drives. Partitions can then be
formatted with the appropriate file system
(NTES for Windows, HFS+ for Mac (also referred
to as Mac OS Extended (Journaled)).

A\ Windows XP allows drives formatted with
the NTFS file system to be seen as whole
volumes. Single Pro Tools audio files cannot
exceed 2048 MB in size.
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A\ Mac OS allows drives larger than 4096 MB
to be seen as whole volumes. Drives must be
initialized with a disk utility that recog-
nizes the 2 terabyte limit. Single Pro Tools
audio files cannot exceed 2048 MB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned
drives (assuming that reads and writes are per-
formed on a single partition), since the heads
only have to seek within the partition boundar-
ies, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger par-
titions, but this comes at the expense of contig-
uous storage space. When you partition a drive,
you will need to find the compromise that best
suits your performance and storage require-
ments.

A Avoid distributing audio files within a ses-
sion over different partitions on the same
drive since this will adversely affect drive
performance.

Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video),
you can limit fragmentation by backing up your
important files to another disk, erasing the files
from the original hard disk, then copying the
files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain
system performance.
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For maximum recording and playback effi-
ciency, data should be written to your hard
drive in a contiguous fashion—minimizing the
seek requirements to play back the data. Unfor-
tunately, your computer can’t always store the
sound files in this way and must write to disk
wherever it can find space.

In multitrack recording, audio tracks are written
in discrete files, spaced evenly across the disk.
While fragmentation of individual files may be
zero, the tracks may be far enough apart that
playback will still be very seek-intensive. Also,
the remaining free space on the disk will be dis-
contiguous, increasing the likelihood of file
fragmentation on subsequent record passes.

Increased fragmentation increases the chance of
disk errors, which can interfere with playback of
audio, and result in performance errors.

Q On Windows, to avoid fragmentation, for-
" mat drives with higher cluster sizes (such as
32K).

Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize
your drive, which rearranges your files into a
contiguous format. Most optimizing software
lets you run a check on a drive to find out the
percentage of fragmentation. If your drive
shows moderate to heavy fragmentation, you
should consider optimizing it.

If you use your system for intensive editing, or if
you frequently delete audio or fade files from
your hard drive, you may need to optimize your
drives on a weekly basis, or even every few days,
since it doesn'’t take long for even a large hard
drive to become fragmented.



Backing Up Data Before Optimizing

Since your files will be rewritten by the optimi-
zation process, always make a backup copy of
the data on your hard drive before you optimize
it. You should also use a hard drive utility to find
and repair any problems before optimizing data
or re-initializing your drives. If there is any dam-
age to your hard drive's directories prior to opti-
mizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive (Windows 7 and
Windows Vista):

1 Click Start.

2 Type “disk defragmenter” in the search field at
the bottom. “Disk Defragmenter” should appear
at the top of the search results.

3 Click the Disk Defragmenter.

4 Click the Defragment disk button (Windows 7)
or the Defragment now button (Windows Vista).
Follow the on-screen instructions.

5 When defragmenting is complete, close the
Disk Defragmenter window.

A\ In Windows 7 you can Ctrl-Click on the
drive names to select multiple drives to de-
fragment, and once more than one drive is
selected, the button changes to “Defrag-
ment disks.”

A The “Defragment Now” (Vista only) com-
mand defragments all your hard drives.
This can take a lot of time, especially on
systems with multiple drives.

Advanced users can use the command line
tool Defrag.exe to defragment individual
drives. See your Windows Vista documen-
tation for more information.

To defragment an audio drive (Windows XP):
1 Right-click My Computer and choose Manage.
2 Under Storage, choose Disk Defragmenter.

3 In the Disk Defragmenter window, choose the
drive you want to defragment

4 Click the Defragment button and follow the
on-screen instructions.

When defragmenting is complete, close the
Computer Management window.

Using Mac Drives on Windows
Systems

Pro Tools for Windows lets you record and play
back sessions directly from a Mac-formatted
(HFS+) drive connected to a Windows system.
This functionality requires that all Mac session
and audio files be stored on Mac-formatted
drives.

During Pro Tools installation, make sure to se-
lect the Mac HFS+ Disk Support option. This op-
tion lets your Pro Tools system read, write, re-
cord, and play back using Mac-formatted HFS+
disks.

For information on using the Mac HFS+
Disk Support option, see the HFS+ Disk Sup-
port Option Guide.

For information on sharing sessions be-
tween Mac and Windows systems, see the
Pro Tools Reference Guide (Help >

Pro Tools Reference Guide).

Formatting HFS+ Drives

To format and partition any drives as HES+, con-
nect the drives to a Mac computer and use the
Apple OS X Disk Utility to format the drives as
Mac OS Extended (Journaled).
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Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately
5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about
7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately
10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about
15 MB per minute.

Table 5 lists the required disk space for certain track numbers and track lengths at 44.1 and 48 kHz,
to help you estimate your hard disk usage.

Table 5. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)

Number of tracks and length 16-bit at 16-bit at 24-bit at 24-bit at
44.1 kHz 48 kHz 44.1 kHz 48 kHz
1 mono track, 1 minute 5 MB 5.5 MB 7.5 MB 8.2 MB
1 stereo track (or two mono 50 MB 55 MB 75 MB 83 MB
tracks), 5 minutes
1 stereo track (or two mono 600 MB 662 MB 900 MB 991 MB
tracks), 60 minutes
24 mono tracks, 5 minutes 600 MB 662 MB 900 MB 991 MB
24 mono tracks, 60 minutes 7 GB 7.8 GB 10.5 GB 11.6 GB
32 mono tracks, 5 minutes 800 MB 883 MB 1.2 GB 1.3 GB
32 mono tracks, 60 minutes 9.4 GB 10.4 GB 14 GB 15.4 GB
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Mono audio tracks recorded with 24-bit resolution at 96 kHz require approximately 16.5 MB of hard
disk space per minute (a little more than twice as much as at 44.1 kHz).

Stereo audio tracks recorded with 24-bit resolution at 96 kHz require about 33 MB per minute.

Table 6 lists the required disk space for certain track numbers and track lengths at 88.1 and 96 kHz,
to help you estimate your hard disk usage.

Table 6. Required hard drive space for audio tracks (88.2 kHz and 96 kHz sessions shown)

Number of tracks and length 16-bit at 16-bit at 24-bit at 24-bit at
88.2 kHz 96 kHz 88.2 kHz 96 kHz
1 mono track, 1 minute 10 MB 11 MB 15 MB 16.4 MB
1 stereo track (or two mono 100 MB 110 MB 150 MB 166 MB
tracks), 5 minutes
1 stereo track (or two mono 1200 MB 1324 MB 1800 MB 1982 MB
tracks), 60 minutes
24 mono tracks, 5 minutes 1200 MB 1324 MB 1800 MB 1982 MB
24 mono tracks, 60 minutes 14 GB 15.6 GB 21 GB 23.2 GB
32 mono tracks, 5 minutes 1600 MB 1766 MB 2.4 GB 2.6 GB
32 mono tracks, 60 minutes 18.8 GB 20.8 GB 28 GB 30.8 GB
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Troubleshooting

Backing Up Your Work

It is highly recommended that you back up your
work on a regular basis, and especially before
making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently.
There are a variety of media that are suited to
back up projects of various sizes, from auto-
mated tape backup systems to high-capacity op-
tical drives, or to CD burners.

The best way to back up an entire session is to
use the Save Copy In command. This command
lets you save the session file and all of its associ-
ated files to a new location.

Q The Auto Save Backup feature (in the
" Operation Preferences page) sets
Pro Tools to automatically save backups
of the session file while you work.

Backing Up Your System
Configuration

After configuring your system and Pro Tools,
you should save an image of your system drive
using a backup utility such as Norton Ghost
(Windows) or Bombich Carbon Copy Cloner
(Mac). By doing this, you can quickly restore
your system configuration and settings if you
encounter any problems.

Common Issues

Pro Tools Won’t Launch

Problem

When you double-click the Pro Tools applica-
tion or a Pro Tools session file, Pro Tools doesn’t
launch, or displays an error message.

Possible Solutions

¢ Check to be sure your computer has the re-
quired amount of RAM to launch Pro Tools.
Visit www.avid.com/compatibility.

& Try a complete restart. Turn off your audio in-
terfaces, computer peripherals and your com-
puter, and then turn them on again in the
proper sequence.
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o If you tried to launch Pro Tools by double-
clicking a Pro Tools session file, do the follow-
ing:
¢ Close any error message.
e Double-click the Pro Tools application.
¢ In Pro Tools, choose File > Open Session to
open the session.

+ Reinstall the Pro Tools application, using the
Pro Tools Installer disc.

Audio Interface Is Not Recognized

Problem

When you launch Pro Tools it does not recog-
nize an audio interface, or a connected audio
interface is not available.

Possible Solutions

o Turn off your computer and check to be sure
your cables are properly and securely connected
to your computer and to your audio interface.

# Verify that your Hardware Setup dialog set-
tings are correct.
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Performance Factors

There are several conditions that may adversely
affect the performance of Pro Tools. These
include:

Network Connections Close any network con-
nections unless you are using them for network
interchange of audio data.

Background Applications Any software utilities
that run in the background or generate disk
activity, such as virus protection, disk optimiza-
tion, or file savers, should be turned off or
removed.

Screen Savers Screen saver software should be
completely disabled on your computer before
running Pro Tools.

Power Saver Features Some automatic power
saver features, such as those that spin down the
system hard drive, can affect Pro Tools perfor-
mance. These features should be turned off.



Before You Call Avid Support

Register Your System

Register your purchase by following the instruc-
tions on the Registration Information Card in-
cluded with your system. By registering, you be-
come eligible to receive the following:

e Technical support information
e Software update and upgrade notices

e Hardware warranty information

Gather Important Information

Avid wants to help you resolve problems as
quickly and efficiently as possible. If you collect
the following information before you contact
Avid Support, it will make the diagnosis of your
problem easier.

System Information

Computer
e Make, model, processor speed
e Amount of system RAM

e Operating system (version of Windows or
Mac OS)

e Any Drivers, Disk Utilities, or other system-
related applications you may have installed

Pro Tools Hardware

e Type of cards (if any), interfaces, or periph-
erals

Hard Drives
¢ Make, Model
e Drive size (GB)
* Drive speed (RPM)
e Drive type (SCSI, FireWire, IDE/ATA)
e Utility used to format the drive

e Number and size of partitions on the drive

Pro Tools Software

e Pro Tools software version
e Plug-In versions

e Other Pro Tools software options or
components

e Additional plug-ins from Avid Develop-
ment Partners

Other Hardware

Refer to the manufacturer’s documentation for
operational details.

The most common hardware additions include:

e 1394 (FireWire) cards for Windows systems
(manufacturer, model)

e Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use
with your Pro Tools system, visit:

www.avid.com/compatibility
Other Software

If you are using other audio or video applica-
tions, refer to the manufacturer’s documenta-
tion for operational details.

Make note of any other software that was run-
ning when a problem occurred.

Diagnostic Information

Note any DAE errors or other error codes you en-
counter. Also, note the ability to reproduce the
problem under different conditions, for exam-
ple, with another session, or after changing set-
tings (such as the Hardware Buffer Size).
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appendix f

Resources

Whether you are new to Pro Tools or just start-
ing out with your new system, we encourage
you to read and utilize the many guides that Pro
Tools provides. There are also useful online re-
sources available, giving you everything from
Pro Tools tips to Pro Tools answers.

About the Pro Tools Guides

In addition to any printed guides included with
your system, PDF versions of the printed guides
and many additional Pro Tools guides and Read
Mes are installed automatically during Pro Tools
installation (see “Documentation Installed Au-
tomatically with Pro Tools” on page 172).

Q Printed copies of the Pro Tools Reference
" Guide and other guides in the Pro Tools guide
set can be purchased separately from the Avid
Online Store (http://shop.avid.com).

Printed Setup Guide

This printed Setup Guide for your system gives
you detailed instructions for setting up and con-
figuring software and hardware for optimum
performance.

Printed Intro to Pro Tools Guide

The printed Intro to Pro Tools has tutorials on us-
ing Pro Tools (such as recording in a Pro Tools
session, importing audio from a CD, and creat-
ing an audio CD from a Pro Tools session).

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from
the Pro Tools Help menu. (Choose Help, then se-
lect a guide.)

These include:

e Pro Tools Shortcuts provides a complete list of
keyboard and Right-click shortcuts for
Pro Tools.

Audio Plug-Ins Guide describes the audio plug-
ins included with Pro Tools for both real-time
and file-based audio processing as well as
many other paid plug-in option offered from
Avid.

Pro Tools Menus Guide covers all the Pro Tools
on-screen menus.

Pro Tools Reference Guide explains Pro Tools
software in extensive detail.
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Documentation Installed
Automatically with Pro Tools

When you install Pro Tools, you get useful PDF
versions of many Pro Tools guides and

Read Mes. This documentation can be found in
the following locations:

Mac Applications/Digidesign/Documentation

Windows C:\Program Files\Digidesign\Docu-
mentation

 Toview or print PDF guides, you can use
Adobe Reader (recommended) or Apple
Preview (Mac only).

Read Me Files

These contain late-breaking information and
known issues pertaining to Pro Tools software
and hardware configurations. Read Me files are
installed in Documentation folder when you in-
stall Pro Tools.

Helpful Online Resources

Once you get going, here are some helpful
online resources:

¢ For questions about installation, visit
our online Knowledge Base. Go to:
http://www.avid.com/support

¢ Get useful information, help, and tips from
the worldwide community of Pro Tools users
at our User Conference. Go to:
http://duc.avid.com

e If you can't find your answer in the Knowl-
edge Base or User Conference, contact
email support. Go to:
http://www.avid.com/support
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About www.avid.com

The Avid website (www.avid.com) is your best
online source for information to help you get
the most out of your Pro Tools system. The fol-
lowing are just a few of the services and features
available.

Product Registration Register your purchase
online.

Support and Downloads Contact Avid Customer
Success (technical support); download software
updates and the latest online manuals; browse
the Compatibility documents for system re-
quirements; search the online Knowledge Base
or join the worldwide Pro Tools community on
the User Conference.

Training and Education Study on your own using
courses available online or find out how you can
learn in a classroom setting at a certified

Pro Tools training center.

Products and Developers Learn about Avid
products; download demo software or learn
about our Development Partners and their
plug-ins, applications, and hardware.

News and Events Get the latest news from Avid
or sign up for a Pro Tools demo.
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Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users
in the European Union

This symbol on the product or its packaging indicates that this
product must not be disposed of with other waste. Instead, it
is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling
of waste electrical and electronic equipment. The separate
collection and recycling of your waste equipment at the time of
disposal will help conserve natural resources and ensure that
it is recycled in a manner that protects human health and the
environment. For more information about where you can drop
off your waste equipment for recycling, please contact your
local city recycling office or the dealer from whom you
purchased the product.

Proposition 65 Warning

A This product contains chemicals, including lead,
known to the State of California to cause cancer and
birth defects or other reproductive harm. Wash hands
after handling.

Perchlorate Notice
This product may contain a lithium coin battery. The State of
California requires the following disclosure statement:

“Perchlorate Material — special handling may apply, See
www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

4y
e
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EMC (Electromagnetic
Compliance)

Avid declares that this product complies with the following
standards regulating emissions and immunity:

FCC Part 15 Class B

EN55022 Class B

EN55024 Class B

AS/NZS 3548 Class B

CISPR 22 Class B

FCC Compliance for United States

Radio and Television Interference

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules.

DECLARATION OF CONFORMITY

We, Avid, 2001 Junipero Serra Boulevard

Daly City, CA 94014-3886, USA

650-731-6300

declare under our sole responsibility that the product
003, 003 Rack, 003 Rack+l

complies with Part 15 of FCC Rules.

Operation is subject to the following two conditions:

(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,
including interference that may cause undesired operation.

Communication Statement
NOTE: This equipment has been tested and found to comply
with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause
harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try and correct the interference by one or
more of the following measures:

Reorient or locate the receiving antenna.

Increase the separation between the equipment and

receiver.

Connect the equipment into an outlet on a circuit

different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician

for help.
Any modifications to the unit, unless expressly approved by
Avid, could void the user's authority to operate the
equipment.
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Australian Compliance

Avid

Canadian Compliance

This Class B digital apparatus complies with Canadian
ICES-003

Cet appareil numérique de la classe A est conforme a la norme
NMB-003 du Canada

CE Compliance
(EMC and Safety)

C€.

Avid is authorized to apply the CE (Conformité Europénne)
mark on this compliant equipment thereby declaring conformity
to EMC Directive 89/336/EEC and Low Voltage Directive
2006/95/EEC.



Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and
Canadian safety certification in accordance with the
specifications of UL Standards: UL60065 7th /IEC 60065 7th
and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been
authorized to apply the appropriate UL & CUL mark on its
compliant equipment.

Warning

RISK OF ELECTRIC SHOCK
DO NOT OPEN

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.
6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance
with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat
registers, stoves, or other equipment (including amplifiers)
that produce heat.

9) Do not defeat the safety purpose of the polarized or
grounding-type plug. A polarized plug has two blades with one
wider than the other. A grounding type plug has two blades and
a third grounding prong. The wide blade or the third prong are
provided for your safety. If the provided plug does not fit into
your outlet, consult an electrician for replacement of the
obsolete outlet.

10) Protect power cords from being walked on or pinched
particularly at plugs, convenience receptacles, and the point
where they exit from the equipment.

11) Only use attachments/accessories specified by the
manufacturer.

12) For products that are not rack-mountable: Use only with a
cart, stand, tripod, bracket, or table specified by the
manufacturer, or sold with the equipment. When a cart is used,
use caution when moving the cart/equipment combination to
avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when
unused for long periods of time.

14) Refer all servicing to qualified service personnel. Servicing
is required when the equipment has been damaged in any way,
such as power-supply cord or plug is damaged, liquid has been
spilled or objects have fallen into the equipment, the
equipment has been exposed to rain or moisture, does not
operate normally, or has been dropped.

15) For products that are a Mains powered device:

The equipment shall not be exposed to dripping or splashing
and no objects filled with liquids (such as vases) shall be
placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not
expose this equipment to rain or moisture.

16) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly
replaced. Replace only with the same or equivalent type.

17) For products with a power switch:

The main power switch is located on the back panel of the 003,
and on the front panel of the 003 Rack and 003 Rack+. It
should remain accessible after installation.

18) The equipment shall be used at a maximum ambient
temperature of 40° C.
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Numerics A

003 AC power connector 66, 76
1394 LED 41 ADAT
Display section 40 connecting 87, 91
Fader section 42 LED (003 Rack) 59
Headphone jacks 56 LED (003 Rack+) 69
LCD display 40 LED (003) 41
Monitor section 56 Optical 1/0 64, 74
Power switch 66 additional software
Pro Tools mode 93 Mac 9
top panel 39 Alt CR switch
top panel shortcuts 113 003 56
Transport section 50 003 Rack 58
window show/hide switches 52 003 Rack+ 69

003 Rack 67 Alt Monitor Outputs (003 and 003 Rack) 63
1394 LED 59

Alt Monitor Outputs (003 Rack+) 73
Analog Inputs 5-8 63
analog tape deck, connecting 91

front panel 57
Headphone jacks 57
Monitor section 58

Power switch 57 Arrow keys 51
003 Rack+ ASIO 17
1394 LED 69 Assign mode 104
front panel 67 assigning
Headphone jacks 67 inputs and outputs 104
Monitor section 68 inserts 106
Power switch 67 sends 105
1394 audio drivers
LED (003 Rack) 59 CoreAudio driver (Mac) 9
LED (003) 41 Windows 17
port 65, 75 Audio MIDI Setup (AMS) (Mac) 151
3/4-HP2 switch Audio tests 149
003 56 authorizing Pro Tools 8, 16
_ 093 R?Ck 58, 69 _ Auto (Automation) Channel Meter LED 45
4-pin FireWire cable (Windows) 19 Automation modes
setting 112
switch LEDs 54
switches 54
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Aux In (to Monitor) switch
003 56
003 Rack 58, 69
Aux In to 7/8 switch
003 56
003 Rack 58
003 Rack+ 69
Aux Ins (003 and 003 Rack) 64
Aux Ins (003 Rack+) 73
Avid
customer success 172
Avid Audio Drivers 17
Avid CoreAudio Driver 9

B
Bank switch 52
banking
Master Faders 112
banking channels
eight channels at a time 111
one channels at a time 111
scrolling 111
bypassing
all plug-ins 99
single plug-in 96, 99

C
cables, microphone 80
Cache Size 26
cancel 49
CC# (Stand-alone mode) 122
Chan (Stand-alone mode) 122
channel controls
Channel Select switches 43
faders 42
Mute switch 43
Rec Arm switch 45
rotary encoders 44
Solo switch 43
Channel Meter LEDs 44, 45
Auto (Automation) 45
Left 45
Right 45
Channel Select switches 43
Channel View 97
switches 48
switches in MIDI mode 120
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Clean Uninstall (Mac) 11
Clock Source 28
compatibility 3
connecting
ADAT 87, 91
analog tape deck 91
digital devices 91
external effects devices 88
guitars 83
headphones 77
keyboards 84
microphones 80

microphones (1/4-inch connector) 82

microphones (XLR connector) 80
MIDI devices 91
mixdown recorder 91
mixers 84
S/PDIF Optical devices 87
S/PDIF RCA devices 87
connecting a sound system 77
Console View 94, 97
switches 47
switches in MIDI mode 120
CoreAudio driver (Mac) 9
CPU Usage Limit 23, 24
cursor
moving one frame at a time 109
moving up or down one track 109

cycling
Dynamics plug-ins 98
EQ plug-ins 97
inserts 99

D

DAE Playback Buffer Size 25

DAT recorder, connecting 91

default settings 109

Default switch 46

DI Inputs 1-4 (003 and 003 Rack) 62
digital devices, connecting 91

Direct Inject inputs 62

Direct Interface inputs (003 and 003 Rack) 62

Display Mode switch 41
Display section 40
Display switches 52



displaying

channel pan setting and send levels

temporarily 101
Dynamics plug-in controls 98
Dynamics plug-ins on a track 97
EQ plug-in controls 97
EQ plug-ins on a track 97
fader level temporarily 101

full names of insert parameters 100

full names of tracks 100

insert settings temporarily 101
inserts on a track 98

Memory Locations 110

plug-in controls 96, 98

plug-in settings temporarily 101
send level temporarily 101
sends on a track 99

settings instead of control names 100
settings instead of track names 100

DMA option (Windows), enabling 32
drive formatting
Mac 160
Windows 161
drive maintenance 159
drive requirements 3
drivers
Mac 9
Windows 17
Dynamics plug-ins
cycling through 98
displaying all on a track 97
displaying controls 98
Dynamics switch 49

Edit selection

during playback 109

extending up or down a track 109

moving up or down one track 109
Edit switch 52
Edit window

Edit window

zooming 108

scrolling 109
encoders

MIDI mode 120
Energy Saver (Mac), turning off 30
Enter switch 53

entry fields, navigating 103

EQ

in Channel View 97

EQ plug-ins

cycling through 97
displaying all on a track 97
displaying controls 97

EQ switch 49
ESC switch 49
external effects devices, using 88

F

F1 Utility 145

Fader Flip switch 46
Fader Group test 148
Fader Mute switch 53
Fader section 42
faders 42

Flip mode 110
MIDI mode 120
testing and resetting 147

Fast Forward 50
FFW 50
FireWire

4-pin cable (Windows) 19

connecting drives 66, 75

connecting drives (Mac) 10

connecting drives (Windows) 18
connecting other devices 66, 76
connecting other devices (Mac) 10
connecting other devices (Windows) 19
connection status (003 Rack) 59
connection status (003) 41

port 65, 75

FireWire requirements 160
firmware

updating (Mac) 8
updating (Windows) 17
viewing firmware version 146

Flip mode 110

views 111

Focus switch 53

footswitch 92

footswitch (003 and 003 Rack) 65
footswitch (003 Rack+) 75
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G

guitar, connecting 83

H

hard drives
drive formats 159
FireWire 66, 75
FireWire (Mac) 10
FireWire (Windows) 18
FireWire requirements 160
formatting 160, 161
formatting (Mac) 160
IDE/ATA requirements 160
maintenance 159, 162
optimizing 162
partitioning 161
requirements 3
SCSI requirements 160
space requirements 164, 165
Hardware Buffer Size 22
Hardware Setup dialog 27
headphones
connecting 77
jacks (003 Rack) 57
jacks (003 Rack+) 67
jacks (003) 56
Level controls (003 Rack) 58, 68
Level controls (003) 56
headroom 61, 71
high pass filter switches
003 55
003 Rack 58, 68
Host status LED 41, 59
HPF switches
003 55
003 Rack 58, 68

|
I/0 Setup 29
IDE/ATA requirements 160
IEEE-1394
port 65, 75

Ignore Errors During Playback/Record option 24

Input 1-4 Gain controls
003 55
003 Rack 57
Input 1-8 Gain controls (003 Rack+) 68
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Input Channel Select switches (003 Rack+) 68

Input switch 46
inputs
Analog Inputs 5-8 63
assigning 104
Aux In (003 and 003 Rack) 64
Aux In (003 Rack+) 73
controls (003 Rack) 57
controls (003) 55
DI Inputs 1-4 (003 and 003 Rack) 62
Line/DlI inputs 1-8 (003 Rack+) 72
Mic Inputs 1-4 (003 and 003 Rack) 62
Mic Inputs 1-8 (003 Rack+) 72
MIDI 65, 75
Optical 64, 74
S/PDIF 64, 74
Insert switch
Channel View 49
Console View 48
Insert View (Console View) 96
Insert/Send Position switches 48
inserts 49
assigning 106
bypassing a plug-in 96
cycling through 99
displaying an Insert position 96
displaying inserts on a track 98
displaying plug-in controls 96
in Channel View 49
working with 96
installing
Pro Tools (Mac) 5
Pro Tools (Windows) 13
QuickTime (Windows) 16

J
Jog mode 51

Jog/Shuttle wheel 51
Jog mode 51
Shuttle mode 51

journaling (Mac), enabling 32

K
Kensington Lock port 65
knobs (see rotary encoders)



L
Latch Automation
LED 54
switch 54
latency
Hardware Buffer Size 22
launching Pro Tools 8, 16
LCD
display 40
test 146
LEDs
Automation modes 54
test 146
Left Channel Meter LED 45
Lightpipe 65, 74
Link indicator 66, 76
Loop Play switch 52
Loop Rec switch 52

Main Analog Outputs 1-8 (003 and 003 Rack) 63
Main Analog Outputs 1-8 (003 Rack+) 73

Main Monitor Outputs 63
Main Monitor Outputs (003 Rack+) 73
Master Faders 46
Mem Loc switch 52
Memory Locations
creating 110
displaying 110
recalling 110
switch 52
working with 110
Meter switch 45
meters
channel LEDs 44
Mic Inputs 1-4 (003 and 003 Rack) 62
Mic Inputs 1-8 (003 Rack+) 72
Mic/DI
controls (003 Rack) 57
controls (003) 55
switches (003 Rack) 58
switches (003) 55
microphones
1/4-inch connectors 82
cables 80
connecting 80
inputs 62, 72

phantom power 80
XLR connectors 80
MIDI
connections 91
editing maps in MIDI mode 122
monitoring 92
requirements 3
setup (Mac) 151
setup (Windows) 155
Stand-alone CC assign 122
Stand-alone channel assign 122
test 149
MIDI Data LEDs
003 41
003 Rack 59
003 Rack+ 69
MIDI Edit 122
MIDI Edit switch 53
MIDI In (003 and 003 Rack) 65
MIDI In (003 Rack+) 75
MIDI Machine Control (see MMC)
MIDI Map preset
editing 121
naming 123
recalling 119
saving 123
MIDI Map switches 53
MIDI mode 38
and MMC 120
assigning controllers 121
editing presets 121
entering 118
MIDI Edit mode 122
naming presets 123

programmable controls and defaults 120

programming and editing 121
recalling presets 119
saving presets 123
selecting 118
MIDI Out 1 65, 75
MIDI Out 2 65
MIDI Recall switch 53
MIDI Studio Setup (MSS) (Windows) 155

Minimize Additional 1/0 Latency option 25

mirroring outputs 78

Mix switch 52

mixdown and connecting a recorder 91
MMC 120

Index
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MME 17
modes
Flip mode 46
MIDI mode 38
Pro Tools mode 37
Standby mode 37
Third-Party Software mode 38
Utility mode 38, 145
modifier keys 55
Command 54
Control 54
Option 54
Shift 54
Monitor Level control
003 56
003 Rack 58, 69
Monitor Mute switch
003 56
003 Rack 58
003 Rack+ 69
Monitor section
003 56
003 Rack 58
003 Rack+ 68
monitoring
MIDI instruments 92
Mono switch
003 56
003 Rack 58
003 Rack+ 69
Mstr Faders switch 46
Mute switch 43
muting fader movement 112

N

navigating 108

network cards (Windows), disabling 34
network connections 168

New Tracks dialog 103

Nudge switch 52

o

Off
Automation LED 54
Automation switch 54
OK switch 53
Operating Level switches 63
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operating levels 61, 71

Optical format 29

Optical I/0 64, 74

optimizing hard drives 162

Output windows 107

outputs
Alt Monitor (003 and 003 Rack) 63
Alt Monitor (003 Rack+ 73
assigning 104
digital 64, 74

Main Analog Outputs 1-8 (003 and 003 Rack)

63
Main Analog Outputs 1-8 (003 Rack+) 73
Main Monitor 63
Main Monitor (003 Rack+) 73
MIDI 65, 75
mirroring 78
Optical 64, 74
S/PDIF 64, 74

P
Page switches 49
Pan switches 48
Pan View 94
Pan/Send Flip mode 111
Pan/Send switch 49
panning
adjusting on a track that has sends 100
panning a track 94
partitioning hard drives 161
phantom power

enabling on an input 81
when to use 80
Phantom Power switches 62
Play 50
Playback Engine
RTAS Processors setting 23
playing
backwards at a variable rate 109
forwards at a variable rate 109

Plug-In Flip mode 111

Plug-In Master Bypass switch 49
Plug-In Streaming Buffer 27
Plug-In Streaming Buffer Size 26
Plug-In switch 52



plug-ins record enabling tracks 108

bypassing all 99 renaming tracks 95

bypassing one 99 saving a session 93

displaying controls 96, 98 Send View workflows 95

multiprocessors 23 shortcuts 113

RTAS Processors setting 23 Undo operations 110

toggling views 53 Processor Scheduling performance (Windows) 35
power 66, 76 Program Change dialog 154, 158
Power switch

003 66 Q

003 Rack 57, 67

QuickPunch switch 52

Pro Tools QuickTime installation (Windows) 16

as Word clock master 87
as Word clock slave 88

authorizing 8, 16 R
demo session 9, 18 Read Automation
hardware settings 27 LED 54
installing (Mac) 5 switch 54
installing (Windows) 13 Rec Arm switch 45
launching 8, 16 recalling a Memory Location 110
removing (Windows) 11, 19 Record 50
setting defaults 109 recording
Pro Tools LE

disabling tracks 108

capabilities 2 enabling tracks 108
Pro Tools mode 93 removing Pro Tools

adding comments 104 Windows 11, 19
Assign mode 104

assigning inputs and outputs 104
assigning inserts 106

renaming a track 95
Return to Zero 50

assigning sends 105 REW 50

automation 112 Rewind 50

banking channels 111 Right Channel Meter LED 45
banking Master Fader tracks 112 rotary encoders 44

Channel View 97 Flip mode 110

Console View 94, 97 LEDs 44

display options 100 test

editing entry field values 103 RTAS Processors setting 23
enabling 93 RTZ 50

Flip mode 110

Insert View workflows (Console View) 96 S

Memory Locations 110

muting fader movement 112 S/PDIF

naming tracks 104 connecting Optical devices 87
navigating Edit window 108 connecting RCA devices 87
navigating entry fields 103 input and output ports 64, 74
navigating New Tracks dialog 103 LED (003 Rack) 59

Output windows 107 LED (003 Rack+) 69
overview 37 LED (003) 41

Pan View workflows 94 Safe Uninstall (Mac) 11
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sample rate 61, 71
default 27
Save switch 53
saving a session (003) 93
screen savers 168
scrolling the Edit window 109
SCSI requirements 160
selecting
a range of tracks 94
a track 94
all tracks 95
noncontiguous tracks 95
Send Flip mode 111
Send switch 48
Send View 95
sends
adjusting send level 95, 100
assigning 105
displaying a Send position 95
displaying sends on a track 99
to external effects devices 89

toggling pre- and post-fader 96, 100

viewing level 101
working with 95
Shuttle mode 51
Software Update (Mac), turning off 30
Solo switch 43
sound system
connecting 77
Spotlight indexing (Mac), disabling 32
Stand-alone mode
assigning CC 122
assigning control channel 122
Standby mode 37
starting Pro Tools 8, 16
Startup items (Windows), disabling 35
Stop 50
Suspend switch 54
suspending automation 112
switches
3/4-HP 2 (003 Rack) 58, 69
3/4-HP 2 (003) 56
Alt CR (003 Rack) 58
Alt CR (003 Rack+) 69
Alt CR (003) 56
Automation modes 54

Aux In (to Monitor) (003 Rack) 58, 69
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Aux In (to Monitor) (003) 56
Aux In to 7/8 (003 Rack) 58
Aux In to 7/8 (003 Rack+) 69
Aux In to 7/8 (003) 56
Bank switch 52

Channel View 48

Console View 47

Default 46

Display Mode 41

Dynamics 49

Edit window 52

Enter 53

EQ 49

ESC 49

Fader Flip 46

Fader Mute 53

Focus 53

HPF (003 Rack) 58, 68
HPF (003) 55

Input 46

Insert (Channel View) 49
Insert (Console View) 48
Insert/Send Position 48
Line-DI (003 Rack+) 68
Loop Play 52

Loop Rec 52

Mem Loc 52

Mic/DI (003 Rack) 58
Mic/DlI (003) 55

MIDI Edit 53

MIDI Map 53

MIDI mode 120

MIDI Recall 53

Mix window 52

Monitor Mute (003 Rack) 58
Monitor Mute (003 Rack+) 69
Monitor Mute (003) 56
Mono (003 Rack) 58

Mono (003 Rack+) 69
Mono (003) 56

Nudge switch 52

Operating Level 63

Page 49

Pan 48

Pan/Send 49

Phantom Power 62

Plug-In Master Bypass 49
Plug-In window 52
QuickPunch 52

Save 53



Send 48
Suspend 54
testing 147
Undo 53
Utility 53
Zoom switch 52
SYNC LEDs
003 41
003 Rack 59
003 Rack+ 69
system
optional optimizations (Windows) 34
recommended optimizations (Windows) 34
required optimizations (Windows) 32
shutting down 21
starting up 21
system optimization
Mac 30
Windows 34
system requirements 3
system settings
Cache Size 26
Clock Source 28
configuring 22
CPU Usage Limit 24
Hardware Buffer Size 22
1/0 Setup 29
Optical format 29
Plug-In Streaming Buffer 27
Plug-In Streaming Buffer Size 26
Sample Rate 27

T

technical support 172
product registration required 169
testing
audio connections 149
faders 147
LCD 146
LEDs 146
MIDI connections 149
rotary encoders 147
switches 147
Third-Party Software mode 38
toggling plug-in views 53
Touch Automation
LED 54
switch 54

Touch test 148
tracks
adding comments 104
decreasing number of 103
increasing number of 103
naming 104
navigating New Tracks dialog 103
renaming 95
selecting 94
selecting a range 94
selecting all 95
selecting noncontiguous tracks 95
Transport
and MMC 120
controls in MIDI mode 120
moving one frame at a time 109

U
Undo operations 110
Undo switch 53
uninstalling Pro Tools
Mac 11
Windows 19
User Account Control (UAC)
disabling 34
Utility mode 38, 145
accessing 145
Audio tests 149
automated Fader tests 147
Encoder test
exiting 145
Fader Group test 148
Fader tests 147
firmware version 146
LCD test 146
LED test 146
MIDI test 149
navigating 145
Switch test 147
Touch test 148
Vegas mode 148
Utility switch 53

Vv
Vegas mode 148
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w
W Clk LED
003 41
003 Rack 59
003 Rack+ 69
WaveDriver 17
window show/hide switches 52
Word Clock
In and Out ports 65, 74
LED (003 Rack) 59
LED (003 Rack+) 69
LED (003) 41
Pro Tools as master 87
Pro Tools as slave 88
working
in Channel View 97
in Console View 94, 97
in Insert View (Console View) 96
in Pan View 94
in Send View 95
Write Automation
LED 54
switch 54

z

Zoom switch 52
zooming 108
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